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Installation and maintenance of licenses

Online activation of  a license
O n l i n e  a c t i v a t i o n  o f   a  l i c e n s e

In order to use EasySIGN software, you need to obtain at least one license. Licenses can be bought from a reseller
and at our web shop.  A license is provided as a ticket. A ticket is a 29 character long string consisting of 5 groups of
alphanumerical characters separated by hyphens, for example: "ABC01- ABC01- ABC01- ABC01- ABC01".

Your computer needs to have an internet connection in order to activate the license.

If you plan to activate a license offline (so your system is not connected to the internet), please consult "Offline
activation" first.

Once you have acquired a ticket, you can activate it by means of the license manager wizard. The license manager
wizard is shown the first time you start EasySIGN. You can also bring it up by selecting the menu "Help > Licensing
options". This will bring up a dialog showing all available licenses.

From here you can bring up the wizard by clicking the button "License Manager...":



7EasySIGN

Press "Next" in order to start the activation process.

Here you have two options

1 I have a Product Voucher.
If you bought the license from a reseller your software box could contain a Product Voucher that will
look like the image below.



8 EasySIGN

You can use the number on this Product Voucher to obtain the ticket for the license you have bought.
You would use this option if you haven't got a ticket yet. If you want to use this option, select it and
press 'Next' to continue.

2 I have a ticket.
If you already have a ticket you would use this option. If you want to use this option, select it and press
'Next' to continue.

I have a Product Voucher

Press the button 'Activate Product Voucher' (1). This will open a browser and the web page where you can activate
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your Product Voucher.
When you have activated your 'Product Voucher' and received your ticket (by email), press next to continue.

I have a ticket

Ticket based license activations are supported by (1) and (2). Offline activation is possible with (3) the latter is
described in section "Offline activation". The two choices in (1) and (2) tell EasySIGN how the newly installed
license will be bound. 

1 The license will be bound to your pc. This means that you can only use the software on that pc.

2 The license will be bound to a dongle. You can use the software on any computer that you connect with
this dongle. In order to be able to choose this option you need to have a dongle. A dongle can be
acquired from your reseller or at the web shop.

Pick the choice that is appropriate for you and press "Next".
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Here you can enter the ticket. By default the full textbox is selected allowing you to simply cut and paste the ticket.
Be careful to avoid leading and trailing white space characters.

Once you have verified that the ticket has been entered correctly, press "Next".
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The installation of a new license can take a while, so please be patient. Upon success you will see the above depicted
message. When you restart EasySIGN your newly added license will be activated. If your license could not be
installed consult section "Troubleshooting" for help.

Offline activation
O f f l i n e  a c t i v a t i o n

If the computer on which you want to use EasySIGN is not connected to the internet, you can choose for an offline
activation. Please be aware that an additional cost may be involved in an offline activation process. 
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On page 2 of the license manager choose "Offline activation (not recommended)" (3) and press "Next".

Choose the second option "I don’t have a license file yet" and press "Next".
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The choice between (1) and (2) tells EasySIGN how the newly installed license will be bound. 

1 The license will be bound to a dongle. You can use the software on any computer that you connect with
this dongle. In order to be able to choose this option you need to have a dongle. A dongle can be
acquired from your reseller or at the web shop.

2 The license will be bound to your pc. This means that you can only use the software on that pc.

In addition to the mentioned choice, you also need to specify a filename. This filename will be used by the license
manager in order to generate a file that will contain information with respect to the choice you made on this page. The
filename will typically be called "context.WibuCmRaC". Once you have made your choice, and provided a valid
filename, press "Next".
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You need to send the file generated to EasySIGN. This can be done by email, for example on another computer that
has an internet connection and e-mail, or by sending us an USB stick containing the generated file. Together with this
file, you need to specify which license you require. If you are not sure which license would be best for your purposes,
you can contact us trough the contact page on our website. Make sure you provide us with a return address.

When we receive the context file in good order we will generate a so-called license file and ship it back to you. The
license file will typically be called "update.WibuCmRaU". In order to install this file, you need to start the license
manager again.
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Select "Offline activation (not recommended)" (1) and press "Next". 

Select "I already have a license file" (1) and press "Next".  

Here you need to provide a filename. This is the name of the file that EasySIGN shipped to you. Select it and press
"Next".
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Upon success you will see the above displayed message. When you restart EasySIGN your newly added license will
be activated. If your license could not be installed consult section "Troubleshooting" for help.

Understanding and using the License dialog
U n d e r s t a n d i n g  a n d  u s i n g  t h e  L i c e n s e  d i a l o g

The license dialog provides an overview of all valid licenses (with the possible exception of the build license) on your
system. Select the menu "Help > Licensing options" to show this dialog.

Each entry in the listbox (1) window represents a license visible on your system. If a license is visible in this dialog, it
means it is considered to be valid. One exception to this rule is the build license:

A build license limits the build version of the software that can be used.  This is done by comparing the build date of
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the software with the expiration date of the build license. If the build date is too new, so it is newer than the expiration
date of the build license, then the build license is said to be invalid. The user will be informed of this fact at startup
after which all licenses will be disabled. Do not confuse a build date with the current date: A build license with an
expiration date in the past is still valid as long as the build date is in the past of the expiration date of the build
license. 
A build license is derived from a support license. All web shop products come with some support. The expiration date
of the support license is identical to the expiration date of the build license. In the example above the build license is
visible as the first entry in the listbox. It is valid since its expiration date of June 26 2010 is more recent than the build
date of May 1sth 2010.

The license dialog has 4 buttons

2 Close. With this you can simply dismiss the license dialog.

3 License manager wizard. With this you can bring up the license manager wizard as described in previous
sections.

4 Ticket manager. This dialog is used to extend subscriptions as will be described in the next section.

5 Web shop. This will open a web browser with a link to our web shop for your convenience.

In the lower left corner a checkbox (6) is visible. Licenses that are invalid will be collected and shown to you at
startup by an invalid license dialog (see "Understanding and using the expired license dialog"). Uncheck this
box if you do not wish to be informed of expired licenses.

Understanding and using  the Ticket Manager
U n d e r s t a n d i n g  a n d  u s i n g   t h e  T i c k e t  M a n a g e r

Licenses are said to have recently expired if their expiration date is within 30 days of the current date. These licenses,
although technically invalid, are still considered to be valid by the software: they are in a so-called grace period of 30
days. A grace period of 30 days will provide you with ample time to continue any subscription you might have without
losing the functionality of the software. 

The ticket manager presents you with a list of licenses that are within a grace period of their expiration date. If these
licenses are part of a running subscription, then they can be extended by means of this manager.
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In listbox (1) you will see an overview of all licenses that recently expired. In the above shown example we see that
two licenses have expired: "Support complimentary" and "Master subscription".  In listbox (2) you are presented with
a list of tickets that have been installed in the past. Selecting one or more licenses in listbox (1) results in the
selection of all relevant tickets in listbox (2). Textboxes (3) and (4) provide you with more information with respect to
a selected license and ticket respectively. Once you are confident that the right ticket(s) has/have been selected, you
can extend your subscription by pressing "Renew" (6). In textbox (5) you will be notified whether the extension was
successful or not. The next example shows a successful extension:

Notice that the licenses in listbox (1) are updated to reflect the new status after the successful extension. You do not
need to restart the software in this case.

The button "Remove" (7) can be used to remove tickets from listbox (2). You can use this to remove old tickets that
you will not extend. It is perfectly safe to remove a ticket. Removing a ticket does not result in the loss of licenses,
nor does it result in the cancellation of any subscriptions you might have. If you remove a ticket of a running
subscription by accident, you can use the license wizard to enter it again. The license wizard itself can be activated
from this dialog by pressing the button "License wizard" (8). You can also enter the web shop by pressing the button
"Online webshop" (9).

Understanding and using the expired license dialog
U n d e r s t a n d i n g  a n d  u s i n g  t h e  e x p i r e d  l i c e n s e  d i a l o g

Licenses that are expired, and which are no longer within a grace period of the current date, will no longer be
considered to be valid by the software. The software will collect these licenses and report them to you in an expired
license dialog.
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Each entry in listbox (1) of this dialog represents an invalid license. If you do not intend to extend the expired license
and you also do not want to see this dialog each time you start the software, you can suppress it by one of the
following two methods:

1 Notice that there is a checkbox (2) in the lower left corner of the dialog. By checking this checkbox you
prevent the software from reporting expired licenses to you. You can turn this checkbox off again by
selecting the appropriate checkbox on the "License dialog".

2 (recommended) You can select the license that is expired and explicitly hide it by pressing button
"Hide" (3).  This will make sure that the tool will no longer  warn you about this specific license. The hide
action is license and date specific: if you install a newer license that also expires, the tool will once more
warn you about this expired license until you hide this license as well.

Troubleshooting
T r o u b l e s h o o t i n g

In this section you will find the most common issues that can occur during activation of your license.

EasySIGN does not start. I just see a dialog with an error message
EasySIGN software is protected by an anti-piracy shield. This shield will only start EasySIGN if certain conditions are
met. The error message you see is most likely generated by this shield. Here are the most common failures you
might encounter:

EasySIGN communicates with a separate license server that runs locally on each machine on which EasySIGN
software is installed. This license server, named CodeMeter server, must be running as a service. If the CodeMeter
server somehow got terminated, it will not restart automatically as a service. Rebooting your system should restart
the CodeMeter server as a service.



20 EasySIGN

The version of the CodeMeter server running  on your system is outdated. This could happen if you e.g.  install
software that is using an older version of CodeMeter. Re-installing EasySIGN should fix this problem.

Axprotector itself requires a license. This license is shipped with the software. It is installed the first time you start the
software. The license itself is persistent to uninstalling and re-installing EasySIGN. So, losing this license is very
unlikely. However, if this license does somehow get deleted, it cannot be installed a second time. Therefore, in
addition to the original license, we ship one backup license with our software in case the original license gets deleted.
If this license also gets deleted you need to contact us in order to acquire a new one.

The shield itself was not able to provide more information about the problem. If you contact EasySIGN have the
following information available: The serial number of your software "Windows Start button > EasySIGN VX > Tools >
ContainerID" or in the software itself select the menu "Help > Container ID". We will also ask you to email us the
resulting file generated by a tool called VersionInfo ("Windows Start button > EasySIGN VX > Tools > VersionInfo"):
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If you see this message, or a message similar to this, your installation of EasySIGN software is corrupt due to missing
DLL files. Reinstall the software.

I cannot bring up the license manager
The license manager is a standalone executable that resides in the same directory in which EasySIGN is installed. It is
named "LicenseManager.exe". If this executable is missing, you need to re-install EasySIGN.

The license manager generates the following error:

Could  no t conta ct the  e x te rna l lice nse  se rv e r
Make sure your computer is connected to the internet. If your computer is connected to a proxy, make sure that the
default (login) credentials allow access to this proxy. Contact your IT department to make sure that this is set up
correctly.

Com m unica tion with  the  e x te rna l lice nse  se rv e r  fa ile d
This is caused by a communication failure between the license server and the license manager. Make sure your
internet connection is setup properly.

Your  ticke t is  no t v a lid
Make sure that your ticket is correct. It is easy to make a mistake if you are manually typing in the ticket. If possible,
try to cut and paste the ticket in order to avoid mistakes.

T he  products  in  th is  ticke t a re  no t com pa tib le  with  y our  ins ta lla tion. T he  m ost like ly  ca use  is  tha t y our
insta lla tion a lre a dy  conta ins  a ll the  products  cov e re d  by  th is  ticke t.
EasySIGN does not allow you to install the same product (license) twice or more on the same computer, or the same
dongle. This is done for your protection. Installing a license twice does not add any additional functionality, nor does it
allow you to start the software multiple times. Make sure that you are installing the ticket on the appropriate
computer, or on the appropriate dongle.

Your  ticke t ha s  a lre a dy  be e n a ctiv a te d
The ticket has already been activated before. You cannot activate it again, unless it is part of a subscription. If case of
the latter, you are trying to activate it too soon; you have to wait until the licenses contained by the ticket enter their
grace periods. The ticket manager (see "Understanding and using the Ticket Manager") will warn you when this
happens.

Unknown e rro r
This is most likely caused by an intermittent communication failure between the license server and the license
manager. Make sure your internet connection is setup properly.
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Could  no t find  a ny  dong le . Ple a se  v e r ify  tha t y our  dong le  is  conne cte d .
You must have selected "I have a ticket and a dongle" on page 2 of the license wizard. The license wizard could not
detect any dongle on this computer.
Important:
Please be aware that you cannot reuse the dongle of version 5 and earlier.

T he re  a re  m ultip le  dong le s  a tta che d  to  y our  sy ste m . T he  lice nse  m a na ge r  re quire s  tha t only  one  dong le
is  a tta che d  to  y our  sy ste m . R e m ov e  a ll dong le s , e x ce pt fo r  the  dong le  on which y ou wish to  ins ta ll the
lice nse .
You cannot have more than one dongle connected to the system during the installation of a new license. You can have
multiple dongles connected during normal operations, but only if at most one of these dongles contains EasySIGN
licenses.

Som e  file s  a re  m iss ing: <lis t o f m iss ing  file s>.
Please reinstall the application.
The license manager detected a corrupt installation of your software. Please re-install EasySIGN.

T he re  is  a  prob le m  with  y our  Code Me te r  se rv ice . Ple a se  re boot y our  com pute r .
The license manager detected a problem with your local CodeMeter license service. Please reboot your computer in
order to reset this service.

EasySIGN starts, but I get a warning/error message.
T he  re le a se  da te  o f the  progra m : <da te 1> is  ne we r  tha n the  e x p ira tion da te  o f y our  build   lice nse :
<da te 2> [E200]
The build date of the executable is too new. You do not have the rights to run this executable. You can either revert to
an older version of the software, or you can buy additional maintenance in the web shop. The setup of our software
normally prevents you from running into this problem, since it verifies that your build license (derived from
maintenance) allows you to run the software. However there are a couple of scenarios in which you can still manage
to trigger this problem. For example, you might have  installed a TryBuy license, after which you upgraded to a newer
version of the software. The TryBuy licenses are only temporarily available to you, and at the end of the TryBuy
period these licenses are deleted.

Only  one  dong le  ca n be  bound  to  the  Ea sy SIGN so ftwa re  on th is  com pute r . Ple a se  re m ov e  the  e x tra
dong le  (s).
You can have multiple dongles connected to your computer, but only one of these dongles may contains EasySIGN
licenses.

I just installed a new license by means of a ticket, and now all my licenses are gone.
Unless you installed a Move license, your licenses are most likely still available on your computer. Reboot your
computer. If the problem persists, contact EasySIGN and have your serial number readily available.

EasySIGN

Introduction

Bienvenue dans EasySIGN. 

Conventions EasySIGN
C o n v e n t i o n s  E a s y S I G N

Avant de commencer à travailler avec EasySIGN, il est préférable de prendre connaissance de la terminologie du
présent manuel.

Menu
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Le menu est la barre horizontale qui se trouve au sommet de votre écran. Il reprend un certain nombre de
commandes, telles que “ Fichier ”, “ Editer ”, etc. Lorsque vous cliquez sur l’une de ces commandes, un sous-menu
apparaît à l’écran. Il comporte des options telles que “ Nouveau ”, “ Enregistrer ”. A chaque fois que vous activez
l’une des options, une action est effectuée.

Menu déroulant

Il s’agit également d’un “ menu ”, si ce n’est que le “ menu contextuel ” n’est visible que lorsque vous cliquez à l’aide
du bouton droit de la souris sur un objet ou sur une feuille de travail.

Curseur

Le curseur est symbolisé par la flèche visible à sur l’écran. Cette flèche suit les mouvements de votre souris.

Boîte de dialogue

Une boîte de dialogue est une fenêtre qui vous permet de modifier des paramètres.

Feuille de travail
C ’est sur la feuille de travail que vous réalisez votre concept ou votre dessin. Il s’agit de l’élément central du
programme.

Fenêtre de travail
Il s’agit de la fenêtre complète dans laquelle se trouvent les règles et les barres de défilement. Elle comprend en
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outre la feuille de travail ainsi que l’espace qui l’entoure.

Boutons

L’expression “ Cliquez sur le bouton OK ” signifie que vous êtes invité à cliquer sur le bouton “ OK ” à l’aide du bouton
gauche de la souris.

Options

Dans une boîte de dialogue, une option est activée lorsqu’une croix se trouve devant l’option ou lorsque le cercle situé
devant l’option est noir.

Clavier

Lorsque vous devez effectuer des opérations à l’aide du clavier, sachez que “ Ctrl + S ” signifie que vous devez
maintenir la touche “ Control ” enfoncée tout en appuyant sur la touche “ S ”.

Souris

EasySIGN recourt aux deux boutons de la souris et part du principe que vous avez paramétré le bouton gauche
comme étant le bouton principal.

Support Produit
S u p p o r t  P r o d u i t  

Si vous vous posez une question à poser au sujet de EasySIGN, commencez par consulter le présent manuel. Si vous
n’y trouvez pas la réponse à votre question, adressez-vous à votre fournisseur.

Lorsque vous appelez votre fournisseur, il est préférable que vous soyez assis devant votre ordinateur et que vous
ayez toute la documentation pertinente sous la main. Veillez à être en mesure de répondre aux questions suivantes.
Quel est le numéro de série de votre version de EasySIGN ?

De quelle version du programme disposez-vous ?
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Prenez note à la lettre des messages d’erreur qui s’affichent à l’écran ou appuyez sur la combinaison de touches
“ Alt+PrintScreen ” pour obtenir une illustration bitmap des messages d’erreur affichés.
Que s’est-il passé ? Que faisiez-vous au moment où le problème s’est produit ?
Avez-vous tenté de résoudre le problème vous-même ? Si oui, comment vous y êtes-vous pris ?
Quelle est votre version de Windows ?
Quels sont les périphériques raccordés à votre système ?
Y a-t-il des cartes spéciales dans votre ordinateur ? Si oui, lesquelles ?

L’écran de EasySIGN
L ’ é c r a n  d e  E a s y S I G N  

Après le lancement du programme, un écran, identique à celui qui figure ci-dessous, apparaît. Les principaux
éléments de cet écran sont décrits ci-dessous.

1 Barre de titre
La barre de titre contient le nom du programme ainsi que le nom du fichier que vous avez ouvert. Elle
comprend également quelques boutons.

2 Barre des menus
 La barre des menus contient le nom des divers menus. Chaque menu est composé de sous-menus qui

renferment les options du programme.

3 Barre d’outils
 Cette barre reprend les options de menu les plus fréquemment utilisées. Il vous suffit de cliquer sur un bouton

pour sélectionner ces options.
 Cette barre peut (à l’instar de toutes les barres situées à cette hauteur) être saisie et être composée à partir

du menu.
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Le programme contient diverses barres d’outils flottantes. Ces barres d’outils sont dites “ flottantes ”, car vous
pouvez poursuivre les opérations sur la feuille de travail de travail lorsque vous utilisez ces barres d’outils,
contrairement aux boîtes de dialogue.

4 Boîte à outils
 La boîte à outils contient les options les plus souvent utilisées. Il vous suffit de cliquer sur le bouton

correspondant à l’option que vous souhaitez mettre en œuvre pour l’activer. La touche “ TAB ” est une touche
de raccourci qui permet de passer rapidement du dernier outil sélectionné à l’outil de sélection (la flèche) et
inversement.

5 Règles
 Les règles se trouvent à gauche et au sommet de la fenêtre de travail du programme. Ces règles vous donnent

un aperçu de l’emplacement et de la grandeur des objets situés sur votre feuille de travail.

6 Barres de défilement
Deux barres de défilement sont placées sur votre fenêtre de travail, l’une au bas de la fenêtre et l’autre sur le
côté droit. Elles vous permettent de déplacer votre feuille de travail horizontalement et verticalement par
rapport à l’image.
Si vous souhaiter déplacer l’image, vous pouvez également utiliser la barre d’espacement. Dans ce cas, le
pointeur de la souris prend la forme suivante.

Déplacez la souris (barre d’espacement et bouton gauche de la souris enfoncés) pour déplacer la feuille de
travail.

7 Barre d’état
La barre d’état se trouve au bas de l’écran. Elle permet d’obtenir les données relatives à l’objet qui a été
sélectionné.

8 Feuille de travail
L’espace blanc affiché à l’écran porte le nom de feuille de travail. La feuille de travail est représentée par un
angle droit et par une bande d’entraînement par picots sur les deux côtés. L’entraînement par picots indique
dans quelle direction le support passe dans l’imprimante.

Travailler avec EasySIGN

Installation de EasySIGN 

L’installation de EasySIGN s’effectue sans problème selon une procédure simple, même pour les utilisateurs
débutants. Pour prendre connaissance de cette procédure, veuillez vous reporter au manuel d’installation.

Désinstallation de EasySIGN 

Si vous décidez de faire disparaître EasySIGN de votre système, sélectionnez l’option “ EasySIGN uninstal ” du
groupe de programmes de EasySIGN (dans le menu “ Démarrer ”, option “ Programme ” de Windows).



27EasySIGN

Lancement de EasySIGN 

Une fois que vous avez réalisé le “ Setup ” du programme, un groupe de programmes qui porte le nom de EasySIGN
32 apparaît dans le menu “ Démarrer ” de Windows. Ce groupe de programmes contient notamment l’icône
correspondant à EasySIGN 32. Il vous suffit de cliquer sur cette icône pour lancer le programme EasySIGN 32.

Interface

EasySIGN Application Look
E a s y S I G N  A p p l i c a t i o n  L o o k

The first time you run the software it will be using the default Application look. This look is highly optimized to be as
less distractive as possible. It uses a neutral color and easy to recognize icons. 

If however you feel more comfortable with a different look this is very easy to change.
Select the menu 'Vie w > App lica tion Look > x x x' where 'xxx' stands for a long list of different looks to choose
from. No restart is necessary so just select them one by one until you find the one you like best.
 
The last selected look is the one the software will be using with each new session until you change the look again.   
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MDI tabs
M D I  t a b s

The first time you run the software it will be using MDI tabs.

MDI tabs have several advantages over old style MDI windows.

1 Very easy navigation between documents.

2 Preview of every worksheet in the Windows 7 taskbar. 

3 Context menu with several useful options.

Manage the MDI tabs
To manage the MDI tabs right click on an empty space of the worksheet and select the command 'Interface'.



29EasySIGN

This will open the same dialog as if you would have chosen the menu 'Vie w > Se ttings'.

1 Switch the tabs on or off.
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2 Choose if and where you want a close button on the tabs.

3 Choose the style of the tabs.

4 Tabs on top or on bottom.
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5 Every tab its own color.

6 Document icons displayed on tabs.

7 Document menu.

8 Drag tabs to a different location.

9 Each tab has its own context menu.
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Customize toolbars
C u s t o m i z e  t o o l b a r s

You can customize existing toolbars and even create your own.

Right click on the menu and select from the context menu the command 'Customize'.

This will open the following dialog.

1 Make sure that you have the 'Toolbars' tab selected.

2 Existing toolbars.

3 Reset the selected toolbar to its original state.

4 Reset all toolbars to their original state. this will also delete any custom toolbar.

5 Create a new toolbar.

6 Rename a toolbar. Only possible on your own toolbars.

7 Delete a toolbar. Only possible on your own toolbars.

Click on 'New...' (5).
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Give the new toolbar a name
and click on 'OK'.

This will create a small empty
new toolbar.

Click on the tab
'Commands' (1). From the
'Categories' list (2) on the left
select the menu you want to
use. From the 'Commands'
list (3).
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On the right drag the
commands you want to use to
the new toolbar.

When you are done close this
dialog.

Your new toolbar is ready to
use.

Create tools
C r e a t e  t o o l s

You can create links to other software (tools) which are automatically displayed in a menu.

Right click on the menu and select from the context menu the command 'Customize'.

This will open the following dialog.
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Make sure that you have the 'Tools' (1) tab selected and click on the button for a new entry (2). 

Enter 'Notepad' in the field that appears (3).
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Enter the path and name of the executable in the 'Command' field (4), or use the browse button (5) to browse to the
executable. When you are done click on 'Close' (6).

Select the menu 'File  > T oo ls  > x x x' where 'xxx' stands for the tool you have added.

Customize shortcut keys
C u s t o m i z e  s h o r t c u t  k e y s

You can create your own Shortcut Keys and they will even appear in the menus.

Right click on the menu and select from the context menu the command 'Customize'.
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This will open the following dialog.

1 Make sure that you have the 'Keyboard' tab selected.

2 Category, here is where you select the menu.

3 Accelerator, make sure this is set to default.

4 Commands, the commands in the menu you have selected under 'category' (1).

5 Current keys, the current assigned key (if any) to the command you have selected under
'Commands' (4).

6 Assign the shortcut Key you have typed in the field 'Press new Shortcut Key' (9).

7 Remove a Shortcut Key.

8 Reset all shortcut Keys to their default values.

9 Type/Press the Shortcut Key as you will use it.

Example
Let's add a Shortcut Key to the command 'Quick connect' from the 'Arrange' menu.
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As you can see in the menu, there is no Shortcut Key assigned to this
command.

Select from 'Category' (2) the menu 'Arrange'.

Select from 'Commands' (4) the command 'Quick Connect'.

Set your cursor in the field 'Press new Shortcut Key' (9). Press and hold on
your keyboard the Control key and then the '1'.

The button 'Assign' is now enabled, click on it to assign the new Shortcut
Key.

The new Shortcut Key is now assigned to 'Quick Connect'. Press 'C lose' to
close this dialog.

If you now go to the command 'Quick connect' from the 'Arrange' menu
you can see that the new Shortcut Key is also added to the menu.

Menu behavior
M e n u  b e h a v i o r

You can customize the menu behavior to your liking.

Right click on the menu and select from the context menu the command 'Customize'.
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This will open the following dialog.

1 Make sure that you have the 'Menu' tab selected.

2 Make sure that 'Design doc' is selected.

3 Select the menu animation you want.

4 Check this if you want the menu to have shadows.

5 Use the 'Reset' button to reset all menu's to their original state.

Manage menu items
M a n a g e  m e n u  i t e m s

You can add or remove new commands to the existing menus, rearrange them and even create new menus.

Right click on the menu and select from the context menu the command 'Customize'.
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This will open the following dialog.

Make sure that you have the 'Commands' tab (1) selected.

Rearrange menu items
Now that this dialog is open you can start rearranging the menus. 

The image shows the current order of the top level menu items. Click on the 'File' menu and drag it behind the 'Help'
menu. 

The menu looks now like above. Drag every menu item to a different position.

Let's stop here and try something else.
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Click on the 'Text' menu to open it and
select the command 'Case'.

Drag the command 'Case' to the menu
'Arrange' and hold it above the menu
'Arrange' until this menu opens (don't let
go of your mouse button yet).

When the menu 'Arrange' opens drag the
command 'Case' just above the
command 'Group'. As you can see you
can even move commands from one
menu to another.

You can also drag commands from the dialog to the menus.
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Under 'Categories' select
'Arrange' and under
'Commands' select and drag
'Group' to the 'Text' menu.

Create your own menu

In the dialog select under
'Categories' the item 'New
menu' (1).
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Under 'Commands' select and
drag the command 'New
menu' (1) to the right of the
main menu, just after
'Text' (remember, we have
rearranged all the menu
items).

Right click on the new menu
item and select the command
'Button Appearance...' (1).

In the field 'Button text' enter
a name for the menu item.
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Start selecting menus in the
Categories (1) list and drag
commands from the
'Commands' (2) list to the
new menu.

In no time you have created
your own 'Favorites' menu.
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If you want to reset the
menus to their original state
just select the tab 'Menu' (1)
and press the button 'Reset' (
2).

Associate mouse double-click
A s s o c i a t e  m o u s e  d o u b l e - c l i c k

You can associate a mouse double-click on an empty space on the worksheet to a certain menu command.

Right click on the menu and select from the context menu the command 'Customize'.

This will open the following dialog.
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1 Make sure that you have the 'Mouse' tab selected.

2 Make sure 'Worksheet' is selected.

3 Check the option 'Associate double-click event with'.

4 Choose the command of your liking (in our case this is 'FileOpen').

5 Click on 'Close' to close the dialog.

If you now double click on an empty space of the worksheet the File Open dialog will open.

Large icons
L a r g e  i c o n s

If desired you can change the size of the icons from all the toolbars.

Right click on the menu and select from the context menu the command 'Customize'.

This will open the following dialog.
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1 Make sure that you have the 'Options' tab selected.

2 Check the option 'Large icons'.

3 Click on 'Close' to close the dialog.

On top the toolbox with standard
icons and on the bottom the
toolbox with large icons.

Arrange Interface
A r r a n g e  I n t e r f a c e

You can arrange the interface completely to your liking. Menu, Toolbars, Dockers etc. can be made floating, dragged
to a different docking location, closed or put in 'Auto hide' mode.
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If you for example want the Object manager and Color docker both visible at the same time just drag one of them
into the other. An advanced docker helper Wil help you getting them on the right place.

If you want the dockers hidden but instantly
accessible when you hover the mouse over
them, just put them in auto hide mode. Click on
the 'Auto hide button' (1).
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The dockers will hide themselves on the side
they were docked.

If you want to make them visible again, just
hover your mouse over the icons. If your mouse
leaves the dockers they will hide themselves
again.

Just play around to get comfortable with all the possibilities with the interface, you will be pleasant surprised.

Ribbon
R i b b o n

The first time you run the software it will be using menus. If you are a user that likes Ribbons like e.g. in Microsoft
Word™ you can easily change the interface to a Ribbon interface.

To change to the Ribbon interface right click on an empty space of the worksheet and select the command 'Interface'.

This will open the same dialog as if you would have chosen the menu 'Vie w > Se ttings'.
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Make sure that the tab 'Interface' (1) is selected and check the option 'use Ribbon interface (needs restart)' (2).

Click on 'OK' to accept the changes and restart the software.

The interface of EasySIGN is now a Ribbon interface that basically works the same as the Microsoft Word™ Ribbon.
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If for example you select the 'Effects' tab you have all the effects instantly at your disposal.

The same goes for the tab 'Text'.

Selecting the tab 'Create' gives you access to the drawing tools, import, export, Compatibility, insert objects etc.
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Just have a good look around and see what works for you, the Menu interface or the Ribbon interface.

Ouverture et fermeture d’une session
O u v e r t u r e  e t  f e r m e t u r e  d ’ u n e  s e s s i o n  

Nouvelle feuille de travail 
Une feuille de travail vierge apparaît systématiquement lors du lancement du programme. Comme le logiciel est une
MDI (Multiple Document Interface), vous pouvez ouvrir plusieurs feuilles de travail en même temps. 

Ouverture de feuilles de travail existantes 

Il vous suffit de sélectionner l’option “ Ouvrir ” du menu “ Fichier ” pour ouvrir une feuille de travail existante. Une
boîte de dialogue s’affiche à l’écran. Elle vous permet de sélectionner votre feuille de travail et de l’ouvrir.

Annulation d’opérations 

Le programme actualise les opérations que vous avez effectuées au cours d’une session. Si vous avez commis une
erreur ou si vous souhaitez modifier une opération que vous venez de réaliser, vous pouvez les annuler à l’aide de
l’option “ Annuler ” du menu “ Traiter ”. Ci-dessous figure la liste des opérations qu’il vous est impossible d’annuler :

 certaines opérations relatives à des fichiers, tels que “ Ouvrir ” et “ Enregistrer ” ;
 la sélection d’un objet ;
 la modification de l’illustration (zoom, etc.) ;
 la mise en place de lignes de références et la modification de paramètres déterminés ;
 le traitement des lignes panneau ;
 le déplacement de croix de bordure spéciales.

L’option “ Fichier, paramètres généraux ” de l’onglet “ Généralités ” vous permet de déterminer le nombre
d’opérations à annuler.

L’option “ Rétablir ” suit l’option “ Annuler ”. Elle vous permet de rétablir la ou les opérations que vous venez
d’annuler.

Annuler

Touches de raccourci “ CTRL+Z ”

Rétablir

Touches de raccourci “ CTRL+A ”

Introduction des préférences

L’option “ Paramètres généraux ” du menu “ Fichier ” et l’option “ Paramètres ” du menu “ Vue ” vous permettent de
déterminer différents paramètres généraux. Ces options vous donnent notamment la possibilité d’adapter les
propriétés d’une feuille de travail, de déterminer les propriétés d’une grille, de spécifier l’unité de mesure globale que
le programme doit utiliser, etc.

Fermeture de EasySIGN 

L’option “ Quitter ” du menu “ Fichier ” vous permet de mettre un terme à la session en cours.

Affichage de la feuille de travail

EasySIGN dispose de trois modes d’affichage.

Modèle fil de fer 
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Cette option affiche tous les objets qui se trouvent sur la feuille de travail comme un modèle fil de fer. Aucun objet
n’est rempli. Vous pouvez uniquement sélectionner un objet en cliquant sur son contour.

Rempli

Tous les objets remplis sont affichés tels quels.

Qualité supérieure

Cette option permet de réaliser le meilleur affichage qui soit de tous les objets.

Actualisation de la fenêtre 

Lorsque l’écran continue d’afficher le résultat d’opérations antérieures, vous pouvez actualiser la fenêtre. Pour ce
faire, il vous suffit de sélectionner l’option “ Rafraîchir ” du menu “ Fenêtre ”.

Touche de raccourci “ F5 ”

 

Déplacement de la fenêtre de travail 

Barres de défilement 
Les barres de défilement horizontale et verticale qui se trouvent sur le bord de l’écran vous permettent de visualiser
les parties de votre dessin qui sont à l’extérieur de la fenêtre de travail.

Flèches de la barre de défilement
Cliquez sur la flèche de la barre de défilement pour déplacer, par petits incréments, la fenêtre dans la direction
souhaitée.

Barres
Cliquez sur la barre pour déplacer, par grands incréments, la fenêtre dans la direction souhaitée.

Blocs de défilement
Le bloc de défilement peut être déplacé dans les deux directions. 

Glissement
Vous pouvez également déplacer la feuille de travail en maintenant la barre d’espacement enfoncée. Le curseur se
présente alors sous la forme suivante.

Cliquez sur la feuille de travail tout en maintenant la barre d’espacement enfoncée, puis faites glisser la feuille de
travail à l’endroit voulu. Relâchez la barre d’espacement, puis le bouton de la souris.

Outil de zoom
O u t i l  d e  z o o m

Cliquez sur le bouton suivant de la barre d’outils si vous souhaitez utiliser l’une des options de zoom disponibles.

Un sous-menu composé des options suivantes s’affiche à l’écran.

Zoom avant



54 EasySIGN

Le curseur se transforme comme indiqué ci-dessous lorsque vous sélectionnez cette option.

Vous pouvez activez le zoom avant en cliquant une fois à l’aide de la souris ou en agrandissant un rectangle autour
de la zone que vous souhaitez soumettre au zoom avant.

Zoom arrière
Le curseur se présente sous la forme suivante lorsque vous sélectionnez cette option.

Vous pouvez activez le zoom avant en cliquant une fois à l’aide de la souris sur la feuille de travail. Le point sur lequel
vous cliquez se déplace vers le centre de la fenêtre.

Tout
Cette option vous permet de soumettre à un zoom avant tous les objets qui se trouvent sur la feuille de travail qu’ils
soient sélectionnés ou non.

Sélection
Cette option vous permet de soumettre à un zoom avant tous les objets sélectionnés.

Page
Cette option vous permet de soumettre la page à un zoom avant.

Précédent
Cette option vous renvoie au mode d’affichage précédent.

Arranger et transformer les icônes

Généralités
G é n é r a l i t é s

Le déplacement, la duplication et la suppression d’objets figurent au nombre des fonctions de base de tout
programme. A l’instar de la plupart des opérations de EasySIGN 32, ces opérations peuvent être effectuées de deux
manières différentes : d’une part, par le glissement de la souris et, d’autre part, par l’introduction de valeurs
numériques dans la boîte de dialogue. Certaines opérations peuvent également être exécutées par l’intermédiaire de
touches de raccourci. Ainsi, vous pouvez supprimer des objets en appuyant sur la touche “ Delete ” et les dupliquer
en appuyant sur la combinaison de touches “ CTRL + D ”.

L’option “ Dupliquer ” du menu “ Traiter ” peut être utilisée pour copier des objets. Cette option vous permet de
réaliser la copie exacte d’un objet. Vous pouvez également faire glisser l’objet à l’aide de la souris. Il vous suffit de
cliquer une fois sur le bouton droit de la souris avant de relâcher le bouton gauche de la souris. Le programme réalise
alors une copie de l’objet. Vous pouvez également suivre cette procédure pour laisser la copie d’une ligne de
référence.

L’exploitation des propriétés magnétiques des lignes de référence, des nœuds et d’une grille vous permet de
positionner des objets rapidement et précisément. Cette fonction extrêmement précise vous évite de devoir réaliser
un zoom avant important pour assurer un positionnement correct.

Pour réaliser des compositions complexes, vous pouvez utiliser toute une série d’options destinées à arranger les
objets. Parmi ces options, citons le centrage, la superposition et le groupement d’objets.
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Déplacement des objets
D é p l a c e m e n t  d e s  o b j e t s  

Déplacement à l’aide de la souris 
Le déplacement à l’aide de la souris s’effectue de la même manière, que vous travailliez en modèle fil de fer ou en
couleurs, si ce n’est qu’il existe une petite différence entre ces deux modes d’affichage. Lorsque vous travaillez en
modèle fil de fer, vous devez toujours sélectionner l’objet en cliquant sur l’un de ses côtés ; par contre, en mode
couleurs, vous pouvez cliquer à n’importe quel endroit de l’objet pour le sélectionner. Dans la suite du manuel, nous
employons systématiquement le terme “ sélectionner ” et nous vous laissons libre de choisir de travailler dans le
mode qui vous convient (modèle fil de fer ou couleurs). Le principe suivant s’applique aux deux modes d’affichage :
lorsque vous placez le pointeur de la souris sur un nœud, un carré rouge apparaît pour vous indiquer que vous
pouvez sélectionner l’objet par l’intermédiaire de ce nœud (sauf si vous avez activé l’option “ Nœuds magnétiques ”).

Amenez l’outil de sélection sur l’objet à déplacer.

Cliquez sur l’objet pour le sélectionner et maintenez le bouton de la souris enfoncé.

Déplacez la souris et amenez le pointeur de la souris à l’endroit où vous souhaiter positionner l’objet. Quelle que soit
la forme de l’objet, celui-ci se transforme lors du déplacement en un cadre jaune qui reproduit les lignes de limite de
l’objet. Le pointeur de la souris prend la forme d’une croix qui indique les directions dans lesquelles l’objet peut être
déplacé.
Le déplacement de l’objet s’arrête dès que vous relâchez le bouton de la souris.

Si vous maintenez la touche “ CTRL ” enfoncée pendant le déplacement, l’objet est déplacé selon une ligne
horizontale ou verticale (selon la direction du déplacement). 

Déplacement à l’aide de valeurs numériques 

Combinaison de touches de raccourci “ ALT+F7 ”

Sélectionnez l’objet que vous souhaitez déplacer de manière numérique.

Cliquez une fois sur le bouton droit de la souris pendant que l’objet est sélectionné. Un menu contextuel  s’affiche
alors à l’écran.
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Sélectionnez l’option “ Transformations ” du menu contextuel. Un sous-menu s’affiche à l’écran. Sélectionnez l’option
“ Position ” dans ce sous-menu.

La boîte de dialogue de déplacement contient diverses possibilités d’introduction.

Position (1)
Cette case reprend la position horizontale “ X ” et la position verticale “ Y ” de l’objet sélectionné.

Origine (2)
Les boutons présents dans cette case indiquent l’origine de l’objet. Dans la boîte de dialogue représentée ci-dessus, le
bouton situé en bas à gauche est activé et les champs “ X ” et “ Y ” comprennent les valeurs “ 100 ”. Cela signifie que
le coin inférieur gauche de l’objet est situé à 100 unités du bord gauche de la feuille de travail et à 100 unités du bord
inférieur de la feuille de travail.

Laisser original (3)
Si cette option est activée, l’objet est déplacé, mais l’original est laissé.

Déplacement relatif (4)
Si vous sélectionnez cette option, les valeurs des champs “ X ” et “ Y ” changent. Dans l’exemple suivant, nous
prenons comme point de départ un objet de 50 unités de largeur et de 50 unités de hauteur qui se trouve en bas à
gauche de la page au point zéro.

1 Sélectionnez les options “ Laissez original ” et “ Déplacement relatif ”.
2 Cliquez sur le bouton “ En haut à droite ” dans le groupe “ Origine ”.

3 Introduisez la valeur “ 50 ” dans les champs “ X ” et “ Y ”.
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4 Cliquez sur le bouton “ Appliquer ”.
5 Le résultat se présente comme suit.

 L’objet est déplacé de 50 unités vers le haut et vers la droite et l’original est laissé.

Fermer
Ce bouton permet de fermer la boîte de dialogue.

Appliquer
Lorsque ce bouton est activé, vous pouvez appliquer les paramètres introduits.

Déplacement à l’aide des touches de flèche 
Dans le menu “ Paramètres généraux ”, la boîte de dialogue figurant sous l’onglet “ Généralités ” vous permet de
déterminer la distance à laquelle vous allez déplacer l’objet à l’aide des touches de flèche.

 

Conseils
C o n s e i l s

Mouvements saccadés pendant le déplacement à l’aide de la souris
Ce problème indique que vous avez probablement activé la propriété magnétique de la grille. Désactivez cette
propriété pour remédier aux mouvements saccadés.

Déplacement uniquement vertical ou horizontal
Utilisez cette fonction pendant le déplacement à l’aide de la touche “ CTRL ”. Maintenez cette touche enfoncée lorsque
vous déplacez l’objet à l’aide de la souris. Comme cette touche est une touche de limitation, vous devez d’abord
relâcher le bouton de la souris, puis relâcher la touche “ CTRL ” lorsque vous procédez à un déplacement le long
d’une ligne verticale ou horizontale.

Déplacement à l’aide des nœuds sélectionnés
Lorsque vous placez le pointeur de la souris au-dessus du nœud d’un objet, vous pouvez sélectionner cet objet. Si
vous avez activé l’option “ Nœuds magnétiques ”, il vous sera plus facile de placer directement des objets les uns
contre les autres sans l’intervention des lignes de référence magnétiques. 

Rotation d’objets
R o t a t i o n  d ’ o b j e t s  

Rotation à l’aide de la souris 
Cliquez une fois sur l’objet pour le sélectionner. Huit poignées de sélection apparaissent autour de l’objet sélectionné.

Cliquez une nouvelle sur l’objet à l’aide de la souris.
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Les poignées de sélection sont à présent modifiées. Vous pouvez uniquement utiliser les poignées qui se trouvent aux
coins de l’objet pour effectuer la rotation de celui-ci.

Pour effectuer la rotation, il vous suffit de déplacer la souris dans la direction de rotation voulue tout en maintenant le
bouton gauche de la souris enfoncé.

Pendant l’exécution de la rotation, l’objet reste visible. Sa nouvelle position est indiquée par une ligne bleue qui
représente le contour de l’objet.

La rotation est terminée dès que vous relâchez le bouton de la souris.

Axe de rotation de l’objet 
L’axe de rotation de l’objet est représenté par le symbole suivant.

Il vous suffit de déplacer ce symbole à l’aide de la souris et de le placer à l’endroit voulu sur la feuille de travail. L’axe
de rotation détermine le point autour duquel la rotation de l’objet est effectuée. 

Déplacement de l’axe de rotation
Cliquez à deux reprises sur un objet non sélectionné pour faire apparaître les leviers de rotation.

Amenez le curseur sur l’axe de rotation. Vous pouvez entamer le déplacement dès que le curseur se transforme en
croix.

Vous pouvez déplacer l’axe de rotation et l’amener à n’importe quel endroit de la feuille de travail.
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Lorsque vous entamez une rotation, vous constatez que l’objet pivote autour du point sur lequel vous avez placé l’axe
de rotation.

Si vous faites glisser l’axe de rotation à l’aide la touche “ CTRL ”, vous pouvez le replacer exactement au centre de
l’objet.

Rotation à l’aide de valeurs numériques 

Combinaison de touches de raccourci “ ALT+F8 ”

 Sélectionnez l’objet dont vous souhaitez réaliser la rotation de manière numérique.

 Cliquez une fois sur le bouton droit de la souris pendant que l’objet est sélectionné. Un menu contextuel s’affiche
alors à l’écran.
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 Sélectionnez l’option “ Transformations ” du menu contextuel. Un sous-menu s’affiche alors à l’écran. Sélectionnez
l’option “ Rotation ” de ce sous-menu.

Rotation (1)
 Un champ de saisie dans lequel vous pouvez introduire le nombre de degrés correspondant à la rotation que vous
souhaitez effectuer s’affiche. Ce champ comporte deux cases qui vous permettent de déterminer dans quelle direction
la rotation sera effectuée.

Origine (2)
 Les boutons de cette case désignent l’axe de rotation de l’objet.

Laisser original (3)
 Si vous activez cette option, la rotation de l’objet est effectuée, mais l’original est laissé.

Rotations spéciales 
Le positionnement de l’axe de rotation en combinaison avec la boîte de dialogue de rotation vous permet de mieux
maîtriser la rotation. Si vous déplacez l’axe de rotation, la boîte de dialogue de rotation s’affiche à l’écran, ce qui vous
permet de déplacer les objets selon un modèle répétitif.

Exemple
 Sélectionnez l’objet à deux reprises afin de faire apparaître les poignées de rotation.

 Déplacez ensuite l’axe de rotation.
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 Faites maintenant apparaître la boîte de dialogue de rotation à l’écran à l’aide du menu contextuel.

 Au niveau de “ Origine ” (2), où figurent en principe les boutons qui vous permettent de déplacer l’axe de rotation
vers le sommet d’un angle ou vers le côté d’un objet, vous constatez la présence de l’icône suivante.

 Introduisez maintenant “ 30 degrés ” dans le champ de rotation, puis activez l’option “ Laisser original ” (3). Une fois
ces deux opérations terminées, cliquez à 12 reprises sur le bouton “ Appliquer ”.

Vous avez réalisé de manière simple une composition constituée d’un objet situé à chaque endroit où se trouvent en
principe le chiffre d’une horloge.
Au lieu de cliquer à plusieurs reprises sur le bouton “ Appliquer ” de la boîte de dialogue, vous pouvez effectuer une
seule rotation à l’aide de la boîte de dialogue ou de la souris, puis répéter l’opération en sélectionnant l’option
“ Répéter ” du menu “ Traiter ” ou en appuyant sur la combinaison de touches de raccourci “ CTRL + R ”.

Inclinaison de l’objet
I n c l i n a i s o n  d e  l ’ o b j e t

Inclinaison à l’aide de la souris 
Cliquez une fois sur l’objet pour le sélectionner. Huit poignées de sélection apparaissent autour de l’objet sélectionné.

Cliquez une fois de plus sur l’objet à l’aide de la souris.

 

Les poignées de sélection sont modifiées. Utilisez les poignées latérales de l’objet pour effectuer l’inclinaison.
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Vous pouvez procéder à l’inclinaison d’un objet en déplaçant la souris dans l’une des directions indiquées par le levier
fixé.

Inclinaison à l’aide de valeurs numériques 

Combinaison de touches de raccourci “ ALT+F11 ”

Sélectionnez l’objet que vous souhaitez incliner de manière numérique.

Cliquez une fois sur le bouton droit de la souris lorsque l’objet est sélectionné. Un menu contextuel s’affiche alors à
l’écran.

Sélectionnez l’option “ Transformations ” du menu contextuel. Un sous-menu s’affiche alors à l’écran. Sélectionnez
l’option “ Incliner ” de ce sous-menu.



63EasySIGN

Angle (1)
Vous pouvez introduire dans ce champ de saisie le nombre de degrés correspondant à l’inclinaison souhaitée. Ce
champ comporte deux cases qui vous permettent de déterminer la direction dans laquelle l’inclinaison de l’objet doit
être réalisée.

Origine (2)
Les boutons indiquent l’origine de l’axe qui a été utilisé comme point d’ancrage pour réaliser l’inclinaison. Les schémas
suivants indiquent la différence existant entre les différents points d’ancrage.

Situation de départ

Origine Résultat

  

  

  

Laisser original (3)
Si vous avez activé cette option, l’objet est incliné, mais l’original est laissé.

Reflet d’objet
R e f l e t  d ’ o b j e t  

Reflet à l’aide de la souris 
Cliquez une fois sur l’objet pour le sélectionner. Huit poignées de sélection apparaissent autour de l’objet.
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Vous pouvez utiliser chacun des leviers de sélection pour refléter l’objet.

Maintenez maintenant le bouton gauche de la souris enfoncé et déplacez le pointeur vers la droite. Appuyez sur la
touche “ CTRL ” pour refléter l’objet sans le déformer. La touche “ CTRL ” est une touche de limitation qui permet de
limiter le mouvement à des étapes de 100 % de la taille de l’objet.

Si vous cliquez une fois à l’aide du bouton gauche de la souris pendant que vous procéder au reflet à l’aide de la
souris, vous laissez automatiquement un original de l’objet.

Reflet à l’aide de la boîte de dialogue 

Combinaison de touches de raccourci “ ALT+F10 ”

Sélectionnez l’objet que vous souhaitez refléter.

Cliquez une fois sur le bouton droit de la souris pendant que l’objet est sélectionné. Un menu contextuel s’affiche alors
à l’écran.
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Sélectionnez l’option “ Transformations ” de ce menu contextuel. Un sous-menu s’affiche alors à l’écran. Sélectionnez
l’option “ Refléter ” de ce sous-menu.

Refléter (1)
Les deux rectangles de sélection vous permettent de refléter l’objet : si vous activez le rectangle supérieur, l’objet est
reflété selon un axe horizontal, tandis que si vous activez le rectangle inférieur, l’objet est reflété selon un axe
vertical. Vous pouvez activer les deux options en même temps.

Origine (2)
Les boutons indiquent l’origine de l’axe qui est utilisé comme point d’ancrage pour effectuer le reflet. Les schémas
suivants indiquent la différence existante entre les divers points d’ancrage. Dans les exemples figurant ci-dessous,
nous avons activé les deux options “ Horizontal ” et “ Vertical ”, ainsi que l’option “ Laisser original ” (3). L’objet muni
des leviers de sélection est l’objet reflété.

Situation de départ

Origine Résultat
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Dimensionnement et déformation d’objet
D i m e n s i o n n e m e n t  e t  d é f o r m a t i o n  d ’ o b j e t  

Dimensionnement et déformation à l’aide de la souris 
Cliquez une fois sur l’objet pour le sélectionner.

Les leviers de sélection entourés dans le schéma ci-dessous servent au dimensionnement.

Pour agrandir l’objet, il vous suffit d’éloigner le curseur de l’objet.
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Pour réduire l’objet, il vous suffit de rapprocher le curseur de l’objet.

Si vous appuyez sur la touche “ Shift ” pendant l’agrandissement ou la réduction de l’objet, l’objet est dimensionné à
partir du centre.

 

Si vous appuyez sur la touche “ CTRL ” pendant l’agrandissement de l’objet, l’agrandissement est réalisé par des
incréments correspondant au double de la taille de l’objet.

 

Les leviers de sélection entourés dans le schéma ci-dessous servent à la déformation.

A l’instar du dimensionnement, la déformation est régie par le principe suivant : l’objet est déformé à partir de son
centre si vous appuyez sur la touche “ Shift ” et est déformé par incrément de 100 pour cent si vous appuyez sur la
touche “ CTRL.

Dimensionnement et déformation à l’aide de valeurs numériques 

Combinaison de touches de raccourci “ ALT+F9 ”
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Sélectionnez l’objet que vous souhaitez dimensionner ou déformer.

Cliquez une fois sur le bouton droit de la souris pendant que l’objet est sélectionné. Un menu contextuel s’affiche alors
à l’écran.

Sélectionnez l’option “ Transformations ” dans ce menu contextuel. Un sous-menu s’affiche alors à l’écran.
Sélectionnez l’option “ Dimensionner ” de ce sous-menu.

Taille (1)
Ici figurent les valeurs horizontale (“ X ”) et verticale (“ Y ”) du format de l’objet sélectionné.

Origine (2)
Ces boutons indiquent l’origine de l’objet sélectionné.

Laisser original (3)
Si vous activez cette option, l’objet est dimensionné ou déformé, mais l’original est laissé.

Proportionnel (4)
Si cette option est activée, vous pouvez uniquement procéder au dimensionnement de l’objet. Toute valeur introduite
au niveau de “ X ” a une influence sur la valeur inscrite au niveau de “ Y ”, et inversement.

Selon valeur (5)
Si cette option est activée, les dimensions réelles de l’objet sont indiquées dans les champs “ X ” et “ Y ”.
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Exemples de dimensionnement
L’objet muni des leviers de sélection représente le résultat final.

Situation de départ

Origine Résultat
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Assistant de transformation
A s s i s t a n t  d e  t r a n s f o r m a t i o n

L’assistant de transformation est une boîte de dialogue flottante qui  vous aide à appliquer les transformations
proposées par le programme (positionnement, rotation, etc.). Vous pourriez ainsi entrer une valeur pour le
positionnement horizontal puis valider avec la touche Entrée. Vous avez le choix d’afficher ou non la boîte de dialogue
(“ Afficher ”, “ Assistant de transformation ”).

Vous pouvez modifier l’apparence et la forme du dialogue en étirant les côtés de la boîte.

Composantes de l’assistant de transformation

Position

Horizontale

Verticale

Taille
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Horizontale

Verticale

Biais

Horizontal

Vertical

Rotation

Bi-
directionnelle

La rotation peut se faire dans les deux directions (valeur positive ou
négative).

Miroir

Horizontal

Vertical

Point
d’ancrage

Le changement de l’ancrage a des conséquences sur :
La position
La taille
Le biais
La rotation
Le miroir

Si vous situez le point d’ancrage en bas à gauche, la transformation partira de cette position.

Dans l’exemple ci-dessus, le point d’ancrage est fixé en bas à gauche. La rotation agit sur les frontières de l’objet.
Vous devez garder à l’esprit que les frontières d’un objet ne sont plus les mêmes après une rotation : des effets que
vous n’attendiez pas pourraient se produire si une deuxième rotation était appliquée. 

Dans l’exemple ci-dessus, la boîte rouge indique la position d’origine de l’objet. La boîte bleue marque les frontières
de l’objet et le point jaune le point de rotation. Notez que la frontière de l’objet change après chaque rotation et donc
que change aussi le point de rotation. Reportez-vous au chapitre “ Objet en rotation ” pour en savoir plus sur le
fonctionnement du point de rotation. 
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Proportions 
Cette option permet de relier les proportions des champs suivants :
Position horizontale et verticale
Taille horizontale et verticale

Pourcentage 
Avec cette option, les champs du menu “ Taille ” sont mesurés en pourcentage de l’objet original et non en valeurs
réelles.

Position relative 
Avec cette option, le positionnement se fait relativement à la position actuelle.

Conserver un original 
Une copie est générée après chaque transformation (sauf s’il s’agit d’un “ Ordre ”).

Ordres

Avancer

Mettre devant

Reculer
 

Mettre à
l’arrière

Duplication d’objet
D u p l i c a t i o n  d ’ o b j e t  

Pour copier un objet, vous pouvez utiliser l’option “ Dupliquer ” ou les options “ Couper ”, “ Copier ” et “ Coller ”. Vous
avez donc recours au presse-papiers interne de EasySIGN.

Placer la copie d’un objet dans le presse-papiers interne

 Combinaison de touches de raccourci “ CTRL+C ”

1 Sélectionnez l’objet que vous souhaitez copier.
2 Sélectionnez l’option “ Copier ” du menu “ Traiter ” (ou cliquez sur le bouton correspondant de la barre

d’outils).

Couper un objet et le placer dans le presse-papiers interne

 Combinaison de touches de raccourci “ CTRL+X ”

1 Sélectionnez l’objet que vous souhaitez couper.
2 Sélectionnez l’option “ Couper ” du menu “ Traiter ” (ou cliquez sur le bouton correspondant de la barre

d’outils). L’objet disparaît et se place dans le presse-papiers interne.

Placer un objet situé dans le presse-papiers interne sur la feuille de travail

 Combinaison de touches de raccourci “ CTRL+V ”

Sélectionnez l’option “ Coller ” du menu “ Traiter ” (ou cliquez sur le bouton correspondant de la barre d’outils).

Dupliquer

Combinaison de touches de raccourci “ CTRL+D ”

L’option “ Dupliquer ” du menu “ Traiter ” vous permet de réaliser la copie de l’objet sélectionné.
 
Duplication sur l’original
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Touche de raccourci “ + ” du pavé numérique

Cette option du menu “ Traiter ” vous permet de placer une copie de l’objet exactement au-dessus de l’original.

Suppression d’objet
S u p p r e s s i o n  d ’ o b j e t  

Touche de raccourci “ DEL ”

Si vous souhaitez supprimer un objet de la feuille de travail, sélectionnez l’option “ Supprimer ” du menu “ Traiter ” ou
appuyez sur la touche “ Delete ”.

ArraAlignement d’un objet
A r r a A l i g n e m e n t  d ’ u n  o b j e t  

Les différentes options de la barre de menu “ Aligner objets ” vous permettent d’aligner les objets les uns par rapport
aux autres, de les agrandir ou de les centrer sur la page.

Important !
Le principe suivant s’applique à toutes les options de cette barre de menu (à l’exception de l’option de centrage) : le
dernier objet sélectionné détermine l’alignement de l’autre objet. En d’autres termes, le dernier objet sélectionné ne
change pas de place.

Placez deux objets sur la feuille de travail.

Sélectionnez le premier objet de la série que vous souhaitez aligner.

Sélectionnez le dernier objet de la série que vous souhaitez aligner.

Cliquez sur le bouton “ Aligner à gauche ” de la barre de menu “ Aligner objets ”.

Cliquez sur le bouton “ Appliquer ” de la barre de menu “ Aligner objets ”.

Vous constatez que le premier objet sélectionné est aligné sur le côté gauche du dernier objet sélectionné.
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Options d’alignement
O p t i o n s  d ’ a l i g n e m e n t  

Dans cette partie, nous allons décrire les diverses options d’alignement ainsi que les différentes combinaisons
d’options qu’il est possible d’utiliser.

Emplacement sur la barre de menu

Options 

A Alignement à gauche

B Centrer verticalement

C Aligner à droite

D Aligner haut

E Centrer horizontalement

F Aligner bas

G Centrer tous les objets sélectionnés au centre de la page

H Elargir tous les objets sélectionnés dans les mêmes
proportions

I Elever tous les objets sélectionnés dans les mêmes
proportions

J Appliquer les options sélectionnées

Combinaisons d’options

Situation de départ

Combinaison Résultat

 



76 EasySIGN

 

 

 

 

 

 

 

 

Les combinaisons figurant ci-dessus peuvent également être utilisées avec les options suivantes.

Elargir tous les objets sélectionnés dans les mêmes proportions

Elever tous les objets sélectionnés dans les mêmes proportions

Ces deux options peuvent être utilisées aussi bien séparément qu’ensemble. A titre d’exemple, citons la combinaison
suivante.

Distribution (espacer régulièrement)
D i s t r i b u t i o n  ( e s p a c e r  r é g u l i è r e m e n t )

Les options de distribution permettent de placer les objets de manière à ce que les distances entre eux soient égales.
Le logiciel peut calculer la distance entre les objets ou bien vous pouvez la spécifier vous-même.

Calculer automatiquement la distance
Ces options se trouvent dans la barre d’outils « Aligner objets ». Vous pouvez également y accéder via le menu
« Arranger, Espacer régulièrement »
.
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A : Distribuer horizontalement
Sélectionnez les objets que vous souhaitez distribuer, puis choisissez une option dans la barre d’outils d’alignement.
Après avoir appuyé sur le bouton "Entrée" de la barre d'outils d'alignement, les objets seront distribués
horizontalement. Les deux objets le plus à l’extérieur restent fixes et jouent le rôle d’ancre. Les autres objets se
positionnent donc par rapport à eux. 
 

Optio
n

Résultat

1

2

3

4

B : Distribuer verticalement

Cette option fonctionne de la même manière que « Distribuer horizontalement », sauf que les objets sont distribués
verticalement.

Vous pouvez utiliser simultanément la distribution horizontale et verticale. Toutefois, il est recommandé de traiter
séparément la distribution horizontale et la distribution verticale. Vous pouvez également combiner les options de
distribution avec les options d’alignement. Si vous combinez les options de distribution avec les options d’alignement,
le dernier objet sélectionné reste fixe et joue le rôle d’une ancre.

C : Options d’alignement du texte

Dans la barre d’outils d’alignement, cliquez sur le bouton « C » pour ouvrir la boîte de dialogue « Paramètres
d’extension de l’alignement du texte ». Voir le chapitre « Options d’alignement du texte » pour une description
détaillée. 

Spécifier la distance

Cette option est disponible via le menu “Arranger, Espacer régulièrement, Distribution ».
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1 Alignement horizontal

Options de gauche à droite :
Ne rien faire.
Distance entre le côté gauche et le côté gauche.
Distance entre le centre et le centre.
Distance entre le côté droit et le côté droit.
Distance entre le côté droit et le coté gauche de l’objet suivant.

2 Spécifier la distance

Si vous le souhaitez, vous pouvez spécifier une distance horizontale entre les objets définie
par l’utilisateur.

3 Distribuer verticalement

Options de gauche à droite :
Ne rien faire.
Distance entre le côté inférieur et le côté inférieur.
Distance entre le centre et le centre.
Distance entre le côté supérieur et le côté supérieur.
Distance entre le côté supérieur et le coté inférieur de l’objet suivant.

4 Spécifier la distance

Si vous le souhaitez, vous pouvez spécifier une distance horizontale entre les objets que vous
déterminerez vous-même.

Options d’alignement du texte
O p t i o n s  d ’ a l i g n e m e n t  d u  t e x t e

En raison de la complexité des objets texte et des opinions diverses concernant la meilleure méthode pour aligner ce type d’objet, il existe

différentes options d’alignement pour le texte. Sélectionnez « Vue, Paramètres », choisissez l’onglet « Texte » et cliquez sur le bouton

« Fonctions texte étendues… ».
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1 Aligner le texte avec blanc

2 Aligner le texte sans blanc

3 Aligner le texte sur la ligne de base

Vous pouvez sélectionner n’importe quelle combinaison d’options. Les paramètres définis dans cette boîte de dialogue s’appliquent à toute la

solution logicielle.    

A Zone gris clair

Il s’agit du « blanc » d’un texte.

B Zone gris sombre

Il s’agit de la forme vectorielle ou de la courbe d’un texte (option : sans blanc).

C Nœuds (petits carrés)

Points d’origine des caractères distincts.

D Ligne orange

Ligne de base, passe à travers les points d’origine des caractères distincts.

Plusieurs exemples avec différents paramètres sont illustrés -ci-dessous.
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Si vous souhaitez aligner le texte correctement typographiquement (et visuellement), activez la combinaison d’options ci-dessous.

Si vous êtes satisfait de l’option unique d’alignement du texte des versions antérieures à la version 5, activez la combinaison d’options ci-

dessous.

Règles
R è g l e s

Les règles verticale et horizontale de EasySIGN se trouvent au sommet et à gauche de l’écran. Les règles sont
graduées selon l’unité de mesure choisie.
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Grille
G r i l l e

Il s’agit d’une grille de points qui est placée sur la page. Lorsque l’option “ Grille magnétique ” est activée, la grille
permet de faire en sorte que tous les déplacements de la souris soient limités à un multiple de la distance de la grille.

 

Lignes de référence
L i g n e s  d e  r é f é r e n c e

Vous pouvez introduire des lignes de référence dans une feuille de travail qui n’en comporte aucune de deux
manières différentes.

 1 Amenez le pointeur de la souris dans la règle, puis cliquez le bouton droit de la souris.
 Un menu contextuel s’affiche alors à l’écran.

 Le menu contextuel aux lignes de référence renferme les options suivantes :

 “ Masquer/Afficher ” ;
 “ Paramètres grille ” ;
 “ Paramètres ligne de référence ”.

 Si vous cliquez sur l’option “ Paramètres ligne de référence ” à l’aide de la souris, la boîte de dialogue suivante
s’affiche à l’écran.
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 La boîte de dialogue comporte trois onglets (1). Le premier onglet concerne les opérations relatives aux lignes
de référence horizontales, le second, les opérations relatives aux lignes de référence verticales et le troisième,
les opérations relatives aux lignes de référence diagonales.

 Dans la partie gauche de la boîte de dialogue, se trouvent les coordonnées numériques de l’emplacement des
lignes de référence (2). S’il existe plusieurs lignes de référence, vous pouvez modifier les propriétés de
chacune d’entre elles en cliquant sur la valeur numérique de la ligne de référence. La valeur de la ligne de
référence sélectionnée est affichée dans la fenêtre de texte qui se trouve à côté (3). 

Suppression des lignes de référence 
Sélectionnez la ligne de référence (2), puis cliquez sur le bouton “ Supprimer ” (6).

Déplacement de lignes de référence
Sélectionnez la ligne de référence (2), puis introduisez une nouvelle valeur (3), avant de cliquer sur le bouton
“ Déplacer ” (5).

Ajout de lignes de référence 
Introduisez une valeur (3), puis cliquez sur le bouton “ Ajouter ” (4).

2. Amenez le pointeur de la souris sur une règle, puis faites glisser la ligne de référence sur la feuille de travail.

Traitement des lignes de référence
Si vous souhaitez traiter les lignes de référence situées sur une feuille de travail, amenez le pointeur de la souris sur
la ligne de référence à traiter, puis cliquez sur la ligne à l’aide du bouton droit de la souris. Un menu contextuel
s’affiche alors à l’écran.

Ce menu contextuel consacré aux lignes de référence renferme les options suivantes :
 “ Supprimer ” ;
 “ Lignes de référence magnétiques ” ;
 “ Placer en avant-plan/Placer en arrière-plan ” ;
 “ Tout masquer ” ;
 “ Propriétés ”.
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“ Supprimer ”
Cette option vous permet de supprimer la ligne de référence sélectionnée. Vous pouvez également la supprimer en la
faisant glisser vers une règle.

“ Lignes de référence magnétiques ”
Cette option vous permet de placer des objets de manière magnétique contre des lignes de référence.

“ Placer en avant-plan/Placer en arrière-plan ”
Cette option vous permet de faire apparaître les lignes de référence devant ou derrière les objets d’une feuille de
travail.

“ Masquer ”
Cette option masque toutes les lignes de référence présentes dans une feuille de travail sans pour autant les
supprimer. Pour faire réapparaître les lignes de référence, il vous suffit d’amener le pointeur de la souris sur une
règle, puis d’afficher la boîte de dialogue “ Paramètres lignes de référence ” en cliquant sur le bouton droit de la
souris. Activez ensuite l’option “ Afficher lignes de référence ” de cette boîte de dialogue.

“ Paramètres ” 
Cette option vous permet de faire apparaître la boîte de dialogue “ Paramètres lignes de référence ”. 

Lignes de référence diagonales
Vous pouvez introduire une ligne de référence diagonale de deux manières différentes.

1 Ouvrez la boîte de dialogue, puis introduisez les valeurs numériques horizontale, verticale et d’angle sous
l’onglet “ Lignes de référence cursives ”.

2 Faites glisser la ligne de référence hors de la règle, puis positionnez-la. Sélectionnez ensuite cette ligne de
référence à l’aide de la souris tout en appuyant sur la touche “ Shift ”. Le mouvement de la souris vous permet
de déterminer manuellement l’angle de la ligne de référence.

“ Propriétés magnétiques ”
La propriété principale des lignes de référence réside dans leur magnétisme. Vous pouvez activer et désactiver cette
propriété magnétique, car elle peut avoir des effets négatifs lors de certains déplacements d’objets. Pour ce faire, il
vous suffit de faire apparaître le menu contextuel en cliquant sur le bouton droit de la souris, puis d’activer ou de
désactiver l’option “ Lignes de référence magnétiques ”.

Accrochage magnétique (accrocher)
Si vous déplacez un objet dans son ensemble, cet objet restera accroché aux poignées de sélection. 
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Si vous souhaitez placer un objet de forme irrégulière contre une ligne de référence, vous pouvez également
accrocher un nœud de cet objet sur cette ligne de référence.

La procédure à suivre est décrite ci-dessous.
Passez le pointeur de la souris au-dessus de l’objet. Dès que le nœud est trouvé, un carré rouge s’affiche à l’écran.

Dès que vous apercevez le carré, cliquez sur le carré à l’aide de la souris. Vous pouvez maintenant accrocher ce
point sur une ligne de référence ou sur un croisement entre plusieurs lignes de référence.

Vous pouvez également accrocher les lignes de référence sur ces nœuds des objets.

Exemple
Votre feuille de travail contient un objet à la gauche duquel vous avez l’intention d’aligner d’autres objets.

Faites glissez une ligne de référence d’une règle.

Déplacez cette ligne de référence au-dessus du côté gauche de l’objet jusqu’à ce qu’un carré rouge apparaisse.
Relâchez ensuite la ligne de référence. La ligne de référence se placera alors exactement sur le côté gauche de
l’objet.
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Conseils
C o n s e i l s

Placement de lignes de référence doubles
Vous pouvez faire glisser deux lignes de référence perpendiculaires à partir des règles. Ce système est
particulièrement utile lorsque vous voulez placer rapidement des lignes de référence sur l’angle d’un objet.

Grouper/dégrouper des objets
G r o u p e r / d é g r o u p e r  d e s  o b j e t s  

Grouper

Combinaison de touches de raccourci “ CTRL+G ”

L’option “ Grouper ” du menu “ Arranger ” vous permet de verrouiller les objets en position les uns par rapport aux
autres. 

Dégrouper

Combinaison de touches de raccourci “ CTRL+U ”

L’option “ Dégrouper ” du menu “ Arranger ” vous permet de séparer les uns des autres les objets réunis au sein d’un
groupe.

Dissociation multiple
D i s s o c i a t i o n  m u l t i p l e

S'il existe plusieurs groupements ou des groupements contenant des groupements imbriqués dans une sélection, vous
pouvez utiliser la commande “Organiser, Dissocier” ou le raccourci “CTRL+U”, jusqu'à ce que tous les groupements
soient supprimés de la sélection. Cela vous évite de dissocier une sélection et de sélectionner un nouveau
groupement avant d'utiliser de nouveau la commande “Dissocier”.

Combiner/scinder des objets
C o m b i n e r / s c i n d e r  d e s  o b j e t s

Combiner

Combinaison de touches de raccourci “ CTRL+L ”

L’option “ Combiner ” du menu “ Arranger ” vous permet de combiner deux objets (ou davantage) du même type.
Cette opération est plus radicale que celle qui consiste à grouper les objets. En effet, dans le cas de la combinaison,
les objets séparés n’en forment plus qu’un seul.

Les lettres sont souvent des objets combinés. Ainsi, la lettre “ b ” est une forme composée d’un contour externe et
d’un contour interne. Comme ces contours sont combinés, seule la lettre est remplie, l’orifice du “ b ” restant
transparent. 

Si vous combinez des objets vecteurs de couleurs ou de styles de ligne différents, l’objet qui en résulte prend la
couleur du dernier objet sélectionné.

Supposons que vous souhaitez créer la lettre “ b ” à partir des objets figurant ci-dessous. Ce que vous avez à faire en
l’occurrence, c’est faire en sorte que la barre affichée soit également visible dans l’orifice de la lettre “ b ”.
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Si vous placez l’objet en haut à gauche du contour externe de la lettre “ b ”, vous obtenez le résultat suivant.

La lettre “ b ” reste composée de deux objets de couleur différente, tandis que la barre n’est pas visible au travers de
l’objet.

Si vous conférez à l’objet supérieur la même couleur que celle de l’arrière-plan, cela ressemble davantage à la lettre
“ b ”, mais la lettre “ b ” est encore composée de deux objets de couleur différente. 

Après la combinaison, l’objet se présentera sous la forme suivante.

Scinder

Combinaison de touches de raccourci “ CTRL+K ”

Scinder consiste à neutraliser la combinaison d’objets.

Fractionnement intelligent
F r a c t i o n n e m e n t  i n t e l l i g e n t

Si plusieurs objets sont combinés pour former un objet, vous pouvez scinder cet objet pour retrouver les objets
d'origine à l'aide de la commande “Scinder”.

Comme le montre l'illustration, si vous souhaitez scinder des objets de type texte, vous devez d'abord recombiner
chaque objet pour conserver la forme visuelle d'une lettre. Le programme peut maintenant effectuer cette opération
automatiquement grâce à la commande “Organiser, Fractionnement intelligent”.

Original
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Après la commande “Organiser, Scinder”

Après la commande “Organiser, Fractionnement intelligent”

Ordre d’empilement des objets
O r d r e  d ’ e m p i l e m e n t  d e s  o b j e t s  

Les options du menu “ Arranger, Séquence ” permet de modifier l’ordre d’empilement des objets. L’ordre
d’empilement des objets détermine si un objet se trouve devant ou derrière un autre objet. 

Avancer

Cette option permet d’avancer d’une place l’objet sélectionné dans l’ordre d’empilement.

Placer à l’avant-plan

 
Cette option permet de placer l’objet sélectionné en première place dans l’ordre d’empilement.

Reculer 

Cette option permet de reculer l’objet sélectionné d’une place dans l’ordre d’empilement.

Placer à l’arrière-plan

Cette option permet de placer l’objet à la dernière place de l’ordre d’empilement.



88 EasySIGN

Ordre d'empilage étendu dans la version 4
O r d r e  d ' e m p i l a g e  é t e n d u  d a n s  l a  v e r s i o n   4

En sélectionnant l'option "Organiser, Ordre, Inverser la sélection", vous pouvez inverser l'ordre d'empilage des objets
sélectionnés.

Vous pouvez placer un objet directement à n'importe quelle position dans la pile. Sélectionnez l'objet que vous
souhaitez déplacer dans l'ordre d'empilage, puis sélectionnez "Organiser, Ordre, Placer devant ou Placer derrière". Le
curseur change de forme. Sélectionnez ensuite l'objet derrière ou devant lequel vous souhaitez placer l'objet
sélectionné.

Multiplication d’objets
M u l t i p l i c a t i o n  d ’ o b j e t s  

Cette option vous permet de réaliser plusieurs copies en une seule opération. Le nombre de copies à réaliser
horizontalement et verticalement peut être déterminé. Vous pouvez en outre spécifier l’espace requis (espace entre
les contours des copies à générer). 
Pour ce faire, il vous suffit de sélectionner l’option “ Multiplier ” du menu “ Arranger ”.
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Vous pouvez indiquer dans les champs prévus à cet effet (1) le nombre de copies verticales et horizontales dont vous
avez besoin. Vous pouvez en outre indiquer l’espace requis entre les copies dans le champ (2).

Multiplier cercle
M u l t i p l i e r  c e r c l e

Cette commande permet de créer plusieurs copies placées dans une forme circulaire. Sélectionnez un ou plusieurs
objets, puis sélectionnez le menu “Organiser, Multiplier”. Dans la boîte de dialogue qui s'affiche, sélectionnez l'onglet
“Cercle”. 

Dans cette boîte de dialogue, le centre de l'objet sélectionné est indiqué sous “Centré” (1). Ces champs indiquent
l'emplacement de l'objet sélectionné dans la feuille de travail. Sous “Rayon” (2), vous pouvez entrer le rayon de la
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forme circulaire. Lorsque vous ouvrez la boîte de dialogue, un numéro basé sur la taille de l'objet sélectionné s'affiche
dans ce champ. Le rayon est calculé à partir du centre de l'objet sélectionné jusqu'au centre des objets dans la forme
circulaire obtenue après la multiplication.

Vous trouverez les paramètres suivants sous “Angles”.

Début:
Entrez ici le point de départ de la forme circulaire. Pour ces paramètres, vous pouvez vous référer à l'illustration
située dans le coin inférieur droit de la boîte de dialogue.  

Fin:
Entrez ici le point d'arrivée de la forme circulaire. Si vous entrez 0 degré dans le champ “Début”, 180 degrés dans le
champ “Fin” et 6 dans le champ “Etapes”, vous créez une forme circulaire comportant 7 objets, avec une rotation de
30 degrés entre chaque objet. 

Si vous entrez 0 degré dans le champ “Début”, 330 degrés dans le champ “Fin” et 11 dans le champ “Etapes”, vous
créez une forme circulaire comportant 12 objets, avec une rotation de 30 degrés entre chaque objet.

Dans les deux illustrations ci-dessus, “A” est l'objet d'origine et “B” est la copie de cet objet. Les autres objets
dépendent du nombre entré dans le champ “Etapes”. L'objet d'origine n'est jamais inclus dans la forme circulaire
obtenue.

Etapes:
Entrez ici le nombre d'étapes à utiliser dans la forme circulaire obtenue.

Chaque étape:
Les champs “Fin” et “Etapes” sont désactivés si ce champ est activé. Le nombre que vous avez précédemment entré
dans le champ “Fin” est recalculé à chaque ajustement du champ “Chaque étape”.

Direction:
Vous pouvez indiquer ici le sens de la rotation.

L'option “Faire pivoter objets” (4) permet d'indiquer si l'axe de l'objet doit rester identique lors de la rotation ou si
vous souhaitez le faire pivoter.
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Dans l'exemple “A”, l'option “Faire pivoter objets” a été activée. Dans l'exemple “B”, cette option n'a pas été activée.

Verrouillage du point de rotation

Pour verrouiller le point de rotation afin que l'objet d'origine ne soit pas le centre mais une partie de la forme
circulaire, vous devez resélectionner l'objet pour accéder au mode rotation. Vous pouvez alors déplacer le centre
rotation vers l'emplacement souhaité. Vous accédez ensuite à la boîte de dialogue. Dans cette boîte de dialogue, les
options “Centré” et “Rayon” sont désactivées car vous avez déjà défini ces paramètres dans la feuille de travail. Dans
ce cas, l'objet d'origine sera toujours une partie, et non le centre, de la forme circulaire.  

Multiplier spirale
M u l t i p l i e r  s p i r a l e

Cette commande permet de créer plusieurs copies placées dans une spirale. Sélectionnez un ou plusieurs objets, puis
sélectionnez le menu “Organiser, Multiplier”. Dans la boîte de dialogue qui s'affiche, sélectionnez l'onglet “Spirale”. 
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Dans cette boîte de dialogue, le centre de l'objet sélectionné est indiqué sous “Centré” (1). Ces champs indiquent
l'emplacement de l'objet sélectionné dans la feuille de travail. Sous “Rayon” (2), vous pouvez entrer le rayon de
début et de fin de la spirale. Lorsque vous ouvrez la boîte de dialogue, un numéro basé sur la taille de l'objet
sélectionné s'affiche dans ces champs. Le rayon est calculé à partir du centre de l'objet sélectionné jusqu'au centre
des objets dans la spirale obtenue après la multiplication.

Vous trouverez les paramètres suivants sous “Angles”.

Début:
Entrez ici le point de départ de la spirale.

Fin:
Entrez ici le point d'arrivée de la spirale. Si vous entrez 0 degré dans le champ “Début”, 360 degrés dans le champ
“Fin” et 12 dans le champ “Etapes”, vous créez une spirale comportant 13 objets, avec une rotation de 30 degrés
entre chaque objet. 

Si vous entrez 0 degré dans le champ “Début”, 720 degrés dans le champ “Fin” et 24 dans le champ “Etapes”, vous
créez une spirale comportant 25 objets, avec une rotation de 30 degrés entre chaque objet.
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Dans les deux illustrations ci-dessus, “A” est l'objet d'origine et “B” est la copie de cet objet. Les autres objets
dépendent du nombre entré dans le champ “Etapes”. L'objet d'origine n'est jamais inclus dans la spirale obtenue.

Etapes:
Entrez ici le nombre d'étapes à utiliser dans la spirale obtenue.

Chaque étape:
Les champs “Fin” et “Etapes” sont désactivés si ce champ est activé. Les nombres que vous avez précédemment
entrés dans les champs "Etapes" et “Fin” sont recalculés à chaque ajustement du champ “Chaque étape”.

Direction:
Vous pouvez indiquer ici le sens de la rotation.

L'option “Faire pivoter objets” (4) permet d'indiquer si l'axe de l'objet doit rester identique lors de la rotation ou si
vous souhaitez le faire pivoter.

Dans l'exemple “A”, l'option “Faire pivoter objets” a été activée. Dans l'exemple “B”, cette option n'a pas été activée.

Verrouillage du point de rotation

Pour verrouiller le point de rotation afin que l'objet d'origine ne soit pas le centre mais une partie de la spirale, vous
devez resélectionner l'objet pour accéder au mode rotation. Vous pouvez alors déplacer le centre rotation vers
l'emplacement souhaité. Vous accédez ensuite à la boîte de dialogue. Dans cette boîte de dialogue, les options
“Centré” et “Rayon” sont désactivées car vous avez déjà défini ces paramètres dans la feuille de travail. Dans ce cas,
l'objet d'origine sera toujours une partie, et non le centre, de la spirale.  
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Multiplication améliorée
M u lt ip lic a t io n  a m é lio r é e

Dans la version 5, la multiplication a été améliorée pour que les copies restent modifiables. Cette fonction s’appelle
« Répétition ». Dans EasySIGN, cela signifie que les copies peuvent toujours être modifiées et pas seulement durant
l’application de cette option. Lorsque vous enregistrez une feuille de travail et que vous la rouvrez ensuite, l’outil de
déplacement vous permet de modifier le nombre de copies. En vérifiant les options de l’objet, vous pouvez modifier
d’autres paramètres tels que le vide entre les copies.

Procédure

Sélectionnez l’objet ou les objets que vous souhaitez multiplier. Sélectionnez le menu « Arranger », « Multiplier ».
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Définissez les paramètres comme vous le souhaitez, puis activez l’option « Modif iable ». Puis cliquez sur « OK ».

Vous êtes maintenant en mode outil de déplacement. Cet outil vous permet de déplacer la poignée afin d’augmenter ou de diminuer le nombre

de copies.

Si vous souhaitez modif ier le vide ou d’autres paramètres par le biais de la boîte de dialogue, choisissez l’option « Propriétés » dans le menu

qui apparaît en cliquant sur le bouton droit de la souris.

Outil de mesure et de correction
O u t i l  d e  m e s u r e  e t  d e  c o r r e c t i o n

Cet outil vous permet de mesurer et de corriger les distances et les angles des objets.

Si vous souhaitez modifier un ou plusieurs objets, commencez par les sélectionner. Sélectionnez ensuite l’option
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“ Mesurer et escaler ” du menu “ Arranger ”.

Rotation à l’aide de l’outil de mesure et de correction
Lorsqu’un objet est scanné et vectorisé, il apparaît légèrement incliné à l’écran dans la plupart des cas. L’outil de
mesure et de correction vous permet de placer cet objet à l’horizontale en une seule opération. Il vous suffit de
sélectionner l’objet, puis d’activer l’outil de mesure et de correction. Recherchez ensuite deux points de l’objet qui
doivent se trouver à l’horizontale, puis tracez une ligne en pointillés entre ces deux points en maintenant le bouton de
la souris enfoncé. 

La boîte de dialogue suivante s’affiche à l’écran lorsque vous relâchez le bouton de la souris.

Si vous indiquez “ 0 ” dans le champ “ Angle ” (2), l’objet se placera automatiquement à l’horizontale.

Cette boîte de dialogue vous permet également de modifier le facteur de dimensionnement des objets (1). Cette
formule se révèle très pratique pour modifier la longueur d’un côté oblique. Si vous sélectionnez plusieurs objets, il
s’avère souvent impossible de procéder à une mesure précise. Les objets extérieurs ne sont en effet pas toujours
alignés sur une seule ligne. Pour ces raisons, EasySIGN dispose de “ poignées invisibles ”. Cela signifie que à
l’intérieur des points des poignées sur lequel la souris s’accroche automatiquement. Ces points indiquent la largeur et
la hauteur maximum des objets.
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Dimensionnement rapide
D i m e n s i o n n e m e n t  r a p i d e

Vous pouvez enregistrer et appliquer les tailles fréquemment utilisées dans EasySIGN pour pouvoir les réutiliser.
Sélectionnez la commande "Organiser, Transformations, Dimensionnement rapide".

1 Liste des tailles disponibles.
2 Ajouter une nouvelle taille.

3 Changer une taille sélectionnée.
4 Supprimer une taille sélectionnée.

Pour appliquer une taille, sélectionnez-la dans la liste et cliquez sur "OK".
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Placer les objets sur un chemin
P l a c e r  l e s  o b j e t s  s u r  u n  c h e m i n

Il est possible de placer tous les types d’objet (y compris les groupes, les effets et les bitmaps) sur un chemin vectoriel ouvert ou fermé. 

Pour ce faire, vous devez d’abord sélectionner les objets que vous souhaitez placer sur un chemin.

Ensuite, sélectionnez le menu « Arranger, Objets sur chemin », puis cliquez sur le chemin.

Une fois les objets placés sur un chemin, vous pouvez choisir l’option « Faire pivoter les objets avec le chemin » dans le menu contextuel.

A l’aide de la combinaison CTRL+CLIC, vous pouvez sélectionner des objets placés sur un chemin et les modif ier. Le chemin lui-même peut

être modif ié après l’avoir sélectionné dans le Gestionnaire d’objets.

Exemple
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Fonctionnalités communes

Area and Length
A r e a  a n d  L e n g t h

Usage:
Select one or more objects on the worksheet.
Select menu : View > Area and Length.

The following results are available in this dialog:

Area
Represents the area of the selected object. When more than one object is selected the silhouette of the objects
represents the area that will be calculated. 
Consider the following example.
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One object, width 100mm, height 100mm.
Result:

Two objects like the one above. 
Result:

The same objects as above but now overlapping. 
Result:

Area contour
Represents the area of the selected object ignoring any "holes". When more than one object is selected the outline of
the objects represents the area that will be calculated.
Consider the following example.

One object, width 100mm, height 100mm with a hole in it (width 50mm, height 50mm).
Result:

Two objects like the one above.
Result:
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The same objects as above but now overlapping. 
Result:

Area extends
Represents the area of the extends of the selected object(s). The extends of an object or objects is the smallest
rectangle that can enclose the object(s).
Consider the following example.

Two objects, the red rectangle around these objects represent the selection extend.  

Length
This is the length of all lines that are visible when viewing your worksheet in color mode. Layers, fills and no fills and
stacking order are considered when calculating the length. Using this method will make sure that non visible lines will
not be calculated. 
Consider the following example.

Two overlapping objects, both have a fill.
Result:

Same as above but the bottom object has no fill, the result will be the same as the result
above. 

Same as above but now the overlapping (top) object has no fill.
Result:
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Length wireframe
As the name already implies this is the length of the selected object(s) as you would view them in wireframe mode.
So all the visible lines in wireframe will be calculated.
Consider the following example.

Four overlapping objects which all have a fill. Below that the same objects but shown in
wireframe.
Result:

Options

Treat as one vinyl
color

This option is for clarity and will not trigger a recalculation. It just hides the "Area"
and "Area contour" values leaving only the "Area Extends".
  

Include line width. This option will recalculate the area but now including the line width.

Wireframe for length This option is for clarity and will not trigger a recalculation. It just hides the
"Length" leaving only the "Length Wireframe".

Revenir au dernier outil sélectionné
R e v e n i r  a u  d e r n i e r  o u t i l  s é l e c t i o n n é

Avant la version 4 de EasySIGN, la touche de tabulation permettait de revenir au dernier outil sélectionné. C'est
désormais la touche "Echap" qui exécute cette fonction, puisque la touche de tabulation est utilisée dans les blocs de
texte. Vous verrez également que la première option du menu contextuel des objets est "Outil précédent" qui a la
même fonction que la touche "Echap". 
Il n'est plus nécessaire de choisir d'abord l'outil de sélection pour pouvoir appliquer un effet spécial à un objet
nouvellement créé. Vous pouvez, par exemple, créer un rectangle puis appliquer un effet sans changer d'outil.

Menu contextuel (bouton droit de la souris)
M e n u  c o n t e x t u e l  ( b o u t o n  d r o i t  d e  l a  s o u r i s )

L'utilisation du menu contextuel a changé depuis la version 4 de EasySIGN. Il n'est plus nécessaire de choisir d'abord
l'outil de sélection pour pouvoir accéder au menu contextuel.
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Coller au centre
C o l l e r  a u  c e n t r e

Lorsque vous collez un objet que vous avez copié dans EasySIGN, celui-ci conserve les coordonnées qu'il avait dans
son emplacement d'origine. C'est une fonctionnalité importante, mais peu pratique dans certains cas, notamment lors
d'un zoom avant dans une zone différente de l'emplacement à partir duquel l'objet a été copié.

L'option "Edition, Coller au centre" (également dans le menu contextuel) permet de coller l'objet au centre de la
fenêtre visible en cours.

Copie spéciale
C o p i e  s p é c i a l e

Cette fonction permet de copier la totalité de la feuille de travail ou une partie de celle-ci dans le Presse-papiers. Vous pouvez ensuite coller

cette copie dans un modèle de courrier électronique, une description de travail, une facture, etc.

Sélectionnez le menu « Modif ier, Copie spéciale, En tant que bitmap dans le Presse-papiers ». Cette commande ouvre une boîte de dialogue

dans laquelle vous pouvez spécif ier l’espace de couleur, la taille et la résolution du bitmap.

Chemins vectoriels dans les bitmaps
C h e m i n s  v e c t o r i e l s  d a n s  l e s  b i t m a p s

Les f ichiers PSD (format natif  de Photoshop™) ainsi que d'autres f ichiers peuvent contenir des chemins vectoriels. Lorsque EasySIGN

importe ce type de bitmap, les chemins vectoriels inclus sont regroupés avec le bitmap. Sur le DVD « LIBRARIES », vous trouverez un

dossier nommé « \BITMAP\Masked\Fonts\Chrome005\ », dans lequel chaque bitmap contient un chemin vectoriel. Vous pouvez utiliser le

chemin inclus comme forme de découpe.

Canaux alpha dans les bitmaps
C a n a u x  a lp h a  d a n s  le s  b it m a p s

Entre autres types de fichiers, les fichiers PSD, PNG et TIFF peuvent contenir des informations de canal alpha en plus
des informations standard du bitmap.
Ce canal alpha est un masque en niveaux de gris qui permet à EasySIGN de traiter ce type de bitmap de manière transparente ou masquée.

Pour le moment, EasySIGN peut uniquement importer les f ichiers TIFF en CMJN avec un canal alpha. Les f ichiers PSD et PNG doivent être des

fichiers RVB. Toutefois, après avoir importé ces f ichiers, vous pourrez les convertir en CMJN. Voir la rubrique sur la transparence pour plus

d’informations et pour savoir comment l’appliquer.

Aperçus dans l’Explorateur Windows
A p e r ç u s  d a n s  l’E x p lo r a t e u r  W in d o w s

Un aperçu de tous les formats de fichiers pris en charge par EasySIGN apparaît dans l’Explorateur Windows. Cela
signifie que vous pouvez non seulement voir un aperçu des feuilles de travail, mais également des fichiers Clipart et
des modèles.
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Surbrillance (point brillant) dans les remplissages avec une couleur radiale
S u r b r i l l a n c e  ( p o i n t  b r i l l a n t )  d a n s  l e s  r e m p l i s s a g e s  a v e c  u n e  c o u l e u r  r a d i a l e

Dans EasySIGN, les remplissages avec une couleur radiale prennent en charge la « Surbrillance ». 

A Sélectionnez un objet et appliquez-lui un remplissage avec une couleur radiale.

B Sélectionnez l’outil permettant d’ajuster les remplissages avec une couleur et placez le curseur au-dessus

du dernier nœud. 

C Cliquez sur le bouton droit de la souris et sélectionnez l’option « Aff icher/masquer Surbrillance ».

D Un nœud indiquant l’emplacement du point brillant apparaît.

E Placez ce point brillant où vous le souhaitez.

F Comparez ce remplissage avec une couleur à celui mentionné à l’étape « A » (la première étape ci-dessus).

Souder les bitmaps
S o u d e r  le s  b it m a p s  

Dans la version 5, les bitmaps peuvent également être soudés. La procédure est identique à celle des objets
vectoriels. Voici un petit exemple qui devrait vous aider.

Objets d’origine, un bitmap et un texte.

Sélectionnez d’abord le bitmap, puis le texte. Ensuite, choisissez l’option de menu « Modif ier, Fondre, Masquer dernier sélectionné ».
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Vous pouvez toujours modif ier le texte à l’aide de la combinaison CTRL+CLIC ou du Gestionnaire d’objets.

Vous pouvez également appliquer plusieurs soudures.

Si votre licence vous y autorise, vous pouvez ajouter des effets supplémentaires aux soudures ainsi qu’au bitmap.

Chemins ouverts
C h e m in s  o u v e r t s

Lorsque vous importez des f ichiers vectoriels (par exemple, des feuilles de travail avec l’extension .AI) dans EasySIGN, il se peut que toutes

les formes ne soient pas fermées alors qu’elles devraient l’être. Cela se produit en particulier lorsque vous utilisez un logiciel dont les f ichiers

d’exportation ne sont pas à jour. La correction manuelle de ce problème peut s’avérer très fastidieuse si vous devez vérif ier toutes les

formes de ce travail.

Dans EasySIGN, une nouvelle procédure très précise a été mise en œuvre qui donne des résultats optimum.

Procédure

Sélectionnez tous les objets que vous souhaitez vérif ier. Ensuite, sélectionnez l’option de menu « Modif ier », « Sélectionner les chemins

ouverts ». Si rien n’est sélectionné, c’est que tous les objets de la feuille de travail sont déjà fermés. S’il reste une sélection, vous pouvez

choisir l’option « Arranger », « Fermer les chemins ouverts » pour fermer les chemins ouverts dans la sélection active. Vous pouvez ainsi

entièrement contrôler le résultat f inal, au lieu de le faire automatiquement pendant l’importation.
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Verrouillage d’objets

Sélectionnez l'objet ou les objets que vous souhaitez verrouiller.

Sélectionnez "Organiser, Verrouiller la sélection” (ou la même option dans le menu contextuel de l'objet). Les
poignées de sélection de l'objet prennent la forme de petits verrous et l'objet est verrouillé. Chaque fois que vous
sélectionnez l'objet, ces poignées s'affichent afin de vous montrer que l'objet est verrouillé.

Lorsqu'un objet est verrouillé, il ne peut pas être déplacé ni modifié par inadvertance. En particulier, si vous souhaitez
dessiner un bitmap, il est plus facile de le verrouiller temporairement que de travailler avec des couches verrouillées.

Vous pouvez déverrouiller un objet en sélectionnant "Organiser, Déverrouiller la sélection" (ou la même option dans
le menu contextuel). Vous pouvez également déverrouiller tous les objets d'une feuille de travail en sélectionnant
“Organiser, Déverrouiller tous les objets”.

Quelques propriétés des objets verrouillés
1 Si votre feuille de travail contient des objets verrouillés, la commande "Edition, Sélectionner tout" permet de

sélectionner uniquement les objets non verrouillés.
2 Les objets verrouillés peuvent être imprimés ou tracés. Si vous ne souhaitez pas que les objets soient

imprimés ou tracés, vous devez travailler avec des couches.
3 Les objets verrouillés ne peuvent pas être sélectionnés à l'aide d'une sélection de zone. Vous pouvez

sélectionner plusieurs objets verrouillés en utilisant la touche "Maj".
4 Les objets verrouillés et déverrouillés ne peuvent pas être sélectionnés ensemble.
5 Il n'est pas possible d'appliquer de transformation ni d'effet spécial à des objets verrouillés.
6 Puisqu'un objet verrouillé peut être sélectionné, il est possible d'exécuter une commande telle que "Insérer des

repères de cadrage autour de la sélection".
7 Toutes les fonctions de transformation et d'édition sont également bloquées dans le Gestionnaire d'objets. Il est

donc utile de verrouiller l'objet.

Sélection par taille

Vous pouvez supprimer rapidement de la feuille de travail les objets qui répondent à certains critères de taille.
Généralement, cette tâche prend beaucoup de temps mais elle est nécessaire du fait que, par exemple, après une
vectorisation, il arrive qu'il soit impossible de tracer certains objets trop petits. Au lieu d'effectuer cette opération
manuellement, vous pouvez sélectionner "Edition, Sélection par, Taille ...".
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La boîte de dialogue comporte deux modes, simple (voir l'image ci-dessus) et avancé (voir l'image ci-dessous).

1 Vous pouvez définir ici la taille maximale des objets à sélectionner.
2 Si vous cochez cette option, une sélection déjà active sera choisie en même temps que la nouvelle.
3 Cette option permet de fermer la boîte de dialogue.
4 Sélectionnez ce bouton si vous souhaitez sélectionner le résultat.
5 Sélectionnez ce bouton si vous souhaitez supprimer le résultat.
6 Si vous avez supprimé une sélection par le biais de cette boîte de dialogue, cette action peut être annulée ici.
7 Cette option permet d'activer le mode avancé.

1 Vous pouvez définir les valeurs minimale et maximale d'une largeur et d'une hauteur.
7 Cette option permet de revenir au mode normal.

Sélectionner les objets à partir du haut

Cette fonction permet de sélectionner des objets identiques placés exactement l'un au-dessus de l'autre. Le simple
affichage de la feuille de travail ne vous permettra pas de détecter ces objets. Ces situations se produisent lorsque
vous collez le même objet plusieurs fois au même endroit ou que vous importez un fichier dans lequel le style de
remplissage et de ligne d'un objet ont été exportés en tant que deux formes séparées.

Sélectionnez la commande "Edition, Sélectionner les objets à partir du haut".

Bitmaps
B i t m a p s

Bitmaps comportant un seul bit

Il est maintenant possible de colorier les bitmaps comportant un seul bit (noir et blanc) à l'aide de la palette de
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couleurs. Ces couleurs peuvent également être imprimées. 

A Bitmap d'origine
B Dans la palette de couleurs, cliquez sur le jaune avec le bouton gauche de la souris (couleur de remplissage) et

sur le rouge avec le bouton droit de la souris (couleur du trait).
C Résultat inverse de celui obtenu dans l'exemple A.

Vous pouvez également utiliser l'outil de couleur pour définir les couleurs de remplissage et de trait d'une bitmap
comportant un seul bit en affectant une couleur qui ne figure pas dans la palette de couleurs.

Il est parfois plus judicieux d'utiliser une bitmap numérisée directement en tant que partie de l'impression plutôt que
de la vectoriser d'abord. Lors de la vectorisation, il est parfois plus facile de placer une copie sous la bitmap
vectorisée avec une couleur contrastée, afin de l'utiliser comme référence pour optimiser la vectorisation.

Affichage des bitmaps

Vous disposez maintenant de quatre options d'affichage pour les bitmaps en mode grille.

A Cadre
B Niveaux de gris simples
C Niveaux de gris
D Original

Vous trouverez ces paramètres dans le menu ‘Vue, Qualité”.

Luminosité et contraste

La procédure à suivre est décrite ci-après. Sélectionnez un bitmap, puis cliquez sur le bouton droit de la souris.
Sélectionnez ensuite l’option “ Régler luminosité et contraste ” du menu contextuel.
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1 Luminosité
 Cela vous permet de régler la luminosité du bitmap.

2 Contraste
 Si un bitmap vous semble trop uniforme, vous pouvez accentuer la différence entre les secteurs plus sombres

et les secteurs plus clairs du bitmap.
3 Gamme
 Cette échelle vous permet d’adapter la luminosité des tons intermédiaires.

4 Saturation
 La saturation désigne la pureté de la couleur.

5 Paramètres RGB
 Lorsqu’un bitmap vous paraît trop rouge, trop vert ou trop bleu, vous pouvez corriger ces valeurs à l’aide des

échelles correspondantes.
6 Fermer
 Ce bouton vous permet de fermer la boîte de dialogue.

7 Appliquer
 Ce bouton vous permet d’appliquer au bitmap les modifications introduites dans la boîte de dialogue.

8 Rétablir 
 Ce bouton vous permet de revenir aux valeurs de la boîte de dialogue qui étaient définies avant l’introduction

des modifications. 
9 Variations
 Ce bouton vous permet d’ouvrir la boîte de dialogue consacrée aux variations (reportez-vous à la description

qui figure ci-après).
10 Graphique

 Ce graphique représente la courbe de couleurs adaptée.

Variations

Les “ Variations ” vous permettent de modifier visuellement l’équilibre des couleurs, le contrates, la saturation, etc.
d’un bitmap.
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1 Aperçu (exemple)
 Ces deux reproductions miniatures qui apparaissent au sommet de la boîte de dialogue donnent un aperçu de

l’original et un aperçu des modifications apportées.
2 Horizontal
 Vous pouvez choisir le type de filtre que vous comptez reproduire et adapter horizontalement dans la boîte de

dialogue.
3 Vertical
 Vous pouvez choisir le type de filtre que vous comptez reproduire et adapter verticalement dans la boîte de

dialogue.
4 Incrément 
 Vous pouvez déterminer la grandeur des incréments appliqués aux modifications. Plus cette valeur est élevée,

plus les modifications sont manifestes.
5 Reproduction horizontale
 Les glissements horizontaux sont représentés.

6 Reproduction verticale
 Les glissements verticaux sont représentés.

7 Afficher limite
 Activez cette option si vous souhaitez visualiser les secteurs de l’image qui feront l’objet d’une perte de couleur

lors de l’application d’une modification.
8 OK
 Ce bouton permet d’apporter toutes les modifications introduites au bitmap et de fermer la boîte de dialogue.

9 Annuler
 Ce bouton ferme la boîte de dialogue sans appliquer les éventuelles modifications introduites.

10 Rétablir 
 Ce bouton vous permet de restaurer tous les paramètres introduits.

Mode de fonctionnement
Supposons que vous avez sélectionné l’option “ Horizontal ” pour la “ Brightness ” (“ Luminosité ”) et l’option
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“ Vertical ” pour le “ Contraste ”. Il vous suffit de cliquer sur l’une des reproductions miniatures représentées ci-
dessous pour introduire la modification.

Effets spéciaux

Vous pouvez appliquer des effets spéciaux à tous les bitmaps importés ou scannérisés. Cliquez sur le bouton droit de
la souris pour activer le menu, puis sélectionnez l’option “ Effets spéciaux ”. Un sous-menu s’affiche alors à l’écran.
Ce sous-menu vous offre le choix entre les effets spéciaux disponibles.

La boîte de dialogue consacrée aux effets spéciaux offre les possibilités suivantes.

1 La fenêtre de gauche représente toujours l’original. Si vous amenez la souris sur cette fenêtre, le pointeur de
la souris se transforme en une “ poignée de glissement ”, ce qui vous permet de vous déplacer dans cette
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fenêtre pour visualiser d’autres parties du bitmap.
2 La fenêtre “ Aperçu ” (exemple). 
3 Ce bouton permet d’afficher l’exemple.
4 Si l’option “ Exemple automatique ” est activée, chaque modification introduite est directement affichée dans la

boîte de dialogue.
5 Vous pouvez agrandir ou réduire l’effet sur l’original en modifiant la position de ce bouton de réglage ou en

introduisant un valeur dans le champ placé à côté.
6 “ Evolution ” : l’évolution de l’application de l’effet est représentée.
7 “ OK ” : ce bouton vous permet d’appliquer toutes les modifications introduites et de fermer la boîte de

dialogue.
8 “ Fermer ” : ce bouton vous permet de fermer la boîte de dialogue.
9 “ Appliquer ” : ce bouton vous permet d’appliquer toutes les modifications introduites au bitmap.

Conversion d'objets en bitmap

Voici une manière directe et aisée d'utiliser la commande permettant de convertir des objets sélectionnés sur une
feuille de travail en bitmap. Sélectionnez les objets et le menu "Edition, Convertir en, Bitmap".

1 Vous pouvez définir ici l'espace colorimétrique tel que RVB, un seul bit, noir et blanc, etc.
2 Vous pouvez définir la taille ici.
3 Vous pouvez définir la résolution ici.

Une fois que les paramètres voulus sont appliqués, tous les objets sélectionnés sur la feuille de travail sont convertis
en un seul bitmap.

Mode Bitmap

Cette commande permet de convertir un bitmap dans un autre mode. Sélectionnez le(s) bitmap(s), la commande
“Bitmap, Mode” et l'espace colorimétrique dans lequel vous souhaitez convertir le bitmap. Vous pouvez, par exemple,
passer du mode RVB au mode CMJN et vice-versa etc.
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Travailler avec des couches

Qu’est-ce qu’une couche ?
Lorsque vous ouvrez un document, vous voyez un arrière-plan blanc entouré d’une limite indiquant qu’il s’agit d’une
feuille de travail s’afficher à l’écran. Vous pouvez importer par exemple différents bitmaps sur cette feuille de travail,
ce qui vous permet de créer un objet ou une composition. Si vous souhaitez utiliser plusieurs dizaines de bitmaps, le
système des couches peut vous épargner bien des tracas et vous faire gagner beaucoup de temps.

Supposons que vous utilisez 60 bitmaps. Malgré la rapidité du programme, l’affichage à l’écran de ces bitmaps prend
du temps. Si vous recourez aux couches, vous pouvez masquer certaines parties de votre composition afin
d’accélérer l’affichage.

Mise en œuvre des couches 

Sélectionnez l’option “ Couches ” du menu “ Vue ”.

La boîte de dialogue consacrée aux couches qui s’affiche à l’écran vous propose les couches standard lors de la
première utilisation. Ces couches ne doivent pas être éliminées. Elles portent les noms suivants.

1 Couche principale 
2 Couche de lignes de référence 
3 Couche de croix de bordure 

La couche principale est systématiquement sélectionnée et activée lors de l’ouverture de la boîte de dialogue. Vous
pouvez sélectionner la couche de lignes de référence et la couche de croix de bordure ou modifier leur niveau. Vous
pouvez même effectuer toutes les opérations sur ces couches, mais vous ne pouvez les activer.

Bouton Fonction

Vous permet d’ouvrir une boîte de dialogue par l’intermédiaire de laquelle vous pouvez
ajouter une nouvelle couche.

Cette boîte de dialogue vous offre les possibilités de paramétrage suivantes.

Nom (1)
Introduisez ici le nom que vous souhaiter donner à la couche. Choisissez un nom que vous pourrez aisément
reconnaître.
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Options de couche (2)

Visible (3)
Vous permet de déterminer si la couche est visible ou non.

Verrouillé (4)
Après verrouillage, aucun objet de cette couche ne peut être déplacé ou traité.

A imprimer (5)
Cette option vous permet de déterminer si cette couche peut ou non être imprimée.

A tracer (6)
Cette option vous permet de déterminer si la couche peut ou non être tracée.

Vous permet d’ouvrir une boîte de dialogue par l’intermédiaire de laquelle vous pouvez
paramétrer les propriétés de la couche sélectionnée.

La couche sélectionnée disparaît.

La couche sélectionnée est amenée à un niveau supérieur.

La couche sélectionnée est amenée à un niveau inférieur.

Les objets sélectionnés dans une couche sont déplacés et amenés dans la couche
sélectionnée dans la boîte de dialogue.

Les objets sélectionnés dans une couche sont copiés dans la couche sélectionnée dans
la boîte de dialogue.

Quels sont les divers statuts des couches ?
Les illustrations suivantes décrivent les divers statuts des couches.

Sélectionnée 

Quand une couche est sélectionnée, vous pouvez modifier les propriétés de cette couche par l’intermédiaire des
boutons de la boîte de dialogue.

Cliquez sur la couche pour la sélectionner.

Active 

Cela signifie que si vous importez une illustration par exemple, cette illustration est placée dans la couche active. Un
symbole placé devant le nom de la couche vous indique que la couche est active.

Cliquez deux fois sur la couche pour l’activer.

Active et sélectionnée 
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Add a plotter

To add a plotter select the menu 'File > Device Setup > 'Add Plotter Wizard...'.

Select from the dropdown for drivers (1) the desired device. Click 'Next'.
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Select from the dropdown for Ports (1) the Port your device has been connected to. Click 'Next'.

How this page will look depends on the selected Port from the previous page. On this page make your settings
according the manual supplied with your device.
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To finish the installation of your device, click 'Finish'.

Paramètres du traceur

Select the menu 'File > Device Setup > Open...'. The following Window will become visible.

On the left open the folder 'Plotter Settings' and click on 'Plot Setting 0'. On the right the available plotter settings will
become visible.
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A Trier et optimisation

 

1 Ne pas trier
 L’objet est tracé dans l’ordre dans lequel il a été dessiné.
2 Vitesse
 Les différents objets sont triés de manière à ce qu’ils soient tracés le plus vite possible.
3 Transport vinyle
 Les données sont triées de manière à obtenir un transport vinyle minimal au cours du traçage. La précision du

traçage s’en trouve améliorée au détriment de la rapidité.
4 Entraînement par picots
 Dans le cas d’un traceur à entraînement par picots, EasySIGN tient compte du manque de précision occasionné

par ce système.
5 Intérieur d’abord
 Dans le cas d’un objet combiné, la lettre “ O ” par exemple, l’intérieur est découpé en premier lieu. Ce système

présente deux avantages : d’une part, il permet d’augmenter la qualité du traçage des petites lettres et,
d’autre part, il est essentiel lors du fraisage qui provoque le détachement des formes.

6 Couteau pivotant
 Les formes sont triées de manière à réduire au minimum les endommagements et les imprécisions provenant

du sens du couteau pivotant.
7 Découpe de formes
 Les formes fermées sont découpées à une distance qu’il est possible de paramétrer à partir du début. Ce

système simplifie le dégagement de la feuille.
8 OK
 Ce bouton permet d’appliquer les paramètres modifiés et de fermer la boîte de dialogue.
9 Annuler
 Ce bouton permet de fermer la boîte de dialogue sans appliquer les paramètres modifiés.

B Options de traçage
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1 Qualité
 Précision de la découpe. Une précision supérieure ralentit la vitesse (“ Qualité 80 ” est le meilleur choix dans la

plupart des cas).
2 Découpe de cadres sarclois 
 Si votre feuille de travail contient des cadres sarclois, vous pouvez indiquer si vous comptez les tracer de

manière standard ou non.
3 Traçage relatif
 Permet de placer automatiquement tous les objets à tracer au niveau du point zéro du traceur.
4 Point de départ après le traçage
 Cette option permet de faire en sorte que le traceur se place après la partie tracée après chaque mouvement

de la plume. Vous pouvez également préciser la valeur de la distance. Cette option n’est pas disponible sur
tous les traceurs.

5 Copies supplémentaires
 Vous pouvez activer cette option si vous souhaitez que des copies supplémentaires soient réalisées à chaque

traçage.
6 Plusieurs découpes
 Cette option vous permet de déterminer si le programme doit utiliser plusieurs découpes et de préciser le

nombre de découpes. Vous pouvez également utiliser cette option dans le cas de supports épais qui ne peuvent
en principe pas être découpés en une seule fois.

7 Découpe de la feuille après traçage
 Cette option permet de faire en sorte que le traceur coupe le rouleau de support après chaque traçage. Cette

option n’est disponible que si votre traceur la supporte.
8 OK
 Ce bouton vous permet d’appliquer les paramètres introduits et de fermer la boîte de dialogue.
9 Annuler
 Ce bouton vous permet de fermer la boîte de dialogue sans appliquer les paramètres introduits.

C Paramètres traceur

 

1 Vitesse
 Vous pouvez paramétrer la vitesse de votre traceur. Ce facteur est particulièrement déterminant dans le cas

de longues lignes droites.
2 Accélération
 Accélération du traceur. Ce facteur détermine la vitesse du traceur dans le cas de courbes.



120 EasySIGN

3 Décalage du couteau
 Ce paramètre concerne les traceurs à couteau et vous permet de déterminer la distance centrale du couteau

pivotant.
4 Pression de lame
 Pression exercée par le traceur sur le support.
5 Numéro de plume
 Si votre traceur soutient plusieurs plumes ou couteaux, vous pouvez choisir parmi ceux-ci.
6 OK
 Ce bouton vous permet d’appliquer les paramètres modifiés et de fermer la boîte de dialogue.
7 Annuler
 Ce bouton vous permet de fermer la boîte de dialogue sans appliquer les paramètres modifiés.

D Device Specific

 How this dialog will look is dependent on the selected plotter driver.

La plupart des traceurs ne supportent pas l’ensemble des paramètres énoncés ci-dessus. Si un paramètre est affiché
en gris, cela signifie que votre traceur ne supporte pas cette fonction. Il est possible que vous puissiez introduire la
valeur concernée sur le traceur lui-même. Pour obtenir davantage d’informations à ce sujet, consultez le manuel
d’utilisation de votre traceur. 

Si vous décochez la case à cocher “ Paramètres standard ”, les paramètres standard du traceur seront utilisés. 

Système de gestion des couleurs

Présentation générale du système de gestion des couleurs
P r é s e n t a t i o n  g é n é r a l e  d u  s y s t è m e  d e  g e s t i o n  d e s  c o u l e u r s

EasySIGN est fourni avec système de gestion des couleurs avancé. Après l'installation de EasySIGN, le SGC est
activé par défaut.

Qu'est-ce que le système de gestion des couleurs ?
Lors de l'utilisation de couleurs, une représentation cohérente d'une couleur sur plusieurs équipements, des moniteurs
ou des imprimantes par exemple, est essentielle. Ces équipements doivent pouvoir échanger des informations
colorimétriques pour obtenir un résultat final prévisible.

La couleur est subjective pour l'œil humain. Tous les équipements d'un processus de production ont une gamme de
couleurs différente. Il est possible qu'un moniteur puisse afficher des couleurs que votre imprimante ne peut pas
reproduire. Le système de gestion des couleurs vérifie que votre moniteur n'affiche que des couleurs que votre
imprimante peut reproduire.

La gamme de couleurs qu'un équipement peut reproduire est appelée gamme. La gamme d'un moniteur est différente
de celle d'une imprimante polychrome. Cela signifie qu'une feuille de travail peut contenir des couleurs qui s'affichent
correctement sur un moniteur mais qui ne peuvent pas être reproduites par un équipement de sortie. Un autre
problème est que la gamme de couleurs de plusieurs imprimantes peut être différente. Même sur des imprimantes de
marque et modèle identique, des différences peuvent se produirent. Une représentation exacte des couleurs ne peut
être obtenue que lorsque les gammes différentes de tous les équipements utilisés sont prises en compte.

L'utilisation d'un système de gestion des couleurs minimise les différences entre les équipements d'un processus de
production.

Qu'est-ce qu'un profil ?
Un profil est un fichier décrivant les propriétés colorimétriques d'un équipement, une imprimante polychrome par
exemple. Les profils couleurs sont généralement au format de fichier ICC (International color consortium) ou ICM
(Image color matching). EasySIGN prend en charge ces deux formats ainsi que son propre format interne qui
fonctionne correctement avec les profils ICC et ICM. Ce format interne vous permet d'ajuster les profils ICC et ICM à
votre convenance, ce qui nécessite autrement des logiciels complexes et onéreux.

Comment installer un profil
Lorsqu'un profil vous est fourni par un tiers, vous pouvez l'installer dans EasySIGN en le copiant dans le répertoire
“\EasySIGN\Shared\Profiles\”.  Sinon, vous pouvez installer le profil pour toutes les applications en faisant un clic droit

sur le fichier et en sélectionnant « Installer ».
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Qu'est-ce que le "rendu de l'intention" ?
Le rendu de l'intention vous permet de sélectionner la méthode utilisée par EasySIGN lors de la conversion des
couleurs pour correspondre aux différents équipements. Le problème majeur que vous risquez de rencontrer est que
certaines couleurs peuvent être affichées sur un moniteur mais ne peuvent pas être reproduites par l'imprimante.
Vous pouvez choisir l'une de ces quatre méthodes :

1 Perceptif

Toutes les couleurs d'une gamme d'un équipement sont mises à l'échelle d'une autre gamme,
et les relations entre les couleurs sont maintenues. Cette méthode est recommandée pour la
reproduction de bitmaps numérisées ou importées.

2 Colorimétrique relatif

Cette méthode laisse intactes les couleurs correspondant aux deux gammes. Les couleurs qui
ne figurent pas dans la gamme de l'équipement de sorite seront ajustées, en privilégiant la
luminosité et la couleur au détriment de la saturation. Cette méthode est à privilégier si la
représentation exacte des couleurs est nécessaire, pour l'impression de tons directs par
exemple.

3 Saturation

Met la gamme source à l'échelle de la gamme de destination mais conserve une saturation
relative au lieu d'une teinte, pour que lors d'une mise à l'échelle vers une gamme plus petite,
la teinte puisse être modifiée. Ce rendu de l'intention est principalement conçu pour les
graphiques professionnels, pour lesquels des couleurs lumineuses et saturées sont plus
importantes que la relation exacte entre les couleurs.

4 Colorimétrique absolu

Le rendu colorimétrique absolu reproduit les couleurs exactes de la gamme source et utilise la
teinte reproductible la plus proche pour les couleurs hors gamme, au détriment de la saturation
et éventuellement de la clarté. Cette méthode prend également en compte la couleur du papier
lors de l'impression.

Paramètres
Dans le menu, sélectionnez « Fichier, Paramètres » puis cliquez sur l'onglet « Gestion des couleurs ».

1 Activer la gestion des couleurs
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Vous pouvez définir ici si toutes les feuilles de travail créées doivent utiliser la gestion des
couleurs.

2 Moniteur
Vous pouvez définir ici si EasySIGN doit utiliser le profil du moniteur système (défini dans
Windows) ou un autre profil, défini par l'utilisateur.

3 Règle d'importation de fichiers bitmap
Vous pouvez définir ici la gestion des couleurs d'un fichier bitmap lors de son importation.

Interroger l'utilisateur
Lors de l'importation,  EasySIGN vous demande ce que vous voulez faire.

Ne pas gérer les couleurs
Lors de l'importation d'un fichier bitmap, ses couleurs ne seront pas gérées, même s'il dispose
d'un fichier incorporé.

Utiliser les valeurs par défaut du document
Les paramètres du document s'appliquent également à ce fichier bitmap.

Utiliser le profil incorporé
Si le fichier bitmap dispose d'un profil incorporé, celui-ci est utilisé. Sinon, les paramètres du
document s'appliquent.

Paramètres
Sélectionnez le menu « Vue, Paramètres » et cliquez sur l'onglet « Gestion des couleurs » :

1 Activer la gestion des couleurs
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Cette option active ou désactive la gestion des couleurs.

2 Profil Bitmap

RVB
Vous pouvez choisir ici le profil utilisé pour les fichiers bitmap RVB (24 bits).

CMJN
Vous pouvez choisir ici le profil utilisé pour les fichiers bitmap CMJN.

Intention
Cette option sélectionne le rendu de l'intention pour les fichiers bitmap.

3 Profil d'objet vectoriel

RVB
Vous pouvez choisir ici le profil utilisé pour les objets vectoriels avec un style de remplissage/
trait RVB.

CMJN
Vous pouvez choisir ici le profil utilisé pour les objets vectoriels avec un style de remplissage/
trait CMJN.

Intention
Cette option sélectionne le rendu de l'intention pour les données vectorielles.

4 Paramètres par défaut
Si cette option est activée, les paramètres actuels sont également utilisés lors de la création
d'un nouveau document.

5 Réinitialiser.
Restaure les valeurs par défaut pour cette boîte de dialogue.

Affichage et exportation CMS
A f f i c h a g e  e t  e x p o r t a t i o n  C M S  

Dans EasySIGN, la gestion des couleurs (CMS) a été améliorée pour rendre son utilisation encore plus intuitive.

Paramètres d’affichage
Dans la boîte de dialogue Paramètres de la gestion des couleurs (accessible via « Fichier », « Paramètres », puis
l’onglet « Gestion des couleurs »), une nouvelle option a été ajoutée :

Gérer RVB comme CMJN

Si vous activez cette option, les couleurs RVB apparaîtront à l’écran telles qu’elles seront imprimées sur une
imprimante par exemple. Cette option était disponible uniquement avec une licence d’impression dans les versions
précédentes (Test couleur).

Lorsque cette option est désactivée :
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Lorsque cette option est activée :

Si cette option est activée, l’affichage à l’écran sera plus lent en raison des nombreux calculs supplémentaires que
devra effectuer le logiciel.

Exportation CMS (gestion des couleurs)
Pour que vous puissiez mieux contrôler la gestion des couleurs, la boîte de dialogue Paramètres (accessible via
« Fichier », « Paramètres »), intègre l’onglet supplémentaire « Gestion des couleurs : Sortie ». Cet onglet comprend

les paramètres suivants :

Lors de l’exportation

Exporter les
couleurs en
tant que :

Lorsque cette option est activée, toutes les couleurs sont exportées en tant que CMJN
ou RVB. Si elle n’est pas activée, les couleurs sont exportées sans être modifiées. Ce
paramètre affectera uniquement l'exportation vers des formats de fichiers vectoriels;
tels que .AI, .EPS et .PDF.

Si vous avez activé l’option « Gérer RVB comme CMJN » dans les paramètres de
gestion des couleurs, nous vous conseillons d’activer également cette option pour plus
d’homogénéité, en choisissant CMJN.
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Lors de la conversion RVB vers CMJN, ou inversement, la gestion des couleurs sera
effectuée à l'aide des profils choisis. Si la gestion des couleurs est désactivée, une
autre conversion sera utilisée.

Lors de l’impression vers les imprimantes PostScript

Exporter les
couleurs en
tant que :

Lorsque cette option est activée, toutes les couleurs sont envoyées vers l’imprimante
en tant que CMJN ou RVB. Si elle n’est pas activée, toutes les couleurs sont envoyées
telles qu’elles sont conçues dans la feuille de travail.

Si vous avez activé l’option « Gérer RVB comme CMJN » dans les paramètres de
gestion des couleurs, nous vous conseillons d’activer également cette option pour plus
d’homogénéité, en choisissant CMJN.

Lors de la conversion RVB vers CMJN, ou inversement, la gestion des couleurs sera
effectuée à l'aide des profils choisis. Si la gestion des couleurs est désactivée, une
autre conversion sera utilisée.

Lors de l’impression vers 'EasySIGN Print Server'

Exporter les
couleurs en
tant que :

Lorsque cette option est activée, toutes les couleurs sont envoyées vers EasySIGN
Print Server en tant que CMJN ou RVB. Si elle n’est pas activée, toutes les couleurs
sont envoyées telles qu’elles sont conçues dans la feuille de travail.

Etant donné que le système de gestion des couleurs de EasySIGN Print Server est
plus avancé que celui de EasySIGN, nous vous conseillons d’utiliser cette option, en
laissant EasySIGN Print Server gérer les couleurs.

Lors de la conversion RVB vers CMJN, ou inversement, la gestion des couleurs sera
effectuée à l'aide des profils choisis. Si la gestion des couleurs est désactivée, une
autre conversion sera utilisée.  

Gestionnaire de production

Toutes les sorties de EasySIGN sont effectuées avec le Gestionnaire de production. Lorsque vous envoyez un travail à
partir de EasySIGN, le Gestionnaire de production s'ouvre automatiquement (s'il n'est pas déjà ouvert) et le travail
s'affiche avec son état en cours. Si vous souhaitez enregistrer un travail pour une utilisation ultérieure, vous devez
activer l'option "Laisser dans le Gestionnaire de production" dans la boîte de dialogue de sortie à partir de EasySIGN.
Même une fois terminé, le travail restera dans le Gestionnaire de production, ce qui vous laissera assez de temps
pour l'enregistrer.

Avec le Gestionnaire de production, plusieurs périphériques de sortie peuvent fonctionner simultanément.
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1 Menu.
2 Barre de boutons.

Ouvre un travail enregistré précédemment. Veillez à ouvrir un travail en sélectionnant le même
périphérique de sortie que lors de l'enregistrement de ce travail. Si vous ouvrez un travail dans
un autre périphérique de sortie, le résultat sera imprévisible. Il est conseillé d'enregistrer un
travail avec le nom du périphérique de sortie dans le nom de fichier. 

Enregistre le travail sélectionné dans le fichier. Ainsi vous n'avez pas besoin d'attendre qu'un
travail répétitif soit calculé de nouveau par EasySIGN. Il suffit d'ouvrir le fichier et de l'activer.
Notez que ces fichiers peuvent devenir très volumineux. Supprimez-les lorsqu'ils ne sont plus
nécessaires.

Active le travail sélectionné qui est interrompu.

Interrompt le travail sélectionné qui est actif.

Arrête le travail sélectionné qui est actif.

Supprime le travail sélectionné.

Laisse un travail dans le Gestionnaire de production, même lorsqu'il est terminé.

Ces boutons vous permettent de contrôler la priorité. Vous pouvez déplacer les travaux vers le
haut et le bas de la liste. Le travail qui figure en haut de la liste sera envoyé en premier.

3 Périphériques de sortie et travaux disponibles.
Pour chaque périphérique installé dans EasySIGN, une icône est ajoutée. Sous ces icônes vous pouvez ensuite
trouver les travaux actifs en cours.

4 Etat d'un travail sélectionné.
Toutes les propriétés, y compris la vitesse, la taille et l'heure de début d'un travail sélectionné, se trouvent ici.

Vous pouvez accéder aux options supplémentaires suivantes à l'aide du premier élément de la barre de
menus :

1 Interrompre tout.
2 Retirer tous les travaux.

Vous ne pouvez pas fermer le Gestionnaire de production lorsqu'il contient encore des travaux actifs ou non.
Cette commande permet d'annuler le Gestionnaire de production. Tous les travaux actifs ou non terminés
seront perdus.

3 Paramètres
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1 Cette option garantit qu'un travail n'est envoyé au périphérique de sortie que lorsque EasySIGN est prêt à
calculer le résultat complet.

2 Cette option garantit que le programme d'impression Windows™ est utilisé à la place du programme
d'impression interne.

3 Vous pouvez définir ici plusieurs dossiers de fichiers temporaires. Si aucun n'est entré, le dossier temporaire
par défaut Windows™ est utilisé.

Impression via Windows

Sélectionnez l’option “ Impression via Windows ” du menu “ Fichier ” pour faire apparaître la boîte de dialogue
d’impression standard de Windows. La seule différence réside dans le fait que nous avons ajouté quelques
fonctionnalités. Au bas de la boîte de dialogue, figurent plusieurs options supplémentaires que nous allons décrire ci-
dessous.

Tout
Cette option vous permet d’imprimer tout ce qui figure sur votre feuille de travail.

Uniquement sélection 
Cette option vous permet d’imprimer tous les objets de votre feuille de travail que vous avez sélectionnés.

Echelle 
Vous pouvez indiquer ici le format d’impression de votre feuille de travail.

Adapter sur page
Si vous activez cette option, tous les objets figurant sur votre fenêtre de travail (à savoir tous les objets de votre
feuille de travail et tous les objets extérieurs à votre feuille de travail) sont réduits de manière à pouvoir être
imprimés sur le format du papier de votre imprimante Windows.

Panneaux
Si vous activez cette option, l’ensemble de votre feuille de travail est automatiquement subdivisé en différents
panneaux. Ces panneaux sont imprimés avec un chevauchement de 5 mm de chaque côté.

Impression modèle fil de fer 
Cette option vous permet d’utiliser le modèle fil de fer pour l’impression de vos objets, au lieu d’utiliser le mode
standard d’impression en couleur ou en grisé.
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Système de positionnement optique (OPOS)

Avec EasySIGN, vous pouvez transformer votre imprimante et votre traceur en une combinaison "imprimer et
découper". EasySIGN prend en charge les systèmes de positionnement optiques prédéfinis et personnalisés. 

Les systèmes prédéfinis sont fournis par les fabricants de traceurs. Lorsque vous sélectionnez un système prédéfini,
EasySIGN utilise automatiquement les spécifications fournies par le fabricant. Si vous utilisez un système
personnalisé, il n'existe pas de restriction spéciale.

Activation du système
Sélectionnez la commande "Affichage, Paramètres" puis l'onglet "Repères de cadrage".

1 Affichez ou masquez les repères de cadrage.
2 Verrouillez les repères de la page.

Cette option permet de recalculer les repères de cadrage lors de tout changement de taille ou d'orientation de
la page.

3 Sélectionnez ici le système que vous souhaitez utiliser.
4 Définissez ici les dimensions des repères de cadrage. 

Une fois que vous avez sélectionné un système prédéfini, la taille des repères de cadrage est liée aux
restrictions spécifiées par le fabricant.

Utilisation du système
La feuille de travail doit contenir des objets traçables et imprimables.
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Activez le système OPOS ("Affichage, Paramètres", puis "Repères de cadrage").

Sélectionnez ensuite les objets que vous souhaitez imprimer puis la commande "Fichier, Imprimer en quadrichromie".
Dans la boîte de dialogue d'impression, activez l'option "Sélection uniquement" puis l'option "Repères d'impression et
de découpage". Puis sélectionnez "Imprimer".
Après avoir imprimé la feuille de travail, retirez la matière de votre imprimante et placez-la dans votre traceur. Le
système de positionnement optique est différent pour chaque traceur. Consultez le manuel de votre traceur pour
obtenir des instructions précises.

Sélectionnez dans la feuille de travail l'objet que vous souhaitez tracer puis la commande "Fichier, Tracer". Activez
l'option "Sélection uniquement" puis "Traçage aligné" dans la boîte de dialogue. Puis sélectionnez "Tracer".

Placez maintenant la tête du traceur sur le premier repère de cadrage et exécutez la procédure (le cas échéant) du
panneau de commande du traceur. 

Déplacement des repères de cadrage
Vous pouvez déplacer les repères de cadrage à l'aide de l'outil de panneautage.

Avertissement
Ne déplacez aucun objet de votre feuille de travail entre les travaux d'impression et de traçage car cela peut produire
des résultats imprévisibles.

Masquer

Le masque vous permet, à l’aide de bitmaps vecteurs et d’autres vecteurs, de procéder à des découpes sans
endommager l’original. Lorsque vous superposez deux bitmaps, vous devez toujours prendre les cadres
rectangulaires en considération. Ainsi, supposons que vous transformez les deux photos ci-dessus de manière à ce
que le visage de l’homme semble être placé sur l’arrière-plan. Seul le masque peut vous permettre d’y arriver. Les
masques peuvent être imprimés, mais pas tracés.
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Si vous tentez d’obtenir ce résultat sans utiliser le masque, les séparations droites des bitmaps restent visibles.
Reportez-vous à l’exemple ci-dessous.

Si vous souhaitez faire en sorte que l’image de l’homme soit placée de manière réaliste sur l’arrière-plan, vous devez
dessiner une ligne qui suit le contour de son visage.

Une fois que vous avez tracé la ligne de contour dont vous avez besoin, il vous reste à sélectionner uniquement le
bitmap. Pour ce faire, sélectionnez l’option “ Masquer ” du menu “ Arranger ”, puis l’option “ Créer dans masque ”. Le
curseur change alors de forme. Vous pouvez ensuite sélectionner l’objet qui doit servir de masque. Tout ce qui figure
à l’extérieur du masque n’est plus affiché (ni imprimé). 

Vous obtenez le résultat suivant si vous placez l’objet masqué sur l’autre photo.

Outils de dessin

Outil de dessin Bézier
O u t i l  d e  d e s s i n  B é z i e r  

Toutes les formes ou presque peuvent être créées à l’aide de ce “ crayon numérique ”. Ce crayon est légèrement
plus difficile à utiliser qu’un crayon normal, mais il présente d’énormes avantages. Si vous utilisez un crayon normal,
la fermeté de votre main détermine l’aspect fluide de la courbe. En revanche, si vous dessinez à l’aide d’un crayon
digital, votre main est ferme et ne doit définir que les formes.

Utilisation 
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Sélectionnez l’outil “ Outil de dessin Bézier ” dans la barre d’outils. Le curseur se présente alors sous la forme
suivante.

Cliquez sur la feuille de travail (1) à l’aide de ce curseur, relâchez le bouton de la souris avant d’aller à un autre
endroit de la feuille de travail (2). Cliquez à nouveau sur cet emplacement à l’aide du curseur, puis cliquez une fois
sur le bouton droit de la souris pour couper la ligne (3). Vous venez de tracer une ligne droite sur votre feuille de
travail.  Si vous souhaitez placer cette ligne à l’horizontale ou à la verticale (incréments intermédiaires de 15°),
maintenez la touche “ CTRL ” enfoncée pendant le mouvement de la souris.

La réalisation d’une courbe peut sembler plus complexe au premier abord. Quelques exercices vous convaincront du
fait qu’il s’agit en réalité d’une opération logique et simple.
Cliquez une fois sur la feuille de travail (1), puis déplacez légèrement la souris sans en relâcher le bouton (2).
Relâchez le bouton de la souris, puis allez à un autre point de la feuille de travail. Une fois sur ce point, cliquez une
fois sur le bouton gauche de la souris pour terminer l’opération (3), avant de cliquer une fois sur le bouton droit de la
souris pour couper la ligne. Vous venez de tracer une courbe fluide sur votre feuille de travail.

Nous ne pouvons naturellement pas décrire chaque situation ici, mais ces deux méthodes de base devraient vous
permettre de dessiner pratiquement toutes les formes qui soient. Vous découvrirez que cette manière de dessiner est
plus performante, plus rapide et plus simple que le dessin à la main. 
Il convient de garder plusieurs éléments présents à l’esprit.

1 Si vous cliquez sur le bouton de la souris et que vous le relâchez immédiatement après, vous obtiendrez une
ligne droite après le mouvement.

2 Si vous cliquez sur le bouton de la souris et que vous la déplacez légèrement tout en maintenant le bouton
enfoncé, vous obtiendrez une courbe après le deuxième mouvement.

3 Pour couper une ligne (l’arrêter), il vous suffit de cliquer une fois sur le bouton droit de la souris. 

Outil de dessin esquisse
O u t i l  d e  d e s s i n  e s q u i s s e  

Cet outil fonctionne de la même manière qu’un crayon. Chaque mouvement réalisé à l’aide de la souris est reporté
sur la feuille de travail.

Utilisation

Sélectionnez l’outil “ Outil de dessin esquisse ” dans la barre d’outils. Le curseur se présente alors sous la forme
suivante.

Cliquez sur un point de la feuille de travail, puis commencez à dessiner. Le résultat de cette méthode doit être corrigé
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à l’aide de l’outil de glissement pour supprimer les imprécisions provoquées par le mouvement de la souris.

Outil de dessin rectangle
O u t i l  d e  d e s s i n  r e c t a n g l e  

L’outil de dessin rectangle permet de dessiner rapidement un rectangle ou un carré. Dans EasySIGN, un rectangle est
un objet qui possède des propriétés spécifiques. En d’autres termes, le rectangle est plus qu’un vecteur, tel qu’une
forme créée à l’aide de l’outil de dessin Bézier par exemple. Vous pouvez notamment arrondir les angles du rectangle
par glissement ou par l’intermédiaire de la boîte de dialogue, ou déterminer l’aspect des angles.

Utilisation 

Sélectionnez l’outil “ Outil de dessin rectangle ” dans la barre d’outils. Le curseur se présente alors sous la forme
suivante.

Cliquez sur un point de votre feuille de travail (1) à l’aide de ce curseur, puis déplacez la souris sans en relâcher le
bouton. Lorsque vous relâchez le bouton de la souris, un rectangle apparaît sur votre feuille de travail (2). Si vous
répétez ces deux premières étapes (1) et (2) en maintenant la touche “ CTRL ” enfoncée, le mouvement donnera lieu
à un carré (3). Si vous maintenez la touche “ Shift ” enfoncée pendant le glissement, le rectangle sera dessiné à
partir du centre.

Une fois que le rectangle est dessiné, vous pouvez en modifier les angles par glissement ou par l’intermédiaire de la
boîte de dialogue. Pour ce faire, sélectionnez le rectangle, puis cliquez une fois sur le bouton droit de la souris.
Sélectionnez ensuite dans le menu contextuel qui s’affiche à l’écran l’option “ Propriétés ”. La boîte de dialogue
apparaît alors à l’écran.
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Cette boîte de dialogue vous propose les paramètres suivants.
1/2 Vous pouvez déterminer la longueur et la hauteur du rectangle.

3 Ce champ vous permet de déterminer la grandeur des angles.
4 Vous pouvez déterminer l’aspect des angles.
5 Si vous cliquez sur le bouton “ Fermer ”, la boîte de dialogue disparaît de l’écran sans que les paramètres

modifiés ne soient appliqués.
6 Le bouton “ Appliquer ” permet d’appliquer les paramètres modifiés au rectangle sans fermer la boîte de

dialogue. Vous voyez alors apparaître les modifications directement à l’écran.

Vous pouvez également arrondir les angles ou modifier la forme du rectangle par glissement.

Sélectionnez l’outil de glissement.

L’aspect du rectangle change (1), vous voyez huit nœuds s’afficher à l’écran. Sélectionnez l’un de ces nœuds situés
aux angles de l’objet, puis déplacez la souris, bouton enfoncé, le long de la ligne du rectangle (2). Les angles sont
maintenant arrondis. Si vous déformez un rectangle à l’aide de l’outil de sélection, les angles se déforment
également. Si vous faites de même à l’aide de l’outil de glissement (3), seule l’échelle verticale ou horizontale du
rectangle est modifiée, les angles restant inchangés.

Outil de dessin cercle
O u t i l  d e  d e s s i n  c e r c l e  

Cet outil de dessin permet de créer rapidement une ellipse ou un cercle. Dans EasySIGN, les ellipses sont, à l’instar
des rectangles, des objets qui possèdent des propriétés spécifiques.

Utilisation 

Sélectionnez l’outil “ Outil de dessin cercle ”. Le curseur se présente alors sous la forme suivante.

La procédure est identique à celle qu’il convient de suivre pour dessiner un rectangle, si ce n’est que vous dessinez
des ellipses ou des cercles au lieu de carrés ou de rectangle.
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Pour dessiner un cercle, il vous suffit de maintenir la touche “ CTRL ” enfoncée pendant le glissement.

Sélectionnez le cercle avant de sélectionner l’outil de glissement. Déplacez la souris le long de la circonférence du
cercle en veillant à ce que l’outil de glissement reste à l’intérieur du rayon du cercle.

Vous venez de dessiner une “ tarte ”. Répétez l’opération en veillant cette fois à ce que l’outil de glissement reste à
l’extérieur du cercle.

Vous venez de dessiner un arc de cercle.

Dessinez un nouveau cercle, puis sélectionnez-le à l’aide de l’outil de glissement. Sélectionnez le nœud inférieur, puis
déplacez-le vers le haut. Répétez cette opération avec le nœud droit, mais glissez-le vers la gauche.

Cette procédure vous permet de transformer un cercle en ellipse. Si vous souhaitez transformer une ellipse en cercle,
appuyez sur la touche “ Shift ”, puis sélectionnez le nœud droit ou inférieur. Déplacez la souris pour obtenir un cercle.
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Vous pouvez dimensionner l’objet intégralement en même temps. Si vous répétez cette opération en maintenant la
touche “ CTRL ” enfoncée, l’objet est intégralement dimensionné, mais sa forme reste inchangée.

Ces propriétés sont, à l’instar de celles des rectangles, paramétrables à l’aide de la boîte de dialogue. Cliquez sur le
cercle à l’aide du bouton droit de la souris, puis sélectionnez l’option “ Propriétés ” du menu afin de faire apparaître la
boîte de dialogue à l’écran.

Outil de dessin étoile
O u t i l  d e  d e s s i n  é t o i l e  

Vous pouvez également modifier les étoiles : changez la forme à l’aide de l’outil de glissement ou cliquez sur l’objet à
l’aide du bouton droit de la souris avant de sélectionner l’option “ Propriétés ”. Une boîte de dialogue s’affiche alors à
l’écran. Vous pouvez y déterminer les propriétés de l’objet de manière numérique.

Utilisation 

Sélectionnez l’outil “ Outil de dessin étoile ” dans la barre d’outils. Le curseur se présente alors sous la forme
suivante.

Placez le curseur sur un point quelconque de la feuille de travail, puis dessinez l’étoile en déplaçant la souris bouton
gauche enfoncé.

Sélectionnez ensuite l’outil de glissement, puis déplacez le nœud droit le long du contour de l’étoile.

Vous pouvez de la sorte augmenter le nombre de points de l’étoile. Si vous vous déplacez vers l’autre côté, le
nombre de points diminue. Sélectionnez à présent le nœud qui se trouve à gauche du précédent, puis déplacez-le
vers l’extérieur de l’étoile.
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Vous pouvez maintenant adapter le rayon intérieur du cercle. Sélectionnez ensuite le nœud gauche, puis déplacez la
souris vers le centre de l’étoile.

Cette procédure vous permet d’adapter le rayon extérieur de l’étoile. Vous pouvez utiliser les deux méthodes pour
agrandir ou rapetisser l’étoile.

Outil de dessin polygone
O u t i l  d e  d e s s i n  p o l y g o n e  

A l’instar de tous les autres objets de EasySIGN, les polygones peuvent être modifiés à l’aide de la souris et par
l’intermédiaire d’une boîte de dialogue.

Utilisation 

Sélectionnez l’outil “ Outil de dessin polygone ” dans la barre d’outils. Le curseur se présente alors sous la forme
suivante.

La manière de travailler avec cet outil est identique à celle décrite pour l’outil de dessin étoile. Les propriétés des
polygones sont également identiques à celles des étoiles.

Outil de dessin flèche
O u t i l  d e  d e s s i n  f l è c h e  

A l’instar de tous les autres objets de EasySIGN, les flèches peuvent être modifiées à l’aide de la souris et par
l’intermédiaire d’une boîte de dialogue.

Utilisation 

Sélectionnez l’outil “ Outil de dessin flèche ” dans la barre d’outils. Le curseur se présente alors sous la forme
suivante.
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La manière de travailler avec cet outil est comparable à celle décrite pour les autres objets de EasySIGN. Les
propriétés de ces objets sont également similaires à celles des autres objets. La grande différence de ces objets par
rapport aux autres réside dans le nombre de nœuds de commande.

A Vous pouvez déplacer ce point vers la gauche et vers la droite pour modifier le point de la flèche.
B Vous pouvez déplacer ce point dans toutes les directions pour adapter le point suspendu. Si vous utilisez la

touche “ Shift ” pendant le glissement, le point “ C ” est déplacé dans la même direction et à la même distance.
C Vous pouvez déplacer ce point dans toutes les directions pour déterminer la largeur de l’avant de la flèche et

l’encoche du point de la flèche. Si vous utilisez la touche “ Shift ” pendant le glissement, le point “ B ” est
déplacé dans la même direction et à la même distance.

D Ce point agit sur la longueur l’extrémité de la flèche.  Si vous utilisez la touche “ Shift ” pendant le glissement,
le point “ C ” est déplacé dans la même direction et à la même distance.

E Ce point détermine l’encoche de l’extrémité de la flèche.
F Ce point vous permet de déplacer l’objet lorsque vous utilisez l’outil de glissement.

Outil Spirale
O u t i l  S p i r a l e

Avec l'outil Spirale, vous pouvez dessiner des spirales normales et de type spécial.

Utilisation

Sélectionnez l'outil Spirale dans la barre d'outils et cliquez puis faites glisser la souris pour dessiner une spirale.
Lorsque vous tenez la touche Ctrl enfoncée tout en dessinant, les rayons X et Y ne changent pas.

Après avoir dessiné la spirale, vous pouvez utiliser l'outil glisser pour ajuster dans les propriétés le nombre
d'enroulements.
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A l'aide de la boîte de dialogue de propriétés de la spirale, vous pouvez effectuer d'autres actions sur cette forme.
Sélectionnez une spirale puis l'option "Propriétés" dans le menu contextuel.

1 Les positions X et Y de la feuille de travail. 

2 Angle de début et de fin.

3 Les rayons horizontal, vertical et intérieur de la spirale. 

4 Nombre d'enroulements. 

5 Direction. 

6 Type

Constante

Exponentielle

7 Forme
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Vous pouvez combiner ici différentes formes supérieures et inférieures en une nouvelle forme unique de spirale.

Pinceau vectoriel
P i n c e a u  v e c t o r i e l

Le pinceau vectoriel est un outil rapide et pratique pour les retouches vectorielles.

Utilisation

Sélectionnez la brosse vectorielle dans la barre d'outils, le curseur se transforme et la barre d'outils suivante
s'affiche :

Vous pouvez définir ici la largeur et la forme de la brosse. Cliquez et faites glisser la souris pour peindre une forme
vectorielle comme vous le feriez avec un vrai pinceau. L'objet obtenu peut être utilisé pour fusionner des objets que
vous souhaitez retoucher.

Cliquez puis relâchez le bouton de la souris et faites la glisser pour dessiner des lignes droites. Utilisez la touche Ctrl
pour limiter ces lignes à des angles de 15 degrés. 
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Gomme vectorielle
G o m m e  v e c t o r i e l l e

La gomme vectorielle est un outil permettant de modifier des formes vectorielles ouvertes et fermées.

Utilisation

Sélectionnez d'abord un ou plusieurs objets pour lesquels vous souhaitez utiliser la gomme, puis sélectionnez la
gomme vectorielle dans la barre d'outils. Le curseur se transforme et la barre d'outils suivante s'affiche : 

Vous pouvez définir ici la largeur et la forme de la gomme. Cliquez et faites glisser la souris pour commencer à
effacer les objets sélectionnés.

Vous pouvez utiliser la gomme sur n'importe quel objet, même du texte, des groupes et des effets complexes. Notez
que lorsque vous utilisez la gomme, tous les objets sont convertis en courbes. Vous pouvez même utiliser la gomme
pour les bitmaps ; les données bitmaps réelles ne seront pas modifiées mais le bitmap sera placé dans un conteneur
semblable à un masque.

Cliquez puis relâchez le bouton de la souris et faites la glisser pour dessiner des lignes droites. Utilisez la touche Ctrl
pour limiter ces lignes à des angles de 15 degrés.
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Outil de glissement et modification des nœuds

Outil de glissement et modification des nœuds
O u t i l  d e  g l i s s e m e n t  e t  m o d i f i c a t i o n  d e s  n œ u d s

Tous les objets vecteurs de EasySIGN sont composés d’éléments de base qui portent le nom de “ tracés ”. Une ligne
ou une courbe est donc un segment de tracé entre deux nœuds.

L’outil de glissement vous permet de modifier les caractéristiques du tracé et des nœuds. Vous pouvez ainsi modifier
la forme d’un objet. Exemple : vous pouvez transformer une ligne droite en courbe, puis donner à cette courbe la
forme souhaitée.

Si vous souhaitez modifier la forme d’un objet à l’aide de l’outil de glissement, vous devez transformer l’objet en
courbe. Cette option se trouve dans le menu “ Traiter, Convertir en, Courbes ”. Cette opération n’est pas nécessaire
pour les objets dessinés, car ils sont créés à l’aide de courbes. Les rectangles, les cercles, etc. doivent tout d’abord
être convertis en courbes. En cas d’objets groupés, ils doivent en premier lieu être dégroupés.

Le symbole de l’outil de glissement se trouve dans la barre d’outils. Cet outil se présente sous la forme suivante.

La fenêtre flottante suivante s’affiche à l’écran lorsque vous sélectionnez l’outil de glissement.

Cette fenêtre renferme les options suivantes.

Ajouter nœuds
A j o u t e r  n œ u d s

Sélectionnez cette option. Le curseur prend alors l’aspect d’un curseur de glissement et accompagné du signe “ + ”.
Un nœud supplémentaire est ajouté au niveau de chacun des points de la ligne sur lesquels vous cliquez à l’aide de ce
curseur. Si vous sélectionnez deux nœuds, un nouveau nœud est ajouté au milieu de la courbe. Lorsque vous avez
terminé cette opération, cliquez une fois sur la feuille de travail pour quitter ce mode.

Supprimer nœuds
S u p p r i m e r  n œ u d s

Sélectionnez le ou les nœuds que vous souhaitez supprimer, puis sélectionnez cette option.
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Ouvrir forme
O u v r i r  f o r m e

 

Sélectionnez cette option. Le curseur prend alors l’aspect d’un curseur de glissement et est accompagné d’une petite
paire de ciseaux. Toutes les lignes sur lesquelles vous cliquez sont alors coupées. Une fois que vous avez terminé
cette opération, il vous suffit de cliquer une fois sur la feuille de travail pour quitter ce mode.

En ligne
E n  l i g n e

 

Sélectionnez la courbe que vous souhaitez convertir en ligne droite, puis sélectionnez cette option.

En courbe
E n  c o u r b e

 

Sélectionnez la ligne droite que vous souhaitez convertir en courbe, puis sélectionnez cette option.

Fermer nœuds
F e r m e r  n œ u d s

 

Sélectionnez les nœuds que vous souhaitez fermer, puis sélectionnez l’option suivante. Si vous avez sélectionné plus
de deux nœuds, les nœuds qui se trouvent le plus près les uns des autres sont fermés. Si vous avez sélectionné plus
de deux nœuds, le dernier nœud sélectionné est celui qui détermine l’emplacement. En d’autres termes, si vous avez
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sélectionné deux nœuds à l’aide de la touche “ Shift ”, le dernier nœud sélectionné reste sur son emplacement, tandis
que le premier nœud sélectionné est déplacé vers l’emplacement du dernier nœud. Ces paramétrages sont
optionnels.

Casser nœuds
C a s s e r  n œ u d s

 

Sélectionnez les nœuds que vous souhaitez casser, puis sélectionnez cette option.

Nœud aigu
N œ u d  a i g u

Sélectionnez le ou les nœuds que vous souhaitez rendre aigu, puis sélectionnez cette option. Seul le levier de
commande que vous traitez à l’aide de la souris est modifié, le nœud avoisinant restant inchangé.

Nœud lisse
N œ u d  l i s s e

Sélectionnez le ou les nœuds que vous souhaitez rendre lisse, puis sélectionnez cette option. Chaque adaptation
réalisée avec le levier de commande de ce nœud a un effet sur le levier de commande traité et sur le levier de
commande avoisinant. Le levier de commande avoisinant n’est donc modifié que si vous modifiez le levier de
commande traité. Si vous corrigez la longueur d’un levier de commande traité, le levier de commande avoisinant
reste inchangé.
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Nœud symétrique
N œ u d  s y m é t r i q u e

 

Sélectionnez le ou les nœuds que vous souhaitez rendre symétriques, puis sélectionnez cette option. Chaque
mouvement réalisé avec le levier de commande traité du nœud symétrique a un effet sur le levier de commande
avoisinant. Le levier de commande avoisinant change également si vous modifiez l’angle du levier de commande
traité ou si vous en modifiez la longueur. Les leviers présentent toujours une longueur identique.

Alignement horizontal
A l i g n e m e n t  h o r i z o n t a l

 

Cette option permet d’aligner tous les nœuds sélectionnés sur une ligne horizontale.
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Alignement vertical
A l i g n e m e n t  v e r t i c a l

 

Cette option permet d’aligner tous les nœuds sélectionnés sur une ligne verticale.

Sur une ligne
S u r  u n e  l i g n e

 

Tous les nœuds sélectionnés sont placés sur une seule ligne entre le premier nœud sélectionné et le dernier nœud
sélectionné.

Perpendiculaire
P e r p e n d i c u l a i r e

 

Sélectionnez les nœuds que vous souhaitez rendre perpendiculaires, puis cliquez sur cet outil.
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Remplacer par ligne
R e m p l a c e r  p a r  l i g n e

 

Faites une ligne droite de tous les segments de ligne sélectionnés entre le premier et le dernier nœud.

En arc de cercle
E n  a r c  d e  c e r c l e

 

Sélectionnez cette option. Le curseur prend alors l’aspect d’un curseur de glissement et est accompagné d’un petit arc
de cercle. Cet outil vous permet de transformer n’importe quelle ligne en arc de cercle, puis de transformer celui-ci
en un autre arc de cercle, etc.

Arrondir angles
A r r o n d i r  a n g l e s

 

Cet outil vous permet d’arrondir tous les nœuds qui se trouvent entre deux lignes droites.
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Paramètres
P a r a m è t r e s

Cliquez sur ce bouton pour faire apparaître une boîte de dialogue à l’écran. Cette boîte de dialogue vous permet de
modifier les paramètres suivants de l’outil de glissement.

1 Dernière sélection
 Cette option vous permet de faire en sorte que le dernier nœud sélectionné soit toujours utilisé comme point

de référence lors de la liaison de nœuds.

 

2 Centre
 Cette option vous permet de faire en sorte que les nœuds liés soient toujours situés en leur centre les uns par

rapport aux autres.

 

3 Avec ligne
 Cette option vous permet de faire en sorte que les nœuds liés les uns aux autres restent sur leur emplacement

et qu’ils soient reliés entre eux par une ligne.
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Connexion rapide

Méthode de dessin unique et rapide. Si vous étiez habitué aux tâches fastidieuses d'édition de lignes, d'ajout ou de
connexion de nœuds et parfois contraint de travailler avec des guides, il vous suffit désormais de cliquer sur un
élément de menu. 

Pour transformer les lignes de la figure ci-dessus en objet fermé, vous deviez précédemment ajouter des nœuds aux
points d'intersection des lignes, supprimer les lignes puis fermer les nœuds qui se chevauchent. Maintenant, il vous
suffit de sélectionner les lignes puis la commande "Organiser, Connexion rapide" pour obtenir l'objet  fermé comme
indiqué ci-dessous.

La fonction "Connexion rapide" peut aussi gérer une combinaison d'objets ouverts et fermés.

Une fois que la fonction "Connexion rapide" est appliquée aux objets illustrés ci-dessus, vous obtenez les résultats
suivants :
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En plaçant les lignes de manière stratégique, vous pouvez obtenir des résultats plus rapidement que par la soudure
ou le marquage des objets. 

Avec la pratique, vous apprendrez à "connecter rapidement" les poignées dans différentes situations et réaliserez que
la plupart de vos dessins peuvent être exécutés dix fois plus vite qu'auparavant.

Panneaux

Définition et mode d’utilisation 

Votre imprimante, même grand format, ne peut pas forcément accueillir tous les formats. Tous les appareils sont
limités à un format maximum. Une imprimante qui utilise des supports de 90 cm ne peut généralement exploiter
effectivement que 88 cm des supports.
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Les imprimantes grand format qui utilisent des rouleaux peuvent imprimer en continu sur toute la longueur du
rouleau. La longueur d’impression dépend donc de celle du rouleau. La longueur ne pose généralement pas de
problème, contrairement à la largeur. La largeur est en effet déterminée par la largeur d’impression effective. Il
existe cependant un moyen de remédier à ce problème, qu’il concerne la largeur ou la longueur. Il est possible de
subdiviser la feuille de travail en panneaux. Ces panneaux sont des délimitations de votre feuille de travail que vous
pouvez introduire vous-même. Ils doivent être basés sur la largeur effective d’impression et sur la longueur
maximum du support. Grâce à ce système, votre feuille de travail est subdivisée en panneaux lors de l’impression.
Pour mieux illustrer ce système, nous allons prendre l’exemple d’une impression dont la taille est supérieure au
format et à la largeur d’impression de notre imprimante. 

Notre exemple concerne l’impression d’un format de 3 000 mm de hauteur et de 4 500 mm de long, la largeur
d’impression effective de l’imprimante étant de 700 mm.

Introduction de lignes panneaux à l’aide de la souris 
Vous pouvez introduire les lignes dont vous avez besoin pour indiquer les panneaux de deux manières différentes :
soit à l’aide de la souris, soit de façon numérique par l’intermédiaire d’une boîte de dialogue. La procédure à suivre
pour introduire des panneaux à l’aide de la souris est décrite ci-dessous. Sélectionnez l’outil “ Panneaux ” dans la
barre d’outils. 

Une fois cet outil sélectionné, le curseur se transforme et se présente sous la forme suivante.

Si vous utilisez le format portrait comme dans notre exemple, vous placez une ligne panneau horizontale à chaque
fois que vous cliquez sur votre feuille de travail (une ligne panneau dans le sens d’impression). Si vous souhaitez
placer une ligne panneau verticalement, cliquez sur votre feuille de travail en maintenant la touche “ Shift ” enfoncée.
Les lignes panneaux peuvent donc être verticales ou horizontales. Mais elles peuvent également être négatives ou
positives. Cliquez sur l’un des autres outils ou appuyez sur la touche “ Tab ” pour quitter le mode “ Lignes panneaux ”.

Introduction de lignes panneaux par l’intermédiaire de la boîte de dialogue 
Sélectionnez l’option “ Paramètres ligne panneau ” du menu “ Fichier ”. La boîte de dialogue suivante s’affiche alors à
l’écran.

Cette boîte de dialogue vous permet de subdiviser automatiquement votre feuille de travail. Il vous suffit d’introduire
la taille maximum d’un panneau. Dans le cas des panneaux, le format (portrait ou paysage) de la feuille de travail
n’entre pas en ligne de compte, seule la ligne zéro de l’imprimante intervient. Pour cette raison, l’horizontale



151EasySIGN

correspond toujours au sens d’impression du support (entraînement par picots).

Dans le champ “ Taille horizontale ” (1), introduisez la taille maximale du panneau à l’horizontale (dans notre
exemple, elle est identique à la longueur de votre page). Comme nous utilisons un rouleau, nous n’avons pas besoin
de panneaux. Indiquez donc la longueur de votre page ou un chiffre supérieur. Dans le champ “ Taille verticale ” (2),
introduisez “ 600 unités ”. Le champ “ Chevauchement horizontal ” (3) désigne le chevauchement total d’une ligne
panneau à la verticale, tandis que le champ “ Chevauchement vertical ” (4) désigne le chevauchement total d’une
ligne panneau à l’horizontale. Indiquez donc 100 unités dans le champ “ Chevauchement vertical ”. Nous n’utilisons
pas ici un chevauchement réel, mais une taille supplémentaire afin de mieux expliquer la répartition des panneaux
sur une feuille de travail. 

Vous disposez maintenant d’une largeur d’impression de 700 mm. Or, votre largeur d’impression est de 600 mm.
L’explication est simple : il convient d’ajouter le chevauchement total à cette largeur.

Lignes panneaux négatives et positives 
Les lignes panneaux positives sont les plus courantes. Lorsque vous effectuez une impression dont le format est
supérieur à celui de votre imprimante, vous avez besoin d’un chevauchement pour pouvoir coller les panneaux les
uns à côté des autres. Les lignes panneaux positives déterminent la taille du chevauchement. Si votre impression est
répartie sur plusieurs panneaux que vous avez placés en accordéon, vous avez besoin dans un angle d’un
chevauchement positif et, dans l’autre, d’un chevauchement négatif. 

A Le point d’angle au niveau de “ A ” est ramené vers l’intérieur. En d’autres termes, une partie du dessin n’est
plus visible au niveau de ce point. Un chevauchement négatif est donc nécessaire. Le chevauchement négatif
ôte une bande de l’impression, tandis que le chevauchement positif ajoute une bande à l’impression.

Horizontal Vertical

 

Le chevauchement négatif est représenté par trois lignes continues de couleur gris foncé.

B Le point d’angle au niveau de “ B ” est ramené vers l’extérieur. En d’autres termes, vous devez adapter un
chevauchement positif si vous souhaitez que votre impression ne soit pas interrompue par une ligne de
jonction.

Horizontal Vertical
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Le chevauchement positif est représenté à l’extérieur par deux lignes en pointillé de couleur gris foncé et, au centre,
par une ligne continue de couleur gris clair.

A L’original.
B Le résultat après un chevauchement négatif.

C/D Le résultat après un chevauchement positif. 

Disposition des lignes panneaux 
L’illustration suivante explique l’emplacement et le format du chevauchement dans le programme.

L’illustration suivante représente la partie inférieure de la page portrait de 3 000 mm de large et de 4 500 mm de
haut (la page de notre exemple).

Placez votre curseur au-dessus de la ligne panneau gauche, puis cliquez sur le bouton droit de la souris pour faire
apparaître le menu contextuel suivant. Sélectionnez l’option “ Propriétés ligne panneau ” de ce menu. La boîte de
dialogue suivante s’affiche alors à l’écran.

Comme le côté droit correspond à la ligne zéro de votre imprimante, le centre de la ligne panneau sélectionnée se
situe à 2 400 mm. Il s’agit de la distance entre la ligne zéro de l’imprimante et le centre de la ligne panneau. La ligne
panneau est considérée comme étant horizontale, étant donné qu’elle est parallèle à la ligne zéro de l’imprimante.
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Panneautage pour traçage
P a n n e a u t a g e  p o u r  t r a ç a g e

Quand votre travail est plus grand que la sortie imprimable de votre traceur, vous pouvez recourir au panneautage. 
Supposons que votre projet graphique soit de 180 cm x 180 cm et que votre table traçante ne puisse prendre en
charge que des vinyles de 100 cm de côté. Vous ne pouvez pas faire autrement que de prévoir un traçage qui
réunisse deux sorties séparées de 90 cm de côté.

Ajustez d’abord la dimension de la page à la dimension de votre projet ; sélectionnez-le, vérifiez ses dimensions
réelles sur la barre d’état ou servez-vous de l’outil de mesure et de dimensionnement.  Affectez ces mesures à la
dimension de la page (menu : “ Affichage ”, “ Paramétrages ”, “ Page ”) pour centrer le dessin dans la page.  Vous
pouvez maintenant ajouter les lignes repères de panneautage à votre feuille de travail.  

Le panneautage est basé sur la dimension de votre feuille de travail ; si vous n’ajustez pas la dimension de la page
au dessin, les blancs de votre feuille de travail seront pris en compte dans le processus de panneautage. Vous
gaspilleriez inutilement vos précieux vinyles :

Dans notre exemple, la sortie de la table traçante se présente comme suit. Les flèches noires signalent les chutes de
vinyle. 

La meilleure façon de se familiariser avec le panneautage est de s’exercer en traçant d’abord des feuilles de travail
de dimensions réduites.  
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Ajout de lignes de panneautage pour le traçage
Dans la barre d’outils, sélectionnez l’outil de panneautage :

Votre curseur prend alors l’aspect suivant :

Cliquez sur la feuille de travail dans laquelle vous voulez placer des lignes de panneautage. 

Une ligne de panneautage est toujours dans le sens des picots d’entraînement de la feuille de travail. Si vous voulez
une ligne de panneautage qui soit à angle droit des picots d’entraînement, cliquez sur l’outil de panneautage en
maintenant en même temps la touche majuscule enfoncée. Pour afficher et modifier les propriétés de la ligne de
panneautage, arrêtez la souris au-dessus et cliquez sur le bouton droit. Dans le menu contextuel, allez sur
“ Propriétés ”. Dans la boîte de dialogue, ajuster l’emplacement exact de la ligne et son alignement avec la ligne de
l’autre panneau.

Traçage
Quand vous commencez le traçage, vous pouvez choisir de tracer tous les panneaux en même temps. Si vous voulez
n’imprimer qu’un panneau, activez cette option et indiquez le numéro du panneau. Vous pouvez voir ces numéros sur
la feuille de travail en mode panneautage (quand l’outil de panneautage est actif).

Scannage

Choix de la résolution du scannage
C h o i x  d e  l a  r é s o l u t i o n  d u  s c a n n a g e

Le principe qui prévaut en la matière consiste à utiliser la résolution 1 sur 1 pour un bitmap de 72 DPI (Dots Per
Inch). En d’autres termes, si vous souhaitez imprimer un bitmap dans un format de 50 x 70 cm, le bitmap peut avoir
une résolution de 72 DPI à cette taille. Si le bitmap en question est très détaillé, vous pouvez éventuellement doubler
cette résolution. 
Les imprimantes sont limitées à un nombre déterminé de DPI. Tout ce qui dépasse la capacité de l’imprimante n’est
pas pris en considération. Le temps de calcul de l’impression est par contre pris en considération. Un bitmap imprimé
à 72 DPI peut donner le même résultat qu’un bitmap imprimé à 2 400 DPI, si ce n’est que ce dernier bitmap prend dix
fois plus de place sur votre disque dur. Le temps de calcul nécessaire à la préparation de l’impression est également
multiplié par 10. Mais la plupart du temps, le résultat est à peine meilleur, voire identique. Si vous estimez qu’une
résolution supérieure est souhaitable, augmentez-la de quelques incréments ou doublez-la, mais ne la multipliez en
aucun cas par dix. 
Dans le secteur de l’imprimerie offset, l’on utilise des films. Ces films sont réalisés sur des imprimantes de 2 400 DPI
(à l’heure actuelle, les imprimantes à jet d’encre vont de 180 à 600 DPI). La résolution 1 sur 1 utilisée pour les
bitmaps correspond à 300 DPI pour une grille de 150 LPI (Lines Per Inch). Cette résolution est appliquée à la plupart
des impressions couleurs. Pourquoi opteriez-vous pour une résolution de 2 400 DPI pour imprimer une photo ?

Pour vous faciliter la tâche, EasySIGN dispose d’un “ Assistant ” de scannage qui vous indique la résolution que vous
pouvez utiliser. 

Sélectionnez l’option “ Scannériser ” du menu “ Fichier ”, puis sélectionnez l’option “ Assistant ” du sous-menu qui
s’affiche à l’écran. La boîte de dialogue apparaît alors à l’écran.
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Au milieu de cette boîte de dialogue, se trouve le bouton “ Sélectionner source ” (1). Cliquez sur ce bouton pour faire
apparaître une boîte de dialogue reprenant les scanners installés sur votre système. Dans cette boîte de dialogue,
sélectionnez le scanner que vous souhaitez utiliser. Cliquez ensuite sur le bouton “ Suivant ” (2).

Indiquez dans cette fenêtre la largeur et la hauteur de l’original que vous avez posé sur votre scanner (1). Cliquez
ensuite sur le bouton “ Suivant ” (2).
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Indiquez dans cette fenêtre le format d’impression de l’original (1). Cliquez ensuite sur le bouton “ Suivant ” (2).

Cette fenêtre indique la résolution conseillée (1). Cliquez sur le bouton “ Terminer ” (2) pour faire apparaître la boîte
de dialogue standard de votre scanner. Indiquez-y la valeur qui vous a été conseillée. Il nous est impossible de vous
montrer la boîte de dialogue du scanner, car elle varie selon le type de scanner. Reportez-vous au manuel
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d’instruction relatif à votre scanner pour davantage d’informations sur l’utilisation de cette boîte de dialogue.

Gestion des couleurs

Utilisation des couleurs
U t i l i s a t i o n  d e s  c o u l e u r s  

L’écran de EasySIGN figurant ci-dessous reprend la palette de couleurs actuellement utilisée. Si ce n’est pas le cas,
sélectionnez l’option “ Afficher palette de couleurs ” du menu “ Vue ”. 

Il s’agit d’une barre flottante. En d’autres termes, vous pouvez en modifier la taille ou la déplacer.

Si vous souhaitez attribuer une couleur à un objet, sélectionnez cet objet, puis cliquez sur la couleur voulue dans la
barre de couleurs. Si vous placez la souris au-dessus d’une couleur, la barre d’état indique le nom de cette couleur.
Cliquez sur le bouton gauche de la souris pour que la couleur sélectionnée soit affectée au remplissage de l’objet et
sur le bouton droit de la souris pour que cette couleur soit affectée à la ligne de l’objet. Pour éliminer le remplissage
ou la ligne de l’objet, cliquez sur la case cochée à l’aide du bouton gauche de la souris pour le remplissage et à l’aide
du bouton droit pour la ligne.

Si vous souhaitez modifier la couleur d’un objet ou créer une nouvelle couleur, sélectionnez l’objet, puis l’outil couleur
de la barre d’outils. 

Une fois que vous avez sélectionné cette option, la boîte de dialogue suivante apparaît à l’écran.
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1 Modèle de couleur
 Vous pouvez choisir le modèle de couleur que vous souhaitez. EasySIGN vous propose en effet une grande

gamme de modèles de couleur, parmi lesquels figurent les modèles suivants.

RGB : Red, Green and Blue (Rouge, vert et bleu)

CMYK : Cyan, Magenta, Yellow and Black (Cyan, magenta, jaune et noir)

Valeurs de gris : Composées à partir de teintes de noir

HSB : Couleur, saturation et luminosité

Couleurs
d’accompagnement

: Couleurs spot définies par les fabricants d’imprimantes

CMYKOrGr : Cyan, Magenta, Yellow, Black, Orange, Green (Cyan, magenta, jaune,
noir, orange et vert)

CMYKLiCLiM : Cyan, Magenta, Yellow, Black, Light Cyan, Light Magenta  (Cyan,
magenta, jaune, noir, cyan clair et magenta clair)

2 La reproduction visuelle du modèle de couleur choisi. Les boutons de réglage situés dans les barres “ A ” vous
permettent de modifier les couleurs. Vous pouvez également les modifier en indiquant une valeur dans le
champ de saisie “ B ”. Le résultat est affiché dans la fenêtre (7).

 

3 Barres de couleur statiques
 Si vous activez cette option, vous constatez que les barres de couleur sont identiques à l’illustration ci-dessous.

Vous pouvez alors procéder à une composition. Si vous n’êtes pas sûr du résultat d’une composition de rouge
ou de vert, il vous suffit de désactiver cette option. Les barres de couleurs vous indiquent à présent vers quel
côté vous devez vous déplacer pour obtenir une couleur déterminée. Chaque mouvement de l’un des boutons
de réglage est appliqué à toutes les barres.
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4 Le bouton “ Fermer ” vous permet de fermer cette boîte de dialogue.
5 Le bouton “ Appliquer ” vous permet d’attribuer la couleur de la boîte de dialogue à l’objet sélectionné.
6 Le bouton “ Ajouter ” vous permet d’ouvrir une boîte de dialogue à l’aide de laquelle vous pouvez ajouter cette

couleur à votre palette.

 

Pour ajouter la couleur dans le tableau, il vous suffit d’indiquer le nom de la couleur dans le champ (1), puis de
cliquer sur “ OK ”.

Standard
Lorsque vous dessinez un objet dans EasySIGN, ce dessin présente systématiquement un remplissage, un style de
ligne et une couleur de ligne standard. Vous pouvez déterminer ce standard. Pour ce faire, il vous suffit de cliquer sur
une couleur de la barre de couleurs ou de créer une couleur dans la boîte de dialogue sans sélectionner l’objet au
préalable. La même procédure s’applique à la création d’une ligne couleur standard.

Gestion de la palette de couleurs et des bibliothèques
G e s t i o n  d e  l a  p a l e t t e  d e  c o u l e u r s  e t  d e s  b i b l i o t h è q u e s  

Si vous souhaitez renommer ou supprimer des couleurs de la barre de couleurs, modifier ou encore ajouter une
couleur provenant d’une bibliothèque, il vous suffit de sélectionner l’outil suivant dans la barre d’outils.

Une fois que vous avez sélectionné cette option, la boîte de dialogue suivante s’affiche à l’écran.
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1 Sélectionnez une couleur dans la liste (2) pour faire apparaître son nom dans le champ de saisie (1). Vous
pouvez également modifier le nom dans ce champ.

2 Cette liste vous permet de trier une couleur et de la sélectionner pour la renommer ou la supprimer.
3 Ci-dessous figure la liste (2) des options qui vous permettent de modifier les couleurs.

Cette option vous permet de sélectionner la liste par ordre alphabétique.

Cette option vous permet d’amener la couleur sélectionnée en haut de la liste.

Cette option vous permet de faire remonter la couleur sélectionnée d’une place dans la liste.

Cette option vous permet de faire descendre la couleur sélectionnée d’une place dans la liste.

Cette option vous permet de faire descendre la couleur sélectionnée au bas de la liste.

Cette option vous permet de supprimer la couleur sélectionnée.

4 Le bouton “ OK ” vous permet d’appliquer toutes les modifications et de fermer la boîte de dialogue.
5 Le bouton “ Annuler ” vous permet de fermer la boîte de dialogue sans appliquer les modifications introduites.
6 Le bouton “ Bibliothèque ” vous permet d’ouvrir la boîte de dialogue suivante.
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1 Vous pouvez sélectionner le nom de la bibliothèque recherchée dans cette liste.
2 Cette liste reprend le nom ou le numéro de référence des couleurs de la bibliothèque sélectionnée. Vous

pouvez sélectionner plusieurs éléments en même temps.
3 Le bouton “ OK ” vous permet d’importer tous les éléments sélectionnés dans la boîte de dialogue précédente

où vous pourrez les trier ou les adapter.
4 Le bouton “ Annuler ” vous permet de fermer la boîte de dialogue sans rien modifier.
7 Le bouton “ Modifier ” vous permet d’ouvrir la boîte de dialogue de couleur standard. Cette boîte de dialogue

vous permet de modifier les caractéristiques des couleurs.

Select by color
S e l e c t  b y  c o l o r

La commande "Sélectionner en fonction de la couleur" du menu "Edition" ouvre une boîte de dialogue qui permet de
sélectionner simultanément tous les objets d'une couleur donnée.
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1 Liste de toutes les couleurs de remplissage de la feuille de travail.
2 Liste de toutes les couleurs de trait de la feuille de travail.
3 Ajouter les couleurs de trait et de remplissage sélectionnées à la liste de sélection (4). 
4 La liste de sélection.
5 Supprime l'élément sélectionné de la liste de sélection.
7 Le bouton "Sélectionner" permet de sélectionner les objets de la feuille de travail qui correspondent à la

couleur de la liste spécifiée.
8 Le bouton "Désélectionner" permet d'annuler la sélection des objets de la feuille de travail qui correspondent à

la couleur de la liste spécifiée.

Sélection par objet
S é l e c t i o n  p a r  o b j e t  

L’option “ Sélection par objet ” du menu “ Traiter ” vous permet d’ouvrir une boîte de dialogue qui fonctionne selon le
même principe que la boîte de dialogue précédente, si ce n’est qu’elle vous permet de sélectionner tous les objets du
même type en une seule opération.

Sélection rapide d'objets possédant un style de remplissage similaire
S é l e c t i o n  r a p i d e  d ' o b j e t s  p o s s é d a n t  u n  s t y l e  d e  r e m p l i s s a g e  s i m i l a i r e

Sélectionnez un objet puis l'option de menu contextuel "Sélection par, Style de remplissage similaire". Tous les objets
possédant le même style de remplissage seront sélectionnés. La sélection recherche les objets ayant le même nom
de couleur et non les mêmes valeurs de couleur.
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Sélection rapide d'objets possédant une couleur de contour similaire
S é l e c t i o n  r a p i d e  d ' o b j e t s  p o s s é d a n t  u n e  c o u l e u r  d e  c o n t o u r  s i m i l a i r e

Sélectionnez un objet puis l'option de menu contextuel "Sélection par, Couleur de contour similaire". Tous les objets
possédant la même couleur de contour seront sélectionnés. La sélection recherche les objets ayant le même nom de
couleur et non les mêmes valeurs de couleur.

Sélection rapide d'objets similaires
S é l e c t i o n  r a p i d e  d ' o b j e t s  s i m i l a i r e s

Sélectionnez un objet puis l'option de menu contextuel "Sélection par, Objets similaires". Tous les objets identiques
seront sélectionnés. 

Couleur d'enregistrement
C o u l e u r  d ' e n r e g i s t r e m e n t

Définition de la couleur d'enregistrement

La couleur d'enregistrement est un espace de couleur séparé. Cette couleur n'est pas une couleur réelle, mais une
propriété. Si un objet possède cette propriété, il sera imprimé et tracé avec chaque couleur dans une séparation de
couleur. La propriété “Couleur d'enregistrement” permet le fonctionnement des repères de cadrage. Vous pouvez
affecter cette propriété via les outils de couleur pour les styles de remplissage et de trait ou via la palette de
couleurs. La couleur d'enregistrement est indiquée dans la palette de couleurs par un champ noir comportant un "R"
blanc.

Vous pouvez affecter n'importe quelle couleur à la propriété de couleur d'enregistrement pour accentuer la différence
entre les couleurs d'enregistrement et les couleurs normales dans votre feuille de travail. Vous pouvez affecter une
couleur par défaut à la couleur d'enregistrement à l'aide de l'onglet "Général" du menu “Fichier, Paramètres”. Chaque
nouvel objet avec une couleur d'enregistrement sera affiché dans cette couleur. Ces paramètres n'ont pas d'effet sur
les objets auxquels cette propriété a déjà été affectée. Vous pouvez modifier l'aspect des objets avec cette propriété
via les outils de couleur pour les styles de trait et de remplissage.

Dans l'illustration ci-dessus, “A” est l'objet avec la propriété de couleur d'enregistrement et la couleur rouge est
affectée à cette propriété.

1 Séparation de couleur en rouge
2 Séparation de couleur en vert
3 Séparation de couleur en bleu

La couleur d'enregistrement est automatiquement incluse avec chaque séparation de couleur.
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Mesure des couleurs
M e s u r e  d e s  c o u l e u r s

Dans EasySIGN, vous pouvez entrer des couleurs dans le logiciel via un densitomètre. C’est le moyen idéal pour réaliser votre propre

bibliothèque de couleurs ! 

Paramètres
Ouvrez le menu « Fichier, Paramètres » et sélectionnez l’onglet « Densitomètre » dans la boîte de dialogue ouverte.

1 Sélectionnez l’option « Oui, je veux utiliser mon densitomètre ».

2 Sélectionnez la marque du densitomètre dans la zone de liste modif iable.

3 Sélectionnez le port sur lequel est connecté le densitomètre. Si vous avez choisi un densitomètre avec une

connexion USB dans la zone de liste modif iable, cette option n’est pas disponible. N’utilisez pas un

densitomètre automatique qui mesure plusieurs couleurs en une fois, choisissez-en un qui mesure seulement

une couleur à la fois.

4 Cliquez sur ce bouton pour savoir si le densitomètre est reconnu. Ceci peut prendre un moment, attendez le

message indiquant que le densitomètre est reconnu.

5 Sélectionnez l’espace de couleur dans lequel les couleurs mesurées doivent être stockées (CMJN ou RVB).

Si vous souhaitez imprimer en couleur, utilisez plutôt l’espace de couleur CMJN.

6 Ici, vous pouvez sélectionner le profil souhaité pour l’espace de couleur CMJN et RVB. Si vous disposez

d’une imprimante et d’un profil (ICC ou ICM) pour cette imprimante : sélectionnez ce profil. De cette manière,

les couleurs mesurées se rapprocheront le plus possible du résultat imprimé. Si vous ne disposez pas d’une

imprimante ou si vous en avez plusieurs, choisissez les profils « CMJN par défaut » et « RVB par défaut ».

Enregistrez les paramètres définis en cliquant sur « Appliquer » et fermez la boîte de dialogue.

Procédure
Dans la barre d’outils, sélectionnez le « pot de peinture », puis l’icône de gestion des couleurs.
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La boîte de dialogue suivante s'ouvre.

Si vous souhaitez stocker les nouvelles couleurs dans un tableau séparé, vous devez d’abord cliquer sur le bouton « Nouveau » (2) dans le

groupe « Tableau », et créer un nouveau tableau. Si vous avez déjà effectué cette opération ou si vous souhaitez ajouter les couleurs

mesurées dans un tableau existant, cliquez sur le bouton « Mesure » (1) dans le groupe « Couleur ».

Entrez le nom de la couleur et cliquez sur la couleur que vous souhaitez mesurer à l’aide du densitomètre. La couleur apparaît dans l’aperçu

des couleurs (2) et les valeurs des couleurs dans les zones d’édition.

Si cette icône apparaît, la couleur mesurée n’entre pas dans la gamme (la gamme de couleurs imprimables) de votre imprimante, selon le

profil sélectionné dans les « Paramètres ».  Vous pouvez ajuster la couleur visuellement pour qu’elle s’approche au plus près de la couleur

mesurée.

Cliquez sur le bouton « Ajouter » pour ajouter la couleur mesurée au tableau des couleurs actives. Fermez la boîte de dialogue une fois les

mesures de couleur terminées. N’oubliez pas de cliquer sur le bouton « OK » pour enregistrer les modif ications. 
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Remplissage en dégradé
R e m p l i s s a g e  e n  d é g r a d é

Avec le remplissage en dégradé, vous pouvez obtenir un fondu graduel d’une ou de plusieurs couleurs dans la couleur
suivante. Cette fonction permet d'ajouter plus d’effets de couleur et de profondeur à chacun de vos projets. Plusieurs
types de remplissages en dégradé sont disponibles.

Linéaire
Le remplissage se fait ligne après ligne de couleur : 

Radial
Le remplissage se fait en cercles concentriques :

Carré
Le remplissage se fait en carrés concentriques.

Conique
Le remplissage se fait par rayons partant du centre de l’objet :

Chacun de ces modes de remplissage est de deux types.

Bicolore
Le remplissage se fait avec deux couleurs se fondant l’une dans l’autre :

Personnalisé
Le remplissage se fait avec plus de deux couleurs. Vous pouvez, par exemple, passer graduellement du rouge à
l’orange, puis au jaune, puis au vert, etc. :

En passant par la boîte de dialogue —ou directement à l’écran— vous pouvez personnaliser davantage encore les
remplissages : en changeant le “ Remplissage latéral ” ou l’“ Angle ”, en ajoutant ou en supprimant des couleurs, etc.
 

Comment appliquer un remplissage en dégradé ?
Vous disposez de deux moyens.

La boîte de dialogue de remplissage en dégradé
Sélectionnez un objet et cliquez sur le bouton de remplissage dans le sous-menu “ Remplissages ” de la boîte à
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outils : 

Définissez vos paramètres et cliquez sur “ OK ”.

Directement à l’écran.
Dans le sous-menu “ Remplissages ” de la boîte d’outils, cliquez sur le symbole pour le remplissage en dégradé
direct. 

Le curseur se transforme :

Pour appliquer un remplissage en dégradé, vous sélectionnez, avec cet outil, l’objet à remplir, et vous le tirez en
même temps avec la souris. 

Boîte de dialogue de remplissage en dégradé
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Bicolore
1 Type
 Vous pouvez choisir ici les différents types de remplissages en dégradé :
  Linéaire
  Radial
  Carré
  Conique

2 Centrer
 Si le type de remplissage s’y prête, vous pouvez ajuster le centre du remplissage avec cette commande. Dans

l’image ci-dessous, dans la colonne de gauche, le centre est réglé avec une horizontale et une verticale à 0% ;
dans la colonne de droite, les valeurs verticales et horizontales sont réglées à 25%.

 

3 Options

 Angle
 Vous pouvez ajuster ici l’angle du remplissage en dégradé.

 Etapes
 Vous pouvez définir ici le nombre d'étapes nécessaires à la construction du remplissage en dégradé. Si vous

déverrouillez le bouton derrière ce champ, vous pouvez décider du nombre d’étapes pour le remplissage en
dégradé actuellement actif. Si vous verrouillez le bouton, les étapes affichées sont celles dont vous pouvez
définir globalement le nombre dans le menu “ Fichier ”, “ Paramètres ”, “ Général ”, “ Etapes de remplissage en
dégradé ”.

 Remplissage latéral
 Ce paramètre règle le début et la fin du remplissage uni et le point de début du remplissage en dégradé. 
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 Effets spéciaux
 Si cette option est active, vous pouvez obtenir un effet spécial avec le remplissage en dégradé.  Un carré de

remplissage en dégradé normal a cet aspect :  

 

 Le même remplissage en dégradé, avec cette fois l’option “ Effets spéciaux ” activée et un angle de 6 degrés,
se présente comme suit : 

 

4 Remplissage en dégradé
 Vous avez le choix entre “ Bicolore ” et “ Personnalisé ”.  

5 De/à
 Vous pouvez indiquer ici le début et la fin du remplissage. Après avoir choisi l’un des boutons, le menu suivant

s’affiche :
 

 

 Le choix d’un carré de couleur détermine la nouvelle couleur de début ou de fin.  
 

 

 Si vous choisissez le carré noir avec la majuscule “ C ”, vous ouvrez une boîte de dialogue qui vous permet de
créer une couleur personnalisée.

6 Centrer
 Vous pouvez définir ici le centre du remplissage.
 

 

7 Arc-en-ciel
 En cliquant sur l’un de ces boutons, vous pouvez définir la direction de début et de fin de la couleur. Dans
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l’exemple ci-dessous, l’image de gauche montre le chemin le plus “ court ” d’une couleur à l’autre dans un
espace de couleur, et l’image de droite le chemin le plus “ long ”. 

 

 

8 Préférences
 Vous trouverez dans cette liste un jeu de remplissage en dégradé pré-définis. Vous pouvez ajouter un dégradé

de votre choix en tapant un nom et en cliquant sur le bouton avec le signe plus (“ + ”).  Vous supprimez un
dégradé en le sélectionnant et en cliquant sur le bouton avec le signe moins (“ - ”). 

Personnalisé
Si vous sélectionnez “ Personnalisé ”, la boîte de dialogue change :

 

 

1 Position
 La position de la couleur sélectionnée dans le remplissage de dégradé est ici indiquée.  

2 Remplissage actuel
 Vous pouvez voir ici la couleur actuellement sélectionnée.  

A Couleur de départ.
B L’une des positions possibles de la couleur dans le remplissage en dégradé.
C Couleur de fin.

Vous pouvez ajouter une nouvelle position de couleur en cliquant deux fois sur le blanc entre les points “A” et “B” ou
en ajoutant une valeur en (1). 
Si vous voulez ajouter une position numériquement (1), assurez-vous qu’aucune position n’est déjà sélectionnée —
vous ne feriez sinon que déplacer une position sans en ajouter d’autres.
 Vous pouvez désélectionner une position en cliquant une fois sur le blanc entre les points “ A ” et “ B ”.
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La position nouvelle, dans le dégradé ci-dessous, a la couleur exacte de la position. Quand vous vous déplacez à un
autre endroit, la position change mais non la couleur. Vous pouvez changer une position en la sélectionnant et en la
tirant ou en sélectionnant la position et en changeant sa valeur dans le champ position (1) :

 

 

Une position est sélectionnée quand le triangle est noir. Quand une position est sélectionnée, vous pouvez la
supprimer en appuyant sur la touche “ Suppr ” de votre clavier. 

Pour changer la couleur de fin et de début, sélectionnez le point “ A ” et “ B ”, puis changez sa valeur dans le menu de
couleur (2). Pour changer la couleur de l’une des positions, sélectionnez-la, puis changez sa valeur dans le menu de
couleur (2).

Ajuster un remplissage en dégradé directement à l’écran
Sélectionnez un objet avec un remplissage en dégradé puis le symbole pour un remplissage en dégradé direct dans le
sous-menu “ Remplissages ” de la boîte d’outils.

Les poignées de contrôle du remplissage en dégradé deviennent visibles :

Si vous tirez sur l’une des poignées extérieures, vous pouvez changer l’angle et les positions du remplissage en
dégradé. Ces poignées sont magnétiques et peuvent s’amarrer à une ligne guide ou à un nœud :  
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Le curseur de réglage, au milieu, sert à changer le centre du remplissage en dégradé.

Quand une position est sélectionnée, vous pouvez changer ses propriétés. 

Non sélectionnée : 

Sélectionnée : 

1 Emplacement
 Vous pouvez aussi modifier numériquement l’emplacement de la position externe en choisissant d’utiliser le

menu contextuel avec la commande “ Déplacer ” : 
 

 

2 Couleur
 Vous pouvez changer la couleur d’une position, d’abord en la sélectionnant, ensuite en choisissant une couleur

dans la barre de couleur. Vous pouvez aussi choisir “ Propriétés ” dans le menu contextuel. Si votre choix s’est
porté sur “ Propriétés ”, la boîte de dialogue de personnalisation des couleurs s’affiche.

3 Supprimer
 Vous pouvez supprimer toute position, avec le menu contextuel ou en pressant la touche “ Suppr ” du clavier,

sauf les positions de fin et de début. 

4 Ajouter des positions
Vous pouvez ajouter une position en plaçant la souris sur la ligne pointillée entre les positions de début et de fin et en
sélectionnant “ Insertion ” dans le menu contextuel. Vous pouvez également cliquer deux fois sur la ligne pointillée. Le
curseur de la souris change d’aspect quand vous êtes sur la ligne pointillée.
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En cliquant deux fois, vous ajoutez une position :

En sélectionnant une couleur dans la barre de couleur, vous pouvez changer la couleur de la position.

Modification du type de remplissage en dégradé
Ouvrez la boîte de dialogue de remplissage en dégradé en cliquant sur le bouton de remplissage du sous-menu
“ Remplissages ” de la boîte d’outils.

Vous pouvez maintenant changez le “ Type ” de remplissage.
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Radial

Comme avec n’importe quel type de remplissage, vous pouvez ajouter des positions et en modifier l’emplacement et
la couleur.

Carré

Conique
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Travailler avec des remplissage en dégradé
Avec les poignées de contrôle, vous pouvez faire directement à l’écran à peu près tout ce que vous feriez avec la
boîte de dialogue.

Le passage d’un type de dégradé à l’autre ne peut se faire qu’avec la boîte de dialogue :

Vous pouvez en réalité faire directement à l’écran presque toutes les opérations de la boîte de dialogue :
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Remplissages en dégradé prêts pour la découpe

Vous pouvez préparer pour la découpe un remplissage en dégradé en choisissant, via le menu contextuel, la
commande “ Convertir en ”, “ Prêt pour la découpe ”.

Si vous travaillez en mode couleur, il est impossible de voir la différence. Vous ne vous apercevez des étapes qu’en
passant par le mode grille. Chaque étape du remplissage en dégradé est convertie en un objet vectoriel prêt à être
découpé. Cette opération n’est utile que si le dégradé requiert un petit nombre d’étapes. Il faudrait sinon consommer
beaucoup de vinyles et le processus serait trop long.

 

 

Motifs de remplissage

Les motifs de remplissage sont des f ichiers bitmap qui peuvent être ajoutés en toute transparence afin de former un ensemble homogène

ininterrompu. EasySIGN est fourni avec plusieurs centaines de f ichiers d’exemple. Vous pouvez obtenir plus de 3 400 remplissages répartis

dans 27 catégories, telles que « Bois », « Métal », « Marbre », « Pierre », etc. sur notre site Web : http://w w w .easysign.com.
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Les motifs de remplissage se trouvent dans le sous-répertoire « Shared\TEXTURES\ » de EasySIGN. 

Application d’un motif de remplissage

Les motifs de remplissage, comme les autres remplissages, peuvent être appliqués au moyen du « pot de peinture" de la barre d’outils.

Sélectionnez d’abord un objet vectoriel auquel vous souhaitez attribuer un motif de remplissage, puis sélectionnez l’icône ci-dessous dans la

barre d’outils.

La boîte de dialogue dans laquelle vous pouvez sélectionner le motif de remplissage s'ouvre.

1 Aperçu des motifs

En cliquant sur le bouton « Motif », vous ouvrez une boîte de dialogue dans laquelle vous pouvez sélectionner le motif de remplissage

de votre choix.
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Il s’agit de la boîte de dialogue « Ouvrir » standard que vous avez déjà vue auparavant, avec quelques ajouts.

1)

Permet de déterminer la manière dont les f ichiers vous sont présentés. Sélectionnez « Miniatures » pour voir les aperçus des images.

2)

En cliquant sur le bouton « + », vous pouvez ajouter le sous-répertoire actuel à la liste « Favoris ».

Lorsque vous sélectionnez un sous-répertoire dans cette liste, la boîte de dialogue accède automatiquement à l’emplacement

sélectionné. 

2 Origine du décalage

Les motifs de remplissage « démarrent » au niveau de l’angle inférieur gauche des objets sélectionnés. Cette option permet de définir

ce point d’origine.

3 Taille

Permet d’ajuster la taille du motif de remplissage.

4 Transformations

Permet d’ajuster l’inclinaison et la rotation du motif de remplissage.

Transformer la mosaïque avec l'objet

Cette option permet de déterminer si le motif de remplissage doit copier les transformations de l’objet.

Original
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L’objet est transformé et cette option est désactivée

L’objet est transformé et cette option est activée

Manipulation des motifs de remplissage avec la souris

Sélectionnez un objet comportant un motif de remplissage.

Ensuite, sélectionnez l’outil permettant d’ajuster les motifs de remplissage (le même que celui qui permet d’ajuster les remplissages avec une

couleur).

Vous pouvez ajuster la rotation, l’emplacement (origine), la mise à l’échelle et l’inclinaison à l’aide de la souris.

Les réglages effectués à l’aide de la souris sont copiés dans la boîte de dialogue du motif de remplissage. Si vous souhaitez aff iner les

transformations, sélectionnez l’objet avec le motif de remplissage, puis choisissez l’icône ci-dessous dans la barre d’outils.

Exemples de motifs de remplissage
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Croix de bordure

EasySIGN vous offre la possibilité de placer automatiquement des croix de bordure autour d’une page ou d’une
sélection. Vous pouvez également disposer directement des croix de bordure à l’emplacement voulu. Les croix de
bordure sont toujours placées sur une couche spéciale dont la visibilité et le verrouillage sont adaptables. Vous
pouvez également déterminer si les croix de bordure doivent ou non être imprimées ou tracées. Dans EasySIGN, les
croix de bordure appartiennent à une catégorie spéciale d’objets et se comportent différemment des autres
catégories. Ainsi, si vous placez des croix de bordure autour d’un objet que vous souhaitez tracer avec séparation des
couleurs, vous ne devez pas placer une croix de bordure pour chaque couleur. Les croix de bordures sont en effet
tracées ou imprimées quel que soit le nombre de couleurs présentes sur une feuille de travail. 
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Si vous souhaitez placer une croix de bordure à un endroit déterminé, sélectionnez l’outil suivant dans la barre d’outil.

Le curseur se présente alors sous la forme suivante.

Une croix de bordure de bordure apparaît sur tous les points de la feuille de travail sur lesquels vous cliquez à l’aide
de ce curseur.

Cliquez sur une croix de bordure à l’aide du bouton droit de la souris pour faire apparaître un menu à l’écran. Ce
menu comporte les options suivantes.

Supprimer : Cette option vous permet de supprimer la croix de bordure qui se trouve sous le pointeur
de la souris.

Tout
supprimer

: Cette option vous permet de supprimer toutes les croix de bordure de la feuille de travail.

Masquer : Cette option vous permet de masquer toutes les croix de bordure qui figurent sur votre
feuille de travail. Utilisez la boîte de dialogue consacrée aux couches pour rendre les croix
de bordure masquées à nouveau visibles.

Propriétés : Cette option vous permet d’ouvrir une boîte de dialogue dans laquelle vous pouvez entrer
les modifications suivantes.

1 Vous pouvez modifier la forme de la croix de bordure.
2 Vous pouvez modifier la taille de la croix de bordure.
3 Si vous activez cette option, toutes les modifications introduites seront appliquées à l’ensemble des croix de

bordure figurant sur votre feuille de travail.

Ouvrez la boîte de dialogue suivante via le menu “ Insérer, Production, Croix de bordure ”.
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La forme et la taille que vous avez déterminées dans cette boîte de dialogue deviennent alors le standard appliqué
lorsque vous placez des croix de bordure sur votre feuille de travail à l’aide de l’outil.

1 Vous pouvez sélectionner la forme.
2 Vous pouvez indiquer ici la taille de la croix de bordure.
3 Si vous activez l’option “ Page entière ou sélection ”, les options du groupe inférieur sont également activées.

Ce groupe vous permet d’indiquer si vous souhaitez placer les croix de bordure autour de la page entière ou
de la sélection.

4 Le champ “ Marges ” vous permet d’indiquer la distance à laquelle les croix de bordure doivent être placées par
rapport à la sélection ou à la page.

5 Si vous activez cette option, les valeurs introduites dans le premier champ sont automatiquement appliquées
aux trois autres champs.

Croix de bordure autour de la page 
Cette option vous permet non seulement de placer des croix de bordure autour de la page, mais également d’adapter
la taille de la page de manière à ce que les croix de bordure soient imprimées. Si vous utilisez cette option, quatre
lignes de référence sont ajoutées sur la page. Elles indiquent la taille initiale de la feuille de travail. De la sorte, vous
ne pouvez pas oublier de tenir compte de la surface des croix de bordure lors de l’impression de la page, car la taille
de la page comprend les croix de bordure.

Modification des repères de cadrage
Le fonctionnement des repères de cadrage est globalement le même que dans les versions précédentes. Toutefois, de
nouvelles fonctionnalités importantes ont été ajoutées. A partir de la version 3, les repères de cadrage peuvent être
sélectionnés avec d'autres objets et repositionnés. Vous pouvez également les convertir en courbes et ajuster leur
couleur.

Repères de cadrage personnalisés
Les repères de cadrage ont la propriété “Couleur d'enregistrement”.  Cela signifie que les objets qui ont cette
propriété sont imprimés ou tracés avec des séparations de couleurs. La propriété “Couleur d'enregistrement” peut
être affectée à chaque objet vectoriel, qui est aussi imprimé ou tracé avec des séparations de couleurs. Si vous
annulez la propriété “Couleur d'enregistrement” pour un repère de cadrage, celui-ci ne sera plus imprimé ni tracé
avec des séparations de couleurs.

Diviser

Si un élément de la feuille de travail est trop grand pour être réalisé en une seule fois ou, en d’autres termes, si le
format de sortie du traceur n’est pas suffisant, il suffit d’utiliser la fonction “ Diviser ”.
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Supposons que l’image représentée ci-dessus est trop grande pour votre traceur. Sélectionnez les objets que vous
souhaitez diviser, puis réalisez une copie provisoire à partir de laquelle vous procéderez à la division. La division
coupe littéralement les objets en deux, ce qui explique pourquoi les objets perdent leurs propriétés. Si vous divisez
du texte par exemple, vous ne pouvez plus le traiter comme du texte. C’est pourquoi il est préférable de travailler sur
une copie.

Sélectionnez l’option “ Diviser ” du menu “ Traiter ”. Le curseur se présente alors sous la forme suivante.

Amenez le curseur sur le point sur lequel vous souhaitez procéder à la division, cliquez une fois sur le bouton de la
souris, puis glissez le curseur sur la partie à diviser. Vous pouvez également procéder à la division à partir de
n’importe quel angle. Si vous utilisez la touche “ CTRL ”, les angles seront limités à 15 degrés. Relâchez le bouton de
la souris après le glissement pour faire apparaître la boîte de dialogue suivante à l’écran.

1 Chevauchement
 Ce champ vous permet d’indiquer la taille du chevauchement.
2 Fermer formes
 Si vous activez cette option, les formes sont fermées après la division. Si vous procédez à la division en vue du

traçage, vous devez activer cette option. En effet, si cette option est désactivée, les formes ouvertes seront
coupées.

3 Grouper résultat
 Si vous divisez un objet par exemple, cette option vous permet de grouper directement le résultat. Il est

préférable de ne pas utiliser cette option si vous disposez de plusieurs objets, car les groupements peuvent
modifier l’ordre, ce qui peut donner lieu à des résultats inopportuns.

4 Le bouton “ OK ” vous permet d’appliquer les modifications introduites, tandis que le bouton “ Annuler ” vous
permet de fermer la boîte de dialogue sans effectuer la division.

Une fois que vous appuyé sur le bouton “ OK ”, vous constatez que rien n’a à première vue changé. Passez en
modèle fil de fer ou étirez l’objet pour mieux visualiser le résultat.

Couper

Il ne s’agit pas d’une fonction spécifique aux enseignes, mais plutôt d’une fonction dérivée de la division. Cette
fonction vous permet de découper des objets ou de les couper en deux très rapidement. Sélectionnez l’option
“ Couper ” du menu “ Traiter ”. Le curseur se présente alors sous la forme suivante :
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Ce curseur vous permet de tracer une ligne, tout comme dans le cas de la division. Cette fonction vous amène à
l’endroit précis où vous souhaitez procéder à la découpe. Si vous souhaitez couper un objet entier, vous devez tracer
la ligne tout autour de cet objet.

Relâchez le bouton de la souris pour faire apparaître la boîte de dialogue suivante à l’écran.

Cette boîte de dialogue vous permet d’introduire la “ largeur de coupe ” (1). Après avoir introduit la largeur de coupe,
cliquez sur le bouton “ OK ” (2). Rien ne semble modifié à première vue. Vous pouvez attribuer une couleur à l’une
des moitiés afin de rendre la différence plus visible.

Fondre

Cette fonction figure certainement au nombre des fonctions les plus utilisées pour faire des dessins à partir d’une
conception réussie. Les éléments de cette fonction vous permettent de visualiser directement à l’écran les dessins les
plus complexes avant la découpe.

Fusionner
Cette fonction vous permet de fusionner deux objets en un. Sélectionnez les objets que vous souhaitez fusionner,
puis sélectionnez l’option “ Fusionner ” du menu “ Traiter, Fondre ”.
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Marquage objet
La fonction “ Marquage objet ” vous permet de supprimer la forme d’un objet de l’objet inférieur. 

Marquage ouvert 
L’option “ Marquage ouvert ” fonctionne selon le même principe, si ce n’est que les formes sont “ ouvertes ” au terme
de l’opération.

Marquage dernière sélection 
En principe, le marquage est basé sur l’ordre : l’objet supérieur marque l’objet inférieur. Cette option ne prend pas
l’ordre dans lequel l’objet se trouve en considération. Le dernier objet sélectionné marque les objets sélectionnés
avant lui, puis est supprimé.

Masquer dernière sélection 
Cette option se sert du dernier objet sélectionné comme un masque et marque tous les objets qui l’entourent.
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Superposition
L’option “ Superposition ” prend uniquement les formes superposées en considération. Si vous avez sélectionné
plusieurs objets qui ne superposent pas tout à fait, cette option ne produit aucun résultat.

L’illustration suivante représente une superposition imparfaite de formes. La forme supérieure se superpose
uniquement à la forme du milieu. Dans ce cas, la fonction ne produit aucun résultat. 

L’illustration suivante représente des formes qui se superposent les unes aux autres. Dans ce cas, cette fonction
produit un résultat.
 

Ajouter nœuds 
L’option “ Ajouter nœuds ” vous permet d’ajouter un nœud supplémentaire sur tous les points où les lignes des objets
sélectionnés se coupent.



187EasySIGN

Phototraçage

Cette fonction vous permet de tracer un bitmap constitué de tons gris ou un bitmap couleurs. Le principe est le
suivant : des bandes plus épaisses sont créées en fonction de la noirceur de la photo. Vous pouvez paramétrer la
distance entre les lignes et le nombre de lignes. Pour la découpe, il est conseillé de ne pas descendre sous 2 mm. Les
lignes seraient en effet trop proches les unes des autres, ce qui compliquerait l’opération de découpe.
Pour procéder au phototraçage, sélectionnez le bitmap que vous souhaitez utiliser. Cliquez ensuite sur ce bitmap à
l’aide du bouton droit de la souris pour faire apparaître à l’écran un menu contextuel contenant deux options
pertinentes en matière de phototraçage.

A Phototraçage
 Sélectionnez cette option pour que le bitmap s’affiche comme un phototraçage avec les paramètres en vigueur.

B Options de phototraçage
 Cette option vous permet d’ouvrir une boîte de dialogue dans laquelle vous pouvez adapter les paramètres du

phototraçage.

 

1 Largeur bande
 Vous pouvez déterminer la largeur des bandes dans lesquelles la photo sera divisée.
2 Nombre de bandes
 Vous pouvez déterminer le nombre de bandes dans lesquelles la photo doit être divisée.
3 Sens de la découpe 
 Vous pouvez déterminer si les bandes sont horizontales ou verticales.
4 Découpe négative
 Cette option vous permet d’inverser la luminosité de la photo.
5 Epaisseur de ligne
 Cette option vous permet de déterminer l’épaisseur maximum et minimum des bandes.

Le bouton “ OK ” vous permet d’appliquer les paramètres et de fermer la boîte de dialogue, tandis que le bouton
“ Annuler ” vous permet de fermer la boîte de dialogue sans appliquer les paramètres introduits.

Les paramètres que vous avez introduits dans cette boîte de dialogue seront appliqués au prochain bitmap que vous
soumettrez au phototraçage.
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Texte

Texte
T e x t e

Le texte est probablement l’élément principal de tout concept. C’est précisément pour cette raison que EasySIGN
contient un outil texte très sophistiqué. Cet outil, très facile à utiliser, traite le texte placé sur un chemin ou sur un
cercle, les tabulations, les propriétés, etc. Tout se fait et s’affiche immédiatement à l’écran.

Insertion de texte
I n s e r t i o n  d e  t e x t e  

Cliquez sur le symbole de l’éditeur de texte dans la barre d’outils.

La boîte de dialogue suivante s’affiche à l’écran. Le curseur se présente sous la forme d’un caret texte.

Cliquez sur la feuille de travail à l’aide de ce caret, puis commencez à taper votre texte. Si vous souhaiter introduire
un texte provenant d’une source autre que EasySIGN, il vous suffit de sélectionner ce texte dans son application
initiale (ou dans l’un des traitements de texte de Windows™), puis de sélectionner l’option “ Copier ”. Dans EasySIGN,
veillez à ce que le caret texte soit situé sur la feuille de travail, puis appuyez sur la combinaison de touches “ CTRL +
V ” pour coller le texte coupé. La compatibilité est assurée avec pratiquement tous les logiciels de traitement de texte
qui fonctionnent sous Windows™.
Si vous sélectionnez une partie du texte, placez le caret texte à la fin ou au début de la sélection, puis glissez le
curseur jusqu’à l’autre extrémité. Toutes les options que vous sélectionnerez à partir de maintenant dans la boîte de
dialogue s’appliqueront à la partie de texte sélectionné.

Eléments de la boîte de dialogue 
1 Sélection de la police
 Vous pouvez sélectionner la police de votre choix. Un exemple de la police appliquée à votre sélection est

affiché pour permettre d’en visualiser l’aspect.
2 Ces boutons vous permettent de mettre le texte sélectionné en gras ou en italique (si la police sélectionnée

l’autorise). Il convient de garder présent à l’esprit le fait qu’il existe des familles entières de polices qui
n’acceptent que les capitales ou le format “ normal ” de caractère.

 

3 Ce premier bouton vous permet de mettre un caractère en exposant (caractère plus petit apposé au sommet
du caractère précédent) ou en indice (caractère plus petit apposé au bas du caractère précédent).

 

4 Le premier bouton vous permet de transformer tous les caractères sélectionnés en lettres majuscules, tandis
que le second les transforme en petites capitales. Ce dernier format signifie que toutes les lettres majuscules
le restent, mais que les minuscules sont transformées en lettres majuscules dont la hauteur est de 30 %
inférieure à celle des capitales normales.
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5 Ces boutons vous permettent d’aligner le texte à droite ou à gauche ou de le centrer.

 

6 Ces boutons vous permettent de placer le texte en cercle. Ils sont expliqués de manière plus approfondie dans
la suite de ce chapitre.

7 Ce champ vous permet d’indiquer la grandeur du texte sélectionné. L’interligne (8) est adapté
automatiquement à la valeur introduite dans ce champ.

 

8 Ce champ vous permet de modifier l’interligne.

 

9 L’espacement entre les mots. L’espacement est exprimé en pour cent. L’espacement standard est de 100 pour
cent. Dans l’exemple figurant ci-dessous, l’espacement standard a été doublé. Ce paramètre s’applique
uniquement à la partie de texte sélectionnée, non à l’ensemble du paragraphe.

 

10 Ce champ vous permet de déterminer un espacement supplémentaire pour les caractères sélectionnés et les
espaces entre les mots. Le paramètre standard est de zéro pour cent. Chaque augmentation de cette valeur
donne lieu à un espacement supplémentaire des lettres (texte plus aéré).

 

11 Ce champ vous permet de déterminer la largeur du texte. Vous pouvez élargir ou réduire votre texte
simplement : il vous suffit de modifier les valeurs. La valeur standard est de 100 pour cent.

 

12 Paramètres par défaut
 Les paramètres actuels de l’éditeur de texte s’appliquent par défaut.

13 Appliquer les paramètres par défaut
 Les paramètres par défaut s’appliquent à toutes les commandes de l’éditeur de texte.

14 Faire pivoter texte
 Rotation de chaque caractère du texte :
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15 Incliner le texte
 Chaque caractère sélectionné est incliné :

La rotation et l’inclinaison de texte se font à partir du point d’origine du caractère. 

Edition du texte 
Si vous souhaitez modifier un texte, il vous suffit de sélectionner l’outil texte dans la barre d’outils, puis de placer le
caret texte à l’endroit du texte que vous désirez changer. Vous pouvez également sélectionner le texte à modifier,
puis sélectionner l’option “ Editer texte ” du menu contextuel. Les deux méthodes donnent lieu au même résultat,
mais elles sont basées sur des approches différentes.

Attribuer une couleur ou un contour à un texte 
Pour attribuer une couleur ou un contour à un bloc de texte, commencez par sélectionner ce bloc à l’aide de l’outil de
sélection. Cliquez ensuite sur la couleur voulue dans la barre de couleurs ou ouvrez la boîte de dialogue consacrée
aux couleurs pour composer une couleur.

Si vous souhaitez attribuer une couleur ou un contour à un ou plusieurs caractères figurant dans un texte,
sélectionnez les caractères à modifier à l’aide de l’outil texte. Cliquez ensuite sur la couleur voulue dans la barre de
couleurs ou ouvrez la boîte de dialogue consacrée aux couleurs pour composer une couleur.

Alinéas et tabulations
A l i n é a s  e t  t a b u l a t i o n s

EasySIGN supporte l’utilisation de tabulations pour les textes classiques et pour les textes placés sur un chemin. Cette
fonction se révèle particulièrement utile pour composer rapidement des tarifs. Les alinéas ne peuvent être utilisés
dans le cas de textes placés sur un chemin, car ils sont constitués de plusieurs lignes. Si vous placez un alinéa sur un
chemin, cet alinéa est toujours converti en une seule ligne.

Création d’un alinéa
Comme la version actuelle de EasySIGN ne supporte pas encore le retour automatique des lignes, vous devez créer
vous-même les coupures dans les alinéas. C’est la seule restriction s’appliquant aux alinéas. Pour le reste, EasySIGN
contient toutes les autres fonctions. Parmi celles-ci, citons la mise en retrait ou les propriétés. Ci-dessous figure un
exemple qui illustre la création d’un alinéa.
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Tapez plusieurs lignes de texte en commençant par une tabulation, un tiret et une tabulation.

Dans la règle figure ce que l’on appelle la “ barre de tabulation ”. L’alinéa n’est pas encore à proprement parler un
alinéa. Avant toute chose, il convient de vous présenter les éléments de la barre de tabulation. 

A Mise en retrait de la première ligne

 

 Lorsque vous déplacez ce bouton de réglage vers la droite, la première ligne (accompagnée dans notre cas des
tabulations) s’aligne sur  sa position.

B Mise en retrait du paragraphe
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 Si vous le déplacez vers la droite, toutes les lignes, à l’exception de la première, s’alignent sur sa position. La
première ligne dépend en effet du bouton de réglage “ A ”. Vous pouvez également introduire cette
modification par l’intermédiaire de la boîte de dialogue consacrée aux propriétés de la barre de tabulation.

C Symboles qui indique la distance standard de tabulation. Seule la boîte de dialogue relative aux propriétés vous
permet de modifier cette propriété.

Si vous souhaitez placer une tabulation dans la barre de tabulation, il vous suffit de cliquer dans la barre à l’aide de la
souris à l’endroit où vous souhaiter la positionner. Une tabulation vient alors s’ajouter à cet endroit précis.

Le caractère qui suit la première tabulation est aligné sur cette position. Si vous souhaitez modifier les
caractéristiques (type d’alignement) de la tabulation, cliquez sur la tabulation à l’aide du bouton droit de la souris pour
faire apparaître un menu contextuel. Ce menu vous donne le choix entre “ Gauche ”, “ Droite ”, “ Décimal ” ou
“ Centré ”. Vous pouvez également modifier ces caractéristiques à l’aide de la boîte de dialogue que vous pouvez
ouvrir en sélectionnant l’option “ Propriétés ” du menu contextuel. Sélectionnez l’option “ Droite ” dans ce cas. Le
résultat se présente alors comme suit. 

Pour faire en sorte que l’alinéa ressemble à un alinéa, vous devez maintenant indiquer la position de la seconde
tabulation. Il s’agit ici d’une tabulation d’alignement à gauche, étant donné que la largeur du texte est trop importante
pour une tabulation d’alignement à droite.
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Pour apporter la touche finale à l’ensemble, il ne vous reste plus qu’à amener le bouton de réglage inférieur (pour le
paragraphe) au même endroit que la deuxième tabulation.

Si vous souhaitez supprimer des tabulations, il vous suffit de sélectionner l’option “ Supprimer ” du menu contextuel
ou de faire glisser la tabulation à l’extérieur de la barre de tabulation.

N’oubliez pas que les paramètres relatifs aux tabulations et à l’alignement doivent être introduits par ligne.

Exemples d’alignement sur des tabulations 
Il existe quatre alignements sur tabulation différents. Tous sont réservés à un usage spécifique. Les exemples
figurant ci-dessous sont tous basés sur le même cas de figure afin de rendre les différences plus manifestes.

Tabulations d’alignement à gauche
Ces tabulations sont presque toujours utilisées au début d’un alinéa en retrait pour aligner la première phrase sur le
reste de l’alinéa. Ce système ne convient pas aux tarifs, comme vous pouvez le constater dans l’exemple suivant.

Tabulations d’alignement à droite
Ces tabulations sont peu utilisées. Elles servent principalement à composer des tarifs, lorsque le même caractère ou
le même nombre de caractères sont placés après la décimale. Leur seule autre fonction concerne des compositions
spéciales : pour attirer l’attention sur un élément d’un alinéa en retrait en plaçant cet élément à droite et non à
gauche (la plupart du temps des chiffres en hausse).
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Tabulations décimales
Ces tabulations figurent parmi les tabulations les plus fréquemment utilisées. Elles sont incontournables pour réaliser
des tarifs. La nature du signe décimal est déterminée par l’intermédiaire des “ Paramètres régionaux ” de Windows™ .
En Europe, le symbole décimal est bien souvent une virgule, tandis qu’aux Etats-Unis, il s’agit d’un point.

Tabulations centrées
Cette tabulation est également réservée à un usage spécifique. Elle est probablement l’une des moins utilisées.

Limitations des tabulations 
Les tabulations ne servent que si le paragraphe est aligné à gauche. Les tabulations appliquées à un texte centré ou
aligné à droite sont ignorées. 

Propriétés de la barre de tabulation 
Cette boîte de dialogue vous permet de définir les propriétés des tabulations et des alinéas. Il vous suffit de cliquer
sur la règle de tabulation à l’aide du bouton droit de la souris pour la faire apparaître à l’écran.
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1 Position des tabulations
 Si vous souhaitez modifier la position d’une tabulation de la liste (2), il vous suffit de modifier ce chiffre, puis de

cliquer sur le bouton “ Déplacer ” (8) pour amener la tabulation à son nouvel emplacement.
2 Cette liste reprend toutes les tabulations présentes dans la barre de tabulation.
3 Type
 Cette liste vous permet de sélectionner l’alignement de la tabulation.
4 Vous pouvez indiquer la distance appliquée aux tabulations standard.
5 Vous pouvez indiquer la distance de mise en retrait de la première ligne.
6 Vous pouvez indiquer la distance de mise en retrait du paragraphe.
7 Ajouter
 Si vous avez introduit un chiffre au niveau de “ Position de tabulation ” (1), vous pouvez ajouter la tabulation à

la liste à l’aide de ce bouton.
8 Déplacer
 Vous pouvez déplacer une tabulation existante.
9 Supprimer
 Vous pouvez supprimer la tabulation sélectionnée de la liste.

10 Tout supprimer
 Cette option vous permet de supprimer toutes les tabulations de la liste.

11 “ OK ”
 Ce bouton vous permet d’appliquer toutes les modifications à la barre de tabulation, puis de fermer la boîte de

dialogue.
12 Annuler

 Ce bouton vous permet de fermer la boîte de dialogue sans appliquer les modifications qui y ont été
introduites.

Placer du texte en cercle
P l a c e r  d u  t e x t e  e n  c e r c l e  

Cette opération est entièrement maîtrisable à l’écran. Pour placer du texte en cercle, commencez par dessiner un
cercle. Celui-ci doit être un objet. Si vous transformez ce cercle en courbe, vous ne placez pas du texte sur un cercle,
mais sur un chemin. Il n’est donc pas question ici de la forme (les ellipses sont possibles), mais plutôt des propriétés
de l’objet (obligatoirement un cercle objet). Sélectionnez le texte à placer en cercle, puis cliquez une fois sur le
bouton droit de la souris. Sélectionnez l’option “ Placer texte sur chemin ” dans le menu contextuel qui s’affiche à
l’écran.
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Après avoir sélectionné l’option “ Placer texte sur chemin ”, cliquez sur le cercle à l’aide de la souris. Le texte se place
alors sur le cercle. 

Le cercle est devenu invisible. Il reste lié au texte aussi longtemps que l’objet est un “ texte placé sur un cercle ”.  Si
vous souhaitez modifier le rayon de l’objet, il vous suffit d’activer l’outil de glissement de la barre d’outil, puis de
sélectionner l’objet à l’aide de cet outil. Pour rendre le cercle visible, vous devez avant toute chose sélectionner le
texte à l’aide de l’outil de glissement.

Dans le cas d’un texte placé sur un chemin, vous pouvez modifier le chemin à l’aide de l’outil de glissement, puis faire
glisser le texte sur le chemin.

Pour modifier le rayon et la forme du cercle, il vous suffit de faire glisser les nœuds du cercle, la taille du texte
restant inchangée.
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Appuyez sur la touche “ CTRL ” pendant le glissement du nœud droit pour agrandir ou réduire le rayon du cercle. 

Pour réaliser une ellipse horizontale, il vous suffit de faire glisser le nœud inférieur du cercle. Si vous appuyez sur la
touche “ CTRL ” pendant le glissement du nœud droit ou gauche, vous agrandissez ou réduisez le rayon de l’ellipse
sans modifier sa forme. Si vous appuyez une fois sur la touche “ Shift ” pendant le glissement, vous transformez
l’ellipse en cercle.

Pour faire une ellipse verticale, il vous suffit de faire glisser le nœud droit du cercle. Si vous appuyez sur la touche
“ CTRL ” pendant le glissement du nœud droit ou gauche, vous agrandissez ou réduisez le rayon de l’ellipse sans
modifier sa forme. 

Pour transformer le cercle en tarte, il vous suffit de faire glisser le nœud supérieur. Vous pouvez également agrandir
ou réduire le rayon de cette figure sans en modifier la forme : appuyez sur la touche “ CTRL ” pendant le glissement
du nœud droit ou gauche.
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Si vous souhaitez fermer la tarte, il vous suffit de placer le point ouvert sur l’autre point ouvert à l’aide de la touche
“ CTRL ”.

Si vous sélectionnez le point de commande de la première lettre à l’aide de l’outil de glissement, vous pouvez faire
glisser ce point sur le chemin.

Si vous sélectionnez une autre lettre pour la déplacer, son positionnement sera recalculé en fonction du paramétrage
de la boîte de dialogue relative au texte. Supposons que l’emplacement est au centre/au sommet dans l’exemple ci-
dessus.

Le texte sera alors à nouveau modifié en fonction de ce paramètre.

L’exemple figurant ci-dessus constitue une situation extrême. Si vous avez opté pour un positionnement déterminé,
ce positionnement ne sera pas affecté lors d’une éventuelle adaptation de l’interlettrage. Si le positionnement ne
revêt aucune importance ou si vous décidez de tout faire manuellement, vous pouvez sélectionner l’option “ Aligner à
gauche ”, “ Aligner à droite ” ou “ Centrer ”. Si vous avez sélectionné l’un de ces alignements, le positionnement du
texte reste inchangé malgré toutes les modifications.
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Lorsque le texte est placé sur un chemin ou sur un cercle, vous ne pouvez pas le glisser devant son point de départ.
Si le texte est placé sur un cercle – comme dans l’exemple figurant ci-dessus –, vous pouvez placer le texte en haut
et au milieu en le faisant glisser en cercle à une seule reprise.

Texte placé sur un chemin
T e x t e  p l a c é  s u r  u n  c h e m i n  

Le texte placé sur un chemin est comparable à celui placé sur un cercle à de nombreux égards. Les boutons qui vous
permettent de modifier le texte en réalisant les opérations suivantes “ Aligner à gauche ”, “ Aligner à droite ”,
“ Aligner centre ” ou “ Aligner bas ” ne sont pas disponibles. Commencez par sélectionner un chemin, puis
sélectionnez le texte que vous souhaitez placer sur ce chemin à l’aide du bouton droit de la souris. Sélectionnez
l’option “ Placer texte sur chemin ” du menu contextuel qui s’affiche à l’écran.

Sélectionnez le chemin.
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Le texte est alors placé sur le chemin. Une fois le texte placé sur le chemin, vous pouvez déplacer le bloc de texte
complet ou des parties de celui-ci sur ce chemin.

Si vous appuyez sur la touche “ Shift ” pendant le glissement, vous pouvez extraire des caractères de ce chemin,
comme dans le cas d’un texte placé sur un cercle. Cette option est également disponible dans le cas de lignes de
texte normales.

Modification du chemin 
EasySIGN vous permet de modifier les chemins sur lesquels du texte est placé, comme tous les autres chemins
d’ailleurs. Le texte s’adapte au “ nouveau ” chemin à chaque modification.

Modifications générales du texte placé sur un chemin ou sur un cercle
M o d i f i c a t i o n s  g é n é r a l e s  d u  t e x t e  p l a c é  s u r  u n  c h e m i n  o u  s u r  u n  c e r c l e  

Inversion de la direction du chemin 
Sélectionnez le texte placé sur le chemin ou sur le cercle, puis cliquez sur ce texte à l’aide du bouton droit de la
souris.
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Sélectionnez l’option “ Inverser direction du chemin ” du menu contextuel qui s’affiche à l’écran.

Il est également possible de procéder de la sorte lorsque le texte est placé sur un chemin.

Dans l’exemple ci-dessus, les chemins du texte sont visibles par souci de clarté, mais ils ne sont en principe visibles
que lorsque vous utilisez l’outil de glissement.

Pivotement des lettres et du chemin

Sélectionnez le texte placé sur le chemin ou le cercle, puis cliquez sur ce texte à l’aide du bouton droit de la souris.
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Sélectionnez l’option “ Pivoter lettres avec le chemin ” du menu contextuel qui s’affiche à l’écran.

Les lettres conservent leur sens vertical. Il est également possible de procéder de la sorte lorsque le texte est placé
sur un chemin.

Par souci de clarté, le chemin interne est une nouvelle fois visible.

Placement du texte sur le chemin

Par défaut, le texte est placé sur la ligne de base du chemin, mais vous pouvez modifier cette forme d’alignement.
Pour ce faire, sélectionnez l’objet à l’aide du bouton droit de la souris, puis sélectionnez l’option “ Aligner bas ”,
“ Aligner centre ” ou “ Aligner haut ”.
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Ces options sont également disponibles lorsque le texte est placé sur un chemin.

L’option “ Aligner haut ” semble ne pas convenir à première vue, mais les apparences sont trompeuses. Ce
phénomène s’explique par le fait que pour cette option, il convient de prendre en compte la forme de certains signes,
comme la lettre majuscule “ E ” surmontée d’un accent circonflexe.

Rétablir le texte 
Si votre texte est placé sur un chemin ou sur un cercle ou si vous avez extrait de la ligne de base des caractères de
ce texte à l’aide de la touche “ Shift ”, vous pouvez rendre à ce texte sa forme originale.

Retirer du texte d’un chemin 
Cette option vous permet de faire un texte ordinaire d’un texte placé sur un chemin. Le chemin reprend son aspect
initial d’objet isolé.

Crénage et ajustement de l’interlignage avec l’outil glisser
C r é n a g e  e t  a j u s t e m e n t  d e  l ’ i n t e r l i g n a g e  a v e c  l ’ o u t i l  g l i s s e r

Crénage par glissement
Situation au départ :
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Pour ajuster le crénage, commencez par sélectionner le texte avec l’outil glisser. Deux points de contrôle
apparaissent :

Le point de contrôle droit sert à ajuster le crénage du texte.

Faites glisser ce point de contrôle pour changer le crénage des caractères et des blancs. Pour ne modifier que
l’espacement entre les mots, maintenez la touche Maj enfoncée pendant le glissement. 
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Augmentez le crénage en faisant glisser le point de contrôle vers la droite, et diminuez-le en faisant glisser le point de
contrôle vers la gauche. Vous pouvez aussi ajuster le crénage d’un texte auquel a été appliqué une rotation ou une
distorsion. 

Déplacement de l’interlignage
Pour augmenter l’interlignage, faites glisser le point de contrôle de gauche vers le bas ; pour diminuer cette distance,
faites-le glisser vers le haut.
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Crénage et ajustement de l’interlignage pour le chemin et l’arc
C r é n a g e  e t  a j u s t e m e n t  d e  l ’ i n t e r l i g n a g e  p o u r  l e  c h e m i n  e t  l ’ a r c

Les mêmes possibilités existent quand le texte est à placer sur un chemin ou sur un arc. La fonction d’interlignage
sert alors à ajuster la distance au chemin ou à l’arc.

Crénage par glissement
Sans la touche Maj.

Avec la touche Maj.

Interlignage par glissement
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Après avoir ajusté l’interlignage, vous pouvez valider cette distance en choisissant, avec le bouton droit de la souris,
“ Alignement bas ”, “ Alignement centre ” ou “ Alignement haut ”.

Sélection et modification de caractères
S é l e c t i o n  e t  m o d i f i c a t i o n  d e  c a r a c t è r e s

Vous pouvez modifier la couleur de plusieurs caractères en même temps, n’importe où dans le texte, en vous servant
de l’outil glisser. Supposons que vous vouliez faire passer en rouge tous les nombres du texte ci-dessous. Procédez
comme suit :

A l'aide de l’outil glisser, sélectionnez chaque caractère en cliquant sur son point d’origine ou en faisant glisser un
rectangle de sélection sur les caractères. Vous pouvez maintenant affecter une couleur au caractère sélectionné. 
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Dans les versions précédentes, quand vous déplaciez un caractère, vous déplaciez aussi les autres caractères. Il
n’était pas possible de déplacer un caractère à la fois ou de déplacer d’autres caractères à différents endroits du
texte. C’est maintenant possible. Vous pouvez toujours employer la méthode précédente, c’est à dire en sélectionnant
l’origine du caractère à déplacer et en le faisant glisser immédiatement, sans relâcher le bouton de la souris. Le reste
de la ligne de texte suit alors. Pour ne déplacer qu’un caractère, lâchez le bouton de la souris et sélectionnez de
nouveau le caractère : vous ne déplacez alors que le caractère sélectionné. Si vous sélectionnez plus d’un caractère,
tous les caractères sélectionnés seront déplacés.

Cliquer et faire glisser un caractère

Sélectionner plusieurs caractères



209EasySIGN

Cliquer, cliquer et faire glisser un caractère

Exceptions
Les choses sont différentes quand vous déplacez des caractères dans un texte comportant des  tabulations.

Dans les exemples précédents, en faisant glisser le point de contrôle, vous déplaciez aussi les caractères placés
après le caractère sélectionné.

Mais notre texte contient des tabulations et le caractère suivant ne peut être déplacé que si la position de la tabulation
suivante est atteinte. Le caractère suivant est maintenant déplacé à la tabulation suivante.

Paramétrages du texte
P a r a m é t r a g e s  d u  t e x t e

Vous pouvez consulter les paramètres par défaut du texte (taille des exposants ou des indices, etc.) dans
“ Affichage ”, “ Paramètres ”, onglet :  “ Texte ” :
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1 Les unités de texte sont toujours en points
Quels que soient les paramètres définis pour les unités, le texte est toujours mesuré en points.

2 Relier l’interlignage au corps de la police
Quand, dans l’éditeur de texte, vous choisissez une taille de caractère pour la police, l’interlignage s’ajuste
automatiquement.

3 Distance de tabulation par défaut
Les tabulations sont placées automatiquement avec un intervalle donné.  Si vous introduisez une tabulation
dans un texte, sans définir sa position, le paramètre par défaut s’applique.

4 Taille des petites majuscules
La valeur applicable pour la taille des petites majuscules est un pourcentage de la taille de la police d’origine.

5 Position de l’indice
L’indice est placé selon une valeur en pourcentage par rapport à la ligne de base du texte.

6 Taille de l’indice
La taille de l’indice est un pourcentage du corps de la police d’origine.

7 Position de l’exposant
Mesurée à partir de la ligne de base du texte et exprimée en pourcentage.

8 Taille de l’exposant
La taille de l’exposant est un pourcentage du corps de la police d’origine.

9 Restaurer les valeurs par défaut
Rétablit les paramètres par défaut définis lors de la première installation du logiciel.

Les paramètres 4 à 8 s’appliquent à tout le texte nouvellement entré. Le texte saisi dans les feuilles de travail
existantes reste tel quel.
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Orientation du texte
O r i e n t a t i o n  d u  t e x t e

Le menu “ Texte ”, “ Orientation du texte ”, “ Vertical ” affiche le texte sélectionné de haut en bas au lieu de gauche à
droite :

Dans un texte vertical, la “ ligne suivante ” est placée à la gauche de la ligne courante.

L’espacement et l’interlignage peuvent être définis avec l’éditeur de texte ou avec l’outil glisser.

Importation de texte
I m p o r t a t i o n  d e  t e x t e

Vous pouvez maintenant importer des fichiers avec l’extension “ .txt ”.  Cette importation est limitée à 1 000
caractères par importation.  Si vous importez un fichier texte contenant plus de 1 000 caractères, seuls 1 000
caractères sont importés.

Crénage ajustable
C r é n a g e  a j u s t a b l e

Le crénage définit la distance entre deux caractères. Vous pouvez régler la distance en faisant glisser le point
d'origine avec l'outil glisser.



212 EasySIGN

Ce crénage est actif uniquement pour le caractère ajusté dans le bloc de texte actif. Vous pouvez également
enregistrer ce crénage dans une police. Une fois enregistré, ce crénage sera appliqué à tout nouveau texte entré
avec ce type de police. Vous avez effectivement enregistré une paire de crénage : distance entre deux caractères.

Comment ?

Tapez un texte avec les paires de crénage que vous souhaitez ajuster et sélectionnez le texte à l'aide de l'outil de
sélection.

Sélectionnez ensuite dans le menu la commande "Texte, Crénage, Modifier le crénage”. Le Gestionnaire d'objets
apparaît (s'il n'est pas déjà ouvert) et le pointeur se transforme en curseur de déplacement.

Faites glisser le point d'origine d'un caractère vers un autre emplacement.

Dans le Gestionnaire d'objets, le nom de la police, la paire de crénage et sa valeur ajustée s'affichent.
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Lorsque vous appuyez sur "Appliquer", le réglage est enregistré dans le tableau de crénage.

Pour chaque nouveau texte, la paire de crénage ajustée sera utilisée à la place de celle qui est intégrée à la police
d'origine. La police d'origine reste inchangée.

 
Appliquer
Enregistre tous les ajustements effectués.

 
Retirer
Retire une paire de crénage du tableau de crénage.

 
Retirer tout
Efface tout le tableau de crénage.

 
Applique le crénage aux blocs de texte sélectionnés.

 
Applique le crénage à tout le texte de la feuille de travail en cours.
Le texte des groupes et les effets sont aussi inclus.

Lorsque vous ouvrez des feuilles de travail qui contiennent déjà des blocs de texte, les paires de crénage ajustées ne
sont pas appliquées automatiquement. Lorsque vous voulez appliquer des paires de crénage ajustées aux blocs de
texte existants, vous devez le faire manuellement en sélectionnant la commande “Texte, Crénage, Réinitialiser tous
les crénages”. Les nouvelles paires de crénage s'appliqueront automatiquement au nouveau texte que vous entrerez.

Fractionnement du texte
F r a c t i o n n e m e n t  d u  t e x t e

Vous pouvez fractionner un texte en différents éléments : 

lignes
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mots

caractères

Pour exécuter l'une des actions ci-dessus, sélectionnez "Texte, Fractionnement du texte, …".

Fusion du texte
F u s i o n  d u  t e x t e

Vous pouvez sélectionner des caractères, des mots ou des lignes pour les fusionner en un seul bloc de texte. Tous les
objets texte sélectionnés seront placés l'un à la suite de l'autre. Le dernier objet texte sélectionné est l'espace
réservé et devient la première partie de texte du nouveau bloc de texte. L'ordre des autres objets texte sélectionnés
sera conforme à celui de la feuille de travail. 

Dans l'exemple ci-dessous, la lettre noire "A" est le dernier objet sélectionné.

Pour fusionner un texte sélectionné, sélectionnez "Texte, Fusion du texte".



215EasySIGN

Correcteur orthographique
C o r r e c t e u r  o r t h o g r a p h i q u e

Options du correcteur orthographique

Si vous utilisez le correcteur orthographique pour la première fois, vous devez effectuer certains réglages.
Sélectionnez “Texte, Orthographe, Options du correcteur orthographique”.

1 Options du correcteur orthographique
Vous pouvez ici définir des exceptions, par exemple, ignorer les mots en lettres capitales.

2 Langue du dictionnaire principal 
Vous pouvez ici sélectionner la langue à utiliser pour l'exécution du correcteur orthographique.

3 Suggestions
Vous pouvez ici définir l'équilibre entre la vitesse et la précision.

Lexiques

Des lexiques peuvent être créés pour une langue spécifique ou pour toutes les langues. Vous pouvez créer ici votre
propre lexique de mots souvent mal orthographiés ou ajouter des mots absents des lexiques fournis. Sélectionnez
“Texte, Orthographe, Adapter les lexiques"



216 EasySIGN

Dans le champ “Mots” (1), vous pouvez ajouter un mot pour lequel vous souhaitez que le correcteur orthographique
effectue une action spécifique. Dans le champ "Autre mot” (2), vous pouvez entrer le résultat souhaité. Avec
“Action” (3), vous pouvez sélectionner l'action à effectuer lorsque le correcteur orthographique trouve ce mot. Par
exemple, vous pouvez choisir que le mot soit toujours remplacé ou, au contraire, toujours ignoré. Avec “Fichiers” (4),
vous pouvez sélectionner le lexique dans lequel vous souhaitez ajouter le mot.

Correction orthographique

Si vous avez sélectionné un texte, seule l'orthographe du texte sélectionné sera vérifiée, sinon le correcteur
orthographique sera passé sur tout le document.

Sélectionnez “Texte, Orthographe, Vérification de l'orthographe” ou appuyez sur la touche de raccourci “F7”.

Les erreurs d'orthographe seront sélectionnées dans la boîte de dialogue et dans la feuille de travail.
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1 Vous pouvez visualiser ici les erreurs trouvées par le correcteur orthographique.
2 La suggestion est affichée ici. Vous pouvez taper une autre suggestion ou en sélectionner une dans la liste ci-

dessous.
3 Liste incluant d'autres suggestions.
4 Ignorer permet d'ignorer la suggestion et de passer à l'erreur d'orthographe suivante. Si vous souhaitez

ignorer tous les mots similaires, appuyez sur le bouton situé à côté de celui-ci.
5 Modifier permet de remplacer l'erreur d'orthographe par la suggestion. Si vous souhaitez que tous les mots

similaires soient modifiés, appuyez sur le bouton situé à côté de celui-ci.
6 Si vous souhaitez ajouter au lexique une erreur d'orthographe fréquemment rencontrée (ce n'est pas une

erreur à proprement parler mais elle ne figure pas dans le lexique en cours), vous pouvez appuyer sur ce
bouton.

7 Si vous avez ajouté votre propre suggestion dans le champ “Remplacer par” (2), appuyez sur ce bouton pour
demander au programme de suggérer d'autres mots similaires à votre suggestion.

8 Le lexique en cours.
9 Vous pouvez ouvrir ici la boîte de dialogue Option, la boîte de dialogue relative au lexique ou fermer cette boîte

de dialogue et terminer le passage du correcteur orthographique.

Statistiques concernant le texte
S t a t i s t i q u e s  c o n c e r n a n t  l e  t e x t e

Dans le menu, sélectionnez "Texte, Statistiques concernant le texte" pour ouvrir une boîte de dialogue qui affiche le
nombre de mots, de lignes, de caractères, etc. d'une feuille de travail.
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Cette boîte de dialogue affiche le nombre d'éléments suivants :

objets texte ;
mots ;
unités (incluant les espaces) ;
unités (sans les espaces) ;
lignes.

Insertion de symboles
I n s e r t i o n  d e  s y m b o l e s

Pour insérer des symboles et des caractères spéciaux, vous devez placer le caret (signe d'insertion) dans un bloc de
texte et sélectionner dans le menu contextuel l'option "Insérer, Symbole".

Dans cette boîte de dialogue, vous pouvez sélectionner une police et le caractère ou le symbole souhaités.
Sélectionnez le bouton "OK" pour insérer le symbole ou sélectionnez le bouton "Insérer" pour ajouter plusieurs
symboles.

Text Merge
T e x t  M e r g e

The function Text Merge is an advanced way to automate tedious jobs like creating hundreds of name tags. When you
have a job to create several nametags, container labels, stickers, engraving plates etc. you will normally get a list or
database file to use as a source from your customer. Normally this source would be a .CSV file (semicolon, tab or
comma delimited text), typically a .CSV file would look like this:
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surname;name;occupation
Smith;Ethan;Art Director
Johnson;Emily;Account Executive
Williams;Noah;Marketing manager
Brown;Emma;Sales manager
Jones;Joshua;Graphic designer
García;Madison;Graphic designer
Davis;Liam;Graphic designer
Martínez;Sarah;Graphic designer

The first row would contain the "field" names where as the rest of the file contains the values for that field names. You
could say that a .CSV is a simplified database table. If you would display the sample .CSV file above as a database
table it would look like this:

surname name occupation

Smith Ethan Art Director

Johnson Emily Account Executive

Williams Noah Marketing manager

Brown Emma Sales manager

Jones Joshua Graphic designer

García Madison Graphic designer

Davis Liam Graphic designer

Martínez Sarah Graphic designer

The Text Merge function doesn't stop at text alone, it is possible to use any design containing text, artwork and even
images to create hundreds of different results within minutes. Say for example we have to make some name badges
containing the names of the people from the .CSV example above together with their photo's. This would normally be
a tedious job, especially when there are hundreds of name badges to make instead of the only eight in the sample .
CSV file. 

For implementing the photo's of the people on the name badges we would not only need (of course) their photo's but
we also have to edit the .CSV file to make the software aware of the photo's and where to find these photo's. Their
will also be times you don't receive a .CSV file from you customer and have to create a .CSV file from scratch. For
these reasons we have created a separate software in the "Helpers" range to make these kind of jobs easier.

To find out the best possible way for this workflow and to learn the Text Merge functions we refer to the help file of
the "esHelperCSV" software. The help file of this "Helper" software contains all the information you need to edit and
create .CSV files and how to use them in the EasySIGN Text Merge function.

To get started do the following. In EasySIGN select the menu "File > Run Helpers > esHelperCSV", this will start the
"esHelperCSV" software. 

In the "esHelperCSV" software select the menu "Help > Help" to start the help file and follow the instruction in this
help file to learn about .CSV files and the usage of the EasySIGN Text Merge function.

Ombre

Comme la plupart des effets spéciaux dans EasySIGN, les ombres sont déterminées par l’objet. Tant que vous ne transformez pas une

ombre en courbes (par exemple, pour des réglages précis), vous pouvez définir les propriétés ou même supprimer la totalité de l’effet pour

revenir à vos objets d’origine. Les propriétés d’un effet d’ombre peuvent être définies par le biais d’un outil de déplacement ou de la boîte de

dialogue des propriétés. 
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Application d’une ombre

Sélectionnez au hasard un objet vectoriel, un texte, un bitmap, un effet, un groupe ou une combinaison de ces objets.

Perspective

Sélectionnez ensuite le type d’ombre souhaité dans le menu « Effets, Ombre ». Dans les exemples ci-dessous, nous avons utilisé une

perspective. La procédure est la même pour les autres types d’ombre.

L’outil de déplacement devient actif  et un aperçu de l’ombre apparaît à l’écran. Vous pouvez ajuster tous les nœuds visibles à l’aide de l’outil

de déplacement pour modif ier la forme.

L’ombre sera recalculée si vous appuyez sur « Echap » ou que vous cliquez sur le bouton « Sélectionner l’outil » dans la barre d’outils.
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Pour modif ier la forme de la perspective, il est inutile de supprimer l’ombre et d’en ajouter une nouvelle à partir du menu. Il suff it d’aff icher les

propriétés d’une ombre via son menu contextuel, puis de modif ier le type d’ombre.

5 Type d'ombre

La boîte de dialogue aff ichant le type d’ombre actuellement sélectionné s’ouvre.

A Normal
L’ombre se prolonge derrière l’objet.
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B Superposer
L’ombre se prolonge en partie derrière l’objet.

L’option « Superposer » (1) devient active. Vous devez d’abord spécif ier une distance pour que la

superposition soit visible.

C Blanc
Un blanc supplémentaire est ajouté entre l’objet d’origine et l’ombre. Vous pouvez également entrer une

valeur pour « Superposer » (1) afin de voir le résultat.

D Cadre supplémentaire original
Un cadre supplémentaire est ajouté autour de l’objet d’origine et la taille de l’ombre est basée sur l’objet

d’origine.

Vous pouvez également entrer une valeur pour « Superposer » (1) afin de voir le résultat.

E Cadre supplémentaire ombre
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Un cadre supplémentaire est ajouté autour de l’ombre f inale et la taille de l’ombre est basée sur l’objet

d’origine.

Vous pouvez également entrer une valeur pour « Superposer » (1) afin de voir le résultat.

4 Permet de définir le style de trait de l’objet d’origine et de l’ombre. Si vous définissez le style de trait ici, plutôt que sur

la feuille de travail, celui-ci sera appliqué à tous les objets d’origine.

3 Si le type d’ombre sélectionné présente un point de f in, vous pouvez le définir ici par une valeur numérique.

2 Permet de définir la couleur du style de trait et le style de remplissage des objets et de l’ombre. Si vous définissez la

couleur du style de trait et le style de remplissage ici, plutôt que sur la feuille de travail, ces styles seront appliqués à

tous les objets d’origine.

1 Permet de définir la profondeur, l’angle et la superposition de l’ombre sélectionnée.

Bloc d’ombre

A

B
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C

D

E

Empreinte

A
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B

C

D

E

Ombrage
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A

B

C

D

E
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Effets spéciaux

EasySIGN vous permet d’appliquer des effets non seulement aux bitmaps, mais aussi aux vecteurs. Toutes les formes
ou presque peuvent être attribuées aux objets vecteurs ou aux groupes d’objets les plus complexes. Ces effets
peuvent en outre être superposés. Vous pouvez superposer des effets à l’infini et même créer votre propre effet. Il
est possible d’extraire un effet attribué à un objet et de retrouver la forme originale de l’objet. Si vous désirez
appliquer un effet définitivement dans le but de réaliser d’autres modifications ou finitions, il vous suffit d’utiliser
l’option “ Courbes ” du menu “ Traiter ”, “ Convertir en ”. Cette option vous permet de transformer l’objet en courbes
adaptables.

Application d’un effet 

Sélectionnez ou tapez un texte.

Sélectionnez ensuite l’option “ Effets spéciaux ” du menu “ Effets ”. EasySIGN applique alors le dernier effet utilisé à
l’objet et passe directement en mode d’outil de glissement. L’objet se présente alors sous la forme suivante.

Les boutons de réglage se trouvent au-dessus de l’objet. Ils vous permettent de modifier la forme de l’objet de
manière interactive.

Chaque bouton de réglage modifie l’une des parties de l’effet. Le nombre de boutons de réglage dépend du nombre
de paramètres supportés par l’effet utilisé. Si vous souhaitez appliquer l’effet, il vous suffit de sélectionner l’outil de
sélection ou d’appuyer sur la touche “ Tab ”.
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Si vous souhaitez adapter l’effet, sélectionnez l’objet, puis cliquez sur le bouton droit de la souris. Sélectionnez
ensuite l’option “ Propriétés ” du menu contextuel qui s’affiche à l’écran.

La boîte de dialogue apparaît alors à l’écran.



229EasySIGN

La boîte de dialogue présente l’effet appliqué et les paramètres y afférents (3). La liste de gauche reprend tous les
effets disponibles. La boîte de dialogue contient une fenêtre d’exemple (2) qui vous permet de visualiser rapidement
les modifications que vous introduisez dans la boîte de dialogue. Chaque modification d’un paramètre est reproduite
simplement dans cette fenêtre. Si vous souhaitez voir l’effet dans sa forme finale, il vous suffit de cliquer sur le
bouton “ Appliquer ” (4). L’effet apparaît alors à l’écran.
Sélectionnez à présent un autre effet. Cliquez ensuite sur le bouton “ Appliquer ” (4), puis sur le bouton
“ Fermer ” (5).

Il convient maintenant de dimensionner l’objet de manière verticale afin de montrer que chaque nouvelle
transformation constitue un élément utile de l’effet.

Sélectionnez l’outil de glissement afin de faire apparaître les paramètres de cet effet.
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Cet effet ne nécessite qu’un seul paramètre. Glissez le bouton de réglage à l’aide de l’outil de glissement jusqu’à
obtention du résultat voulu.

Vous pouvez maintenant superposer un autre effet à cet effet. Pour ce faire, sélectionnez l’option “ Déformations ” du
menu “ Effets ”.

Vous pouvez supprimer chaque effet appliqué séparément. Pour ce faire, sélectionnez l’objet à l’aide du bouton droit
de la souris, puis cliquez sur l’option “ Supprimer effet ”. Vous pouvez éliminer tous les effets appliqués pour revenir à
la forme originale de l’objet. Si vous souhaitez rendre l’effet définitif, sélectionnez l’option “ Courbes ” du menu
“ Traiter ”, “ Convertir en ”.

Lignes de dimension

Dans EasySIGN, les lignes de dimension sont réellement orientées objet. Chaque modification de taille ou de forme
est directement appliquée dans les étiquettes des lignes de dimension. Les lignes de dimension doivent être
sélectionnées ou groupées avec l’objet. Toutes les propriétés des lignes de dimension sont modifiables par
l’intermédiaire d’une boîte de dialogue spéciale.

Application d’une ligne de dimension 
Sélectionnez un objet, puis activez l’option “ Lignes de dimension ” de la barre d’outils.
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Le curseur se présente alors sous la forme suivante.

A l’aide de ce curseur, sélectionnez l’un des points que vous souhaitez mesurer. Cliquez ensuite sur ce point avec la
souris.

Déplacez ensuite la souris (bouton enfoncé) et amenez-la sur le point suivant avant de cliquer sur ce point.

Relâchez le bouton de la souris, puis déplacez la “ flèche ” en fonction de la distance à laquelle vous souhaitez placer
la ligne de dimension.

Relâchez le bouton de la souris. Une ligne de dimension se positionne alors à cet endroit, la dimension apparaissant
dans ce que l’on appelle une étiquette.
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Sélectionnez la ligne de dimension et l’objet. La reproduction de l’étiquette s’adapte alors automatiquement à la
nouvelle mesure.

Modification des lignes de dimension 
Il est possible d’apporter les modifications directement à l’écran par l’intermédiaire d’une boîte de dialogue spéciale
ou à l’aide du bouton droit de la souris. Pour adapter directement la ligne de dimension à l’écran, il vous suffit
d’activer l’outil de glissement. Cet outil vous permet de sélectionner l’un des points de commande de la ligne de
dimension, puis de le modifier.

Lorsque vous faites glisser un point de commande au niveau de l’extrémité d’une flèche, vous pouvez incliner la ligne
de dimension. Pour ce faire, il vous suffit d’appuyer sur la touche “ Shift ” pendant le glissement.
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Dans le cas de lignes de dimension obliques, l’angle est repris.

Cliquez sur une ligne de dimension sélectionnée à l’aide du bouton droit de la souris pour faire apparaître un menu
contextuel. Ce menu comprend plusieurs options directes qui vous permettent notamment de modifier l’unité de
mesure utilisée dans la ligne de dimension. L’option “ Propriétés ” de ce menu vous permet de faire apparaître la
boîte de dialogue suivante à l’écran.

1 Hauteur de texte
 Vous pouvez indiquer la taille du texte.
2 Police
3 Texte fixe
 Cette option vous permet d’indiquer au niveau de “ Texte étiquette ” (4) le texte qui doit apparaître au lieu du

texte calculé automatiquement.
4 Texte étiquette
 Vous pouvez indiquer votre propre texte d’étiquette.
5 Unités identiques à celles de la feuille de travail 
 Si vous activez cette option, l’unité sera couplée à celle de la feuille de travail.
6 Unités de mesure spécifiques
 Si vous activez cette option, l’unité choisie sera toujours utilisée pour l’étiquette, quelle que soit l’unité de la

feuille de travail.
7 Précision
 Vous pouvez sélectionner le nombre de décimales utilisées pour représenter la mesure.
8 Vous pouvez indiquer la forme de la flèche.
9 Etiquette horizontale
 Si vous activez cette option, l’étiquette est systématiquement représentée à l’horizontale, quel que soit l’angle
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de la ligne de dimension.
10 Afficher unités dans texte étiquette

 Si vous activez cette option, les unités utilisées sont également reprises dans l’étiquette.
11 Appliquer

 Ce bouton vous permet d’appliquer le paramétrage et de l’afficher directement sur la feuille de travail
12 Fermer

 Ce bouton vous permet de fermer la boîte de dialogue.

Cadres sarclois

Les cadres sarclois sont utilisés pour faciliter l’élimination du vinyle excédentaire lors de la découpe. A l’écran, les
lignes de cadre peuvent traverser le texte et/ou l’image, mais sont uniquement coupées dans le vinyle excédentaire
lors du traçage. Pour le texte, la ligne est coupée entre les lettres et non sur les lettres. Les contours intérieurs des
lettres ne sont bien entendu pas découpés.

Ajouter un cadre sarclois 
Il existe deux procédures différentes pour ce faire. Vous pouvez le faire manuellement en sélectionnant l’option
“ Cadres sarclois ” dans la barre d’outils.

Le curseur se présente alors sous la forme suivante.

Procédez comme si vous souhaitiez tracer un rectangle pour placer le cadre sarclois autour de l’objet voulu.

Vous avez dessiné le cadre, il vous reste maintenant à ajouter des lignes de découpe. Pour ce faire, il vous suffit de
sélectionner l’outil de glissement. Le cadre sarclois se présente alors sous la forme suivante.

L’outil de glissement vous permet de faire glisser les lignes de cadre à partir des renflements des lignes horizontales
et verticales.

Si vous activez une nouvelle fois l’outil de sélection, vous pouvez faire apparaître la boîte de dialogue suivante en
cliquant sur le bouton droit de la souris. Sélectionnez ensuite l’option “ Propriétés ”.
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1 Marge contour
 Il s’agit de l’espace situé entre la partie extérieure de l’objet à tracer et le cadre sarclois.
2 Marge des lignes de cadre
 Il s’agit d’une marge de sécurité paramétrable pour la découpe d’objets.

 Lignes de cadre horizontales et verticales
3 Aucun
 Aucune ligne de cadre n’est dessinée.
4 Tous
 Les lignes de cadre sont dessinées à une distance paramétrable.
5 Réglable individuellement
 Toutes les lignes de cadre sont paramétrables séparément.
6 Les lignes de cadre sélectionnées dans la liste sont affichées. Les lignes de découpe existantes peuvent être

modifiées et de nouvelles lignes peuvent être introduites.
7 Toutes les lignes de cadre sont affichées.
8 Déplacer
 Vous pouvez déplacer une ligne de cadre existante.
9 Ajouter
 Vous pouvez ajouter une nouvelle ligne de cadre.

10 Supprimer
 Vous pouvez supprimer une ligne de cadre existante.

Vous pouvez également ajouter des cadres sarclois et des lignes de cadre à des objets sélectionnés par
l’intermédiaire d’une boîte de dialogue. Sélectionnez un objet, puis activez l’option “ Insérer cadre sarclois autour de
la sélection ” du menu “ Insérer ”, “ Production ”. La boîte de dialogue suivante s’affiche alors à l’écran. 
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1 Marge contour
 Il s’agit de l’espace entre la partie extérieure de l’objet à tracer et le cadre sarclois.
2 Marge de lignes de cadre
 Il s’agit d’une marge de sécurité paramétrable pour la découpe d’objets.

 Horizontal
3 Aucune 
 Aucune ligne de cadre n’est dessinée.
4 Tous
 Les lignes de cadre sont dessinées à une distance paramétrable.
5 Entre les lignes
 Une ligne de cadre peut être introduite entre les lignes si vous avez sélectionné du texte.
6 Dans les lignes
 Les lignes de cadre sont placées dans les lignes de texte.
7 Entre et dans les lignes
 Les éléments 5 et 6 sont appliqués simultanément.

 Vertical
8 Aucun
 Aucune ligne de cadre n’est dessinée.
9 Tous
 Les lignes de cadre sont dessinées à une distance paramétrable.

10 OK
 Ce bouton vous permet d’appliquer tous les paramètres et de fermer la boîte de dialogue.

11 Annuler
 Ce bouton vous permet de fermer la boîte de dialogue sans appliquer les paramètres que vous y avez

introduits.
12 Valeurs par défaut

 Ce bouton vous permet de restaurer toutes les valeurs par défaut dans la boîte de dialogue.

Modifications du cadre sarclois
Vous pouvez apporter des modifications au cadre sarclois et aux lignes de cadre directement à l’aide de l’outil de
glissement.

Si vous faites glisser l’un des points de contrôle extérieurs, vous pouvez modifier la marge du contour.
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Si vous faites glisser l’un des points de contrôle extérieurs, vous pouvez déterminer la position et le dimensionnement
par rapport à l’objet.

Vous pouvez déplacer des lignes de cadre déjà positionnées à l’aide de l’outil de glissement. Vous pouvez également
déplacer les lignes de cadre. Pour ce faire, il vous suffit de les faire glisser pour les ramener dans les renflements des
lignes verticales et horizontales.

Imbrication de blocs

L'imbrication de blocs est un effet rapide et facile à appliquer qui réorganise les objets aussi efficacement que
possible pour économiser de la matière. Cet effet est orienté objet et, même après son application, vous pouvez
toujours ajouter des objets ou revenir à l'état d'origine des objets. 

Sélectionnez "Effets, Imbrication de blocs" pour appliquer l'effet à une plage d'objets sélectionnés.
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Un objet de contrôle apparaît autour des objets sélectionnés. En faisant glisser les points de contrôle, les objets se
réorganisent aussi efficacement que possible dans les proportions de largeur et de hauteur de l'objet de contrôle.

Faites glisser les points de contrôle jusqu'à ce que vous soyez satisfait de la réorganisation des objets.
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Si vous pensez qu'il est possible d'améliorer le résultat, sélectionnez "Propriétés" dans le menu contextuel de l'effet.
Dans la boîte de dialogue qui s'affiche, vous disposez des options suivantes pour optimiser le résultat :

1 Sélectionnez la direction que vous souhaitez modifier.
2 Choisissez classique ou optimale. L'option Optimale donne de meilleurs résultats mais elle est plus lente. 
3 Vous pouvez définir ici la taille horizontale ou verticale.
4 Vous pouvez définir ici l'espace entre les objets. Les images ci-dessus utilisent un espace de 2 mm, l'image ci-

dessous, un espace de 0 mm.

5 Vous pouvez choisir ici de fractionner le texte en lignes, mots, caractères ou de ne pas fractionner le texte. Le
texte reste tel quel, si vous supprimez l'effet Imbrication de blocs, le texte revient à l'état qui était le sien avant
l'application de l'effet.

6 Cette option permet de faire pivoter les objets pour obtenir un meilleur résultat. Pour obtenir un résultat
optimal, vous devez utiliser un grand nombre d'objets sans insérer d'espace entre eux.
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True shape nesting

'True shape nesting' is an automated method of minimizing material usage. ‘True shape nesting’ places objects
together with minimal space between them. Using this functionality is cost efficient and environmental friendly. For
example, the objects on the worksheet below are placed by using the 'Multiply' functionality.

 

Compare this placement to the placement automatically generated with 'True shape nesting' as shown below.
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For some objects the media cost reduction can be even far greater, for example:

Manual or other automated placement
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As you can see 'True shape nesting' saves almost 50% of the media cost.

Workflow

Using 'True shape nesting' is simple and straight forward. Before you can start using 'True shape nesting' you need to
know how to apply the object specifications.

Preparing the objects to be nested

'True shape nesting' requires the objects you want to nest to meet a certain specification. An object ready for 'True
shape nesting' needs to be enclosed in a 'Sticker contour' with the option 'Connect' checked.

Why do you need the option connect checked?
For example see the object below with a 'Sticker contour' applied. For clarity the 'Sticker contour' is represented by a
red line.

At first glance there seems to be noting wrong with this situation but if you want to start the 'True shape nesting', with
50 duplicates of the object, you will get the following error message. 
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Som e objects could not be  p laced. No unique  cutline  de fined fo r 50 objects. 

A unique cutline is a continuous line surrounding each of the objects you want to nest. The object used is one object
that consists of 3 words with spaces between them. The so called 'cutline' consists of tree separated cutline's, one for
each word. You could of course enlarge the distance of the 'Sticker contour' to the object until the lines meet, but that
would not be the best option in this case, see the image below. 

The white space surrounding the object is much larger then was intended (or even required by the customer). It is
much easier and more consistent to let the software try to optimize this object by checking the option 'Connect' in the
'Sticker contour' dialog. Checking this option will give you the following result.

If you think this option will take too much extra space/media after the nesting command, you can also make some
adjustments too the object, for example by quickly closing the gaps between the words.

Remove the 'Sticker contour' from the object (if
any).

Draw some simple shapes to close the gaps, pen
style or color is not important.
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With the new objects still selected, select the
menu 'Ed it > Conv e rt to ' > Line  ty pe  > S ign
Bla nk'. 'Sign Blank' is a line type that isn't
printed or cut, so this is a invisible object for any
kind of output.

Select the original object including the new
objects and group them together.

Select the menu 'Effe cts  > Sticke r  contour'
and apply the 'Sticker contour' to the group.

The actual workflow

You can subdivide the workflow in two scenarios, a scenario in which you have one object that needs to be duplicated
multiple times and then nested and a scenario in which you have many different objects that need to be nested. 

One object multiple times

1 Import or open the object you want to use.

2 Adjust the page size to the size of your media using the menu 'Vie w > Se ttings'. 

3 Prepare the object like described in the chapter above 'Preparing the objects to be nested'.

4 Multiply the objects using the menu 'Arra nge  > Multip ly '. Enter the number of duplications, in the
dialog that opens, and be sure to uncheck the option 'Modifiable'.

5 Place the objects outside the worksheet because 'True shape nesting' is based on the dimensions of the
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worksheet and places the 'nested' objects on the worksheet.

6 Select the objects you want to use for 'True shape nesting'.

7 Select the menu 'Effe cts  > T rue  sha pe  ne sting  > T rue  sha pe  ne sting'. Select the options you want
to use in the dialog that opens.

8 In the 'True shape nesting' dialog press 'OK' to start the nesting.

Multiple objects 

1 Import the different objects you want to use into one worksheet.

2 Adjust the page size to the size of your media using the menu 'Vie w > Se ttings'. Select the tab 'Page'
and adjust the page size accordingly in the dialog that opens.

3 Prepare the objects (if necessary)  like described in the chapter above 'Preparing the objects to be
nested' but do not yet apply the 'Sticker contour'.  We postpone this because it would be very tedious to
apply a 'Sticker contour' to, let's say, 100 objects that need no other preparation.

4 place the objects outside the worksheet because 'True shape nesting' is based on dimensions of the
worksheet and places the 'nested' objects on the worksheet.

6 Select the objects you want to use for 'True shape nesting'.

7 Select the menu 'Effe cts  > T rue  sha pe  ne sting  > Pre pa re  T rue  sha pe  ne sting'. Choose your
settings in the dialog that opens.

8 In the 'Prepare True shape nesting' dialog press 'Apply' to apply a 'Sticker contour' to all selected
objects.

9 Select the menu 'Effe cts  > T rue  sha pe  ne sting  > T rue  sha pe  ne sting'. Select the options you want
to use in the dialog that opens.

10 In the 'True shape nesting' dialog press 'OK' to start the nesting.

Optional
Say you only need the 'Sticker contour' to nest your objects and not to cut them after printing (where the distance of
the 'Sticker contour is not an option but a customer requirement). If you want to change the distance you first have to
remove the 'Sticker contour’ and reapply them using the 'Prepare True shape nesting' dialog again. This is a simple
four step process.

1 Select all object on the worksheet that are already nested.

2 Select the menu 'Effe cts  > R e m ov e  e ffe ct' which will remove the 'Sticker contour' of all selected
objects. 

3 With the objects still selected open the menu 'Effe cts  > T rue  sha pe  ne sting  > Pre pa re  T rue  sha pe
ne sting' and apply the 'Sticker contour' with the new settings.

4 Apply the 'True shape nesting' again using the menu 'Effe cts  > T rue  sha pe  ne sting  > T rue  sha pe
ne sting'.
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Tip

If you have multiple objects, with different cutting types and/or distances, that you want to use for Print & Cut, then
you can use them as they are. Just apply a 'Sticker contour' on them using a distance of '0' (or any distance you
desire) and a line type of 'Sign Blank'.

The objects in the image above both have a Print & Cut line applied to an Inline effect (represented by the green line)
and a 'Sticker contour' for 'True shape nesting' with a distance of '0' and 'Sign Blank' as line type (represented by the
red line).

The 'Prepare True shape nesting' dialog

1 Cutter-tool
here you can select the line type you want to use, you have several predefined options to choose from.

2 Data
Here you can set the distance between the object and the 'Sticker contour'. 

When using the first 'Corner shape' options the 'Miter limit' will become available which will determine
how far a corner will 'Overshoot'.

In the image below from left to right the 'Miter limit' is set to 11, 72 and 125.
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3 Line properties
Here you can choose the shape of the corners. In the image below from left to right the first, second
and third option.

The second option is the most widely used because it gives the best result for almost any shape.

The 'True shape nesting' dialog

1 Nesting quality
Here you can set the quality of the 'True shape nesting'. The most commonly used option is 'Normal'
which will give a very good result consuming four times less memory as the 'More detail' option. The
option 'Less detail' is extremely fast and gives a lesser, but still acceptable, result and it also consumes
the least amount of memory.

2 Rotation
Here you can set the rotation allowed when nesting.

3 Options
The most important setting here is 'Incremental'. When this option is checked the 'True shape nesting'
will take objects already placed on the worksheet into account when calculating the nesting result.

The option 'use objects extends for objects without unique cutline' does just as it says. It will use the
objects extends while calculating the nesting result and not the actual shape of the object.

4 Page/cropmarks margin
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'True shape nesting' uses the worksheet as 'work area' or, when present, the inside of the alignment
cropmarks area. Especially with alignment cropmarks, but also with a worksheet, you don't want to nest
your objects all the way to the edge. Here you can enter the space between the outer most nested
shapes and the edge of the work area.

Out of memory

'True shape nesting' is very memory intensive. If you have too many objects selected it can run out of memory. 'True
shape nesting' has an 'Incremental' option, this options works together with the objects already nested on the
worksheet. You can use this option to nest very large numbers of objects as follows.

1 Place all objects you want to nest outside the worksheet.

2 Select a lower number of objects. If for example you tried to nest a 1000 objects all at once and ran
out of memory, select only 100 of them.

3 Start the 'True shape nesting' with your preferred settings, the objects will be placed on the worksheet.

4 Select the next 100 objects and start the 'True shape nesting' with your preferred settings, only now
activate the option 'Incremental'.

5 Repeat step 4 until you have placed all objects.

Déformations bitmap (effets spéciaux)

Dans EasySIGN, la plupart des effets spéciaux peuvent également être appliqués aux bitmaps. Le fait que les
déformations puissent être appliquées à la fois aux objets vectoriels et aux bitmaps est une propriété unique.

Nous allons vous donner un exemple de cette application.

Importez un bitmap et ajoutez un texte par dessus, ainsi que d’autres objets vectoriels, si vous le souhaitez. Vous pouvez placer ces objets

à l’extérieur des limites du bitmap.

Sélectionnez le bitmap et les autres objets, puis choisissez l’option « Effets spéciaux » du menu « Effets ».
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Sélectionnez l’effet que vous souhaitez utiliser et cliquez sur le bouton « Appliquer ».

Vous pouvez y superposer n’importe quel effet tel qu’un cadre d’arc.



250 EasySIGN

Comme la plupart des fonctions de EasySIGN, ceci ne détruit pas les objets d’origine. Vous pouvez à tout moment apporter des changements

au texte, au bitmap et aux objets vectoriels. Vous pouvez même ajouter de nouveaux objets par le biais du Gestionnaire d’objets. Le résultat

f inal sera automatiquement recalculé.

Rappelez-vous que plus le bitmap est volumineux, plus le calcul du résultat f inal est long.

Paramètres des déformations bitmap.

Sélectionnez l’option « Paramètres » du menu « Fichier » et choisissez l’onglet « Divers ». Il contient le paramètre « Résolution de l’effet

bitmap en cours d’édition ». Plus la valeur définie pour ce paramètre est élevée, plus l’aff ichage du résultat f inal est long à apparaître.

Vectorisation

Vectorisation
V e c t o r i s a t i o n

Rien n’est plus simple que la vectorisation dans EasySIGN. Si vous souhaitez réaliser une vectorisation “ Ligne
centrale ”, “ Ligne contour ” ou “ Couleurs ”, vous n’avez besoin que d’un bitmap. Vous pouvez modifier les
vectorisations à tout moment. Vous pouvez également tenter d’appliquer de nouveaux paramètres. Pour ce faire, il
vous suffit de sélectionner l’option “ Vectorisation ”. Si vous sélectionnez l’option “ Courbes ” du menu “ Traiter ”,
“ Convertir en ”, vous pouvez transformer l’objet vecteur en courbes paramétrables. Il ne vous est alors plus possible
de sélectionner l’option “ Vectorisation ”.
Vous avez besoin d’un bitmap noir/blanc pour réaliser une vectorisation “ Ligne centrale ” ou “ Contour ” et d’un
bitmap couleurs RGB pour une vectorisation couleurs.

Vectorisation “ Ligne contour ”
V e c t o r i s a t i o n  “   L i g n e  c o n t o u r   ”  

Importez ou scannérisez le bitmap noir/blanc d’un logo par exemple, puis sélectionnez-le.
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Sélectionnez à présent l’option “ Vectorisation ” du menu “ Fichier ”, “ Scannériser ”. La boîte de dialogue suivante
s’affiche alors à l’écran.

Sélectionnez l’option “ Ligne de contour ” comme “ Type de vectorisation ” (1). Le champ “ Filtre à poussières ” (2)
vous permet de sélectionner la mesure dans laquelle EasySIGN élimine les “ poussières ”. Le terme “ Poussières ”
désigne les parties qui ne doivent pas être soumises à la vectorisation dans le cas d’un bitmap avec un logo et un
arrière-plan blanc prédominant par exemple (saletés sur le scanner, traces de doigt sur l’original, etc.). Les
“ Paramètres ” (3) vous donne le choix entre divers éléments.

Préférences
Vous procédez à une sélection parmi les diverses préférences. Ces paramètres donnent le meilleur résultat pour un
type de bitmap déterminé. Dans notre exemple (un bitmap noir/blanc), nous avons opté pour les paramètres “ Haute
résolution texte noir/blanc ”. Les boutons de réglage situés sous la liste déroulante s’adaptent à vos préférences. Si
vous souhaitez modifier ces paramètres, sélectionnez l’option “ Déterminé par utilisateur ”. Vous pouvez alors
modifier la position des boutons de réglage comme bon vous semble.

Nombre de nœuds 

 

Ce paramètre vous permet de déterminer la précision avec laquelle EasySIGN doit construire les vecteurs pendant la
vectorisation. Plus les nœuds sont nombreux, plus la forme est précise. Ce n’est toutefois pas une règle d’or. Lorsque
l’original est de piètre qualité, il est parfois préférable de sélectionner un nombre inférieur de nœuds, les anomalies
étant également vectorisées. Dans ce cas, réduire le nombre de nœuds permet d’obtenir un résultat plus fluide.

Aiguiser les angles

 

EasySIGN vous permet de corriger l’arrondissement des angles après le scannage. En effet, les angles droits sont
arrondis en fonction de la résolution pendant le scannage et ne sont pratiquement jamais droits lorsque les originaux
sont des documents imprimés. 

Lignes droites

 

Ce filtre transforme les lignes légèrement courbées en droites. Plus le coefficient est élevé, plus les lignes sont
courbes.

Filtre horizontal / vertical
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Ce filtre permet de rétablir les lignes obliques qui sont en réalité verticales ou horizontales. Plus le coefficient est
élevé, plus les lignes sont nombreuses.

Une fois le paramétrage effectué, vous pouvez cliquer sur le bouton “ Appliquer ” (4) pour visualiser le résultat ou
cliquer directement sur le bouton “ OK ” pour fermer la boîte de dialogue immédiatement après la vectorisation. Le
résultat se présente sous la forme suivante.

Vectorisation “ Ligne centrale ”
V e c t o r i s a t i o n  “   L i g n e  c e n t r a l e   ”  

Dans EasySIGN, les atouts de la vectorisation résident dans le fait que la vectorisation est modifiable à tout moment
et que tous les types de vectorisation se traitent de la même manière. La seule différence entre la vectorisation
“ Ligne centrale ” et la vectorisation “ Ligne contour ” est que vous devez sélectionner l’option “ Ligne centrale ”
comme “ Type de vectorisation ” (1) dans la boîte de dialogue.

Vectorisation couleurs
V e c t o r i s a t i o n  c o u l e u r s  

Cette forme de vectorisation présente quelques paramètres de plus par rapport à la vectorisation “ Ligne contour ” et
“ Ligne centrale ”, mais elle fonctionne selon le même principe que la vectorisation “ Ligne contour ”. Elle s’applique
uniquement aux bitmaps RGB. Si vous scannérisez une image à vectoriser, veillez donc à placer votre scanner en
mode RGB.
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1 Nombre de couleurs
 Vous pouvez indiquer ici le nombre de couleurs à soumettre à la vectorisation.
2 Médiation de couleurs
 La médiation couleurs fusionne les couleurs situées côte à côte en une couleur. L’avantage de ce procédé

réside dans la disparition des transitions vagues entre couleurs. Ces transitions se présentent en effet sous la
forme de lignes très irrégulières après la vectorisation.

Dessiner les contours des objets

Dans la version 5, cette fonctionnalité a été considérablement étendue. De nouvelles options ont été ajoutées et presque toutes les options

offrent la possibilité de combiner plusieurs étapes en une. Le meilleur moyen d’expliquer ces fonctionnalités est de vous donner des

exemples.

Sélectionnez un objet, puis choisissez une des options de contour dans le menu « Effets ». En fonction de votre licence/version ou du type

d’OEM, vous disposez des fonctions suivantes :

Contour

Contour (carré)

Contour (cercle)

Contour (double)

Ligne

Ligne (double)

Développer bande

Contour autocollant

Etirement
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1 Type

Données supplémentaires

2 Distance

3 Distance extérieure

4 Distance onglet

5 Numéro

Options supplémentaires

6 Résultats fondus

7 Masquer original

8 Pré-soudé

9 Encadré

Propriétés de ligne

10 Forme de l'angle

11 Embouts de ligne

Propriétés de ligne

Tous les types de contour partagent des propriétés communes qui sont liées à la forme de l’angle ou aux embouts de ligne.

Différentes propriétés sont appliquées en fonction du type de contour.

Forme de l’angle (10).

Angles droits

Cette option permet de dessiner un rabot à onglet comportant des lignes entrecroisées dont les bords extérieurs

sont allongés jusqu’à ce qu’ils se coupent. Pour éviter de dessiner des points de découpe qui risqueraient d’être

trop éloignés des extrémités des lignes, vous pouvez ajuster la distance de l’onglet.
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A : Original

B : Distance onglet  10

C : Distance onglet  1

Embouts de ligne arrondis

Cette option permet de dessiner un cercle autour de l’extrémité de la ligne dont le diamètre est égal à la largeur de

la ligne.

A : Original

B : Exemple

Rabot à onglet

Cette option permet d’aplanir le point de découpe de deux lignes qui se rencontrent, en tronquant une partie de

l’allongement.

Cela s’apparente à un angle droit avec une distance d’onglet de « 0 ».

A : Original

B : Exemple

Embouts de ligne (11)

Onglet

Cette option aplanit la ligne au niveau des extrémités des lignes, de manière à ce qu’il n’y ait pas

d’allongement au-delà de ces extrémités.

A : Original

B : Exemple

Rond

Cette option permet de dessiner un demi-cercle au niveau de l’extrémité de la ligne dont le

diamètre est égal à la largeur de la ligne.

A : Original
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B : Exemple

Droit

Cette option permet d’allonger la ligne au-delà de son extrémité sur une distance égale à la moitié

de la largeur de la ligne et d’aplanir le résultat.

A : Original

B : Exemple

Pointu

Cette option permet de dessiner un embout pointu au niveau de l’extrémité de la ligne, la distance

jusqu’à l’extrémité de cette ligne étant égale à la moitié de la largeur de la ligne.

A : Original

B : Exemple

 

Type (1)

Cette option permet de sélectionner le type de votre choix. Vous pouvez le sélectionner pendant que vous créez l’effet, mais vous pourrez

aussi le faire ultérieurement, lorsque vous modif ierez les propriétés d’un objet en ajoutant un type de contour. Vous pouvez donc modif ier le

type de contour à tout moment. Si plusieurs autres effets sont ajoutés à ce contour, ces effets sont recalculés automatiquement.

A Un texte auquel est ajouté un contour, puis un cadre d’arc, une perspective plate et une perspective.

B Le type « Contour » a été remplacé par « Contour double ». Tous les autres effets ajoutés se sont adaptés

au nouveau type de contour.

 

Type, Données supplémentaires et Options supplémentaires

Par le biais de plusieurs exemples, nous allons vous montrer quelques possibilités. Lorsque vous utilisez des contours, vous pouvez faire

vous-même un grand nombre de combinaisons. Sachez que vous pouvez ajouter une quantité illimitée de types les uns par-dessus les

autres.
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Dans l’image ci-dessus, différents types de contours empilés les uns sur les autres apparaissent de droite à gauche. Si vous modif iez le

texte, tous les contours empilés seront recalculés (voir l’image ci-dessous).

Sélectionnez un type de contour, tel que « Contour », dans le menu « Effets ».

A : Original

B : Masquer original (7) désactivée.

C : Masquer original (7) activée.
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Contour

Distance (2) égale 1 et Numéro (5) égale 1.

La même chose que la première option, mais avec des angles arrondis.

La même chose que la seconde option, mais avec Numéro (5) défini sur 3.

Contour (carré)

Contour (cercle)

Deux variantes qui ne basent par le contour sur la forme extérieure des objets sélectionnés, mais sur les

extensions de la sélection. Vous avez le choix entre « carré » et « cercle ».
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Contour double

Distance (2) égale 3, Distance extérieure (3) égale 5 et Numéro (5) égale 1.

La même chose que la première option, mais avec des angles arrondis.

La même chose que la seconde option, mais avec Numéro (5) défini sur 3.

Ligne

Distance (2) égale 3 et Numéro (5) égale 1.

La même chose que la première option, mais avec Numéro (5) défini sur 3.
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Double ligne

Distance (2) égale 3, Distance extérieure (3) égale 5 et Numéro (5) égale 1.

La même chose que la première option, mais avec Numéro (5) défini sur 3.

Développer bande

Distance (2) égale 2 et Distance onglet (4) égale 1.

La même chose que la première option, mais avec des angles arrondis.

Contour autocollant Comme l’indique son nom, cette option permet de produire des contours pour autocollants, mais son utilisation

ne se limite pas à cette application.

Vous pouvez définir une distance positive ou négative (9) jusqu’aux objets d’origine. Vous pouvez même

définir le résultat sur la distance (2) « 0 » pour que le contour autocollant suive exactement la forme
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extérieure.

Etirement L’étirement est véritablement une fonction unique. Imaginez le résultat comme un ensemble d’un ou plusieurs

objets autour desquels est étiré un ruban élastique. Cela peut, par exemple, être une bonne alternative au

contour autocollant si vous souhaitez créer un contour de découpe sans entrées qui comporte par

conséquent moins de lignes de découpe.

Vous pouvez définir une distance positive ou négative (9) jusqu’aux objets d’origine. Vous pouvez même

définir le résultat sur la distance (2) « 0 » pour que l’étirement suive exactement la forme extérieure.

Cette fonction est également parfaitement adaptée pour relier des objets entre eux.

Si vous tentez de dessiner l’exemple ci-dessus à la main, vous aurez beaucoup de diff icultés à relier

parfaitement les deux cercles. Grâce à l’étirement et à la distance (2) définie sur « 0 », il vous suff it de

cliquer sur un bouton.

Centrage

Effet orienté objet pour obtenir le centrage d'un objet vectoriel.

Sélectionnez un objet et la commande "Effets, Centrage".
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Dans la boîte de dialogue, vous pouvez choisir entre deux types de centrage et spécifier si vous souhaitez masquer
l'original. Nous avons sélectionné la première option et affiché l'original.

Le résultat étant orienté objet, vous pouvez changer ses propriétés. Pour ce faire, sélectionnez "Propriétés" dans le
menu contextuel. Dans la boîte de dialogue relative aux propriétés, sélectionnez la deuxième option.

L'effet a été recalculé. Même lorsque nous modifions l'original, l'effet est recalculé.
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Si vous êtes satisfait du résultat, vous pouvez choisir "Masquer l'original" dans la boîte de dialogue des propriétés et
par exemple utiliser l'objet pour la gravure.  Si vous souhaitez apporter des modifications au résultat, vous devez
convertir l'objet en courbes (CTRL+Q). Vous pouvez ensuite modifier l'objet mais il n'est plus lié à l'original.

Optimisation de l'application (Recouvrement des couleurs)

En particulier, lorsque le vinyle doit être appliqué à une enseigne lumineuse, il est impossible de coller à froid deux
pièces adjacentes (sans chevauchement et directement l'une contre l'autre) et même si cela était possible, avec le
temps, les contraintes d'étirement ou de rétrécissement provoqueraient un décalage. Il est donc nécessaire d'utiliser
un chevauchement. Le chevauchement doit être le plus petit possible et ne doit pas comporter de défaut visible ni de
bords sombres inesthétiques. Pour cela, EasySIGN utilise une fonction spéciale appelée "Optimisation de l'application".
Cette fonction est simple d'utilisation et permet de découper dans la zone de chevauchement. La découpe de
chevauchements est pratique lorsque vous devez coller deux objets de même dimension. Lorsque le chevauchement
n'a pas été découpé, l'objet situé en dessous risque de dépasser et d'être visible sous de l'objet du dessus.

Sélectionnez les objets que vous souhaitez optimiser (pour mieux voir le résultat, les images peuvent aussi être
affichées en mode Fil de fer).

Dans le menu "Edition", sélectionnez ensuite la commande "Optimisation pour l'application" pour ouvrir la boîte de
dialogue suivante.

Dans cette boîte de dialogue, vous pouvez entrer sous "Options" (1) la distance voulue pour les chevauchements. Si
vous souhaitez utiliser des "chevauchements délimités", activez la case à cocher correspondante. Sous "Ordre
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d'application" (2), vous pouvez régler l'ordre des couleurs. Avec les réglages utilisés ci-dessus, vous obtiendrez le
résultat suivant :

Le résultat est orienté objet, ce qui signifie que vous pouvez toujours modifier les propriétés. Pour ce faire, dans le
menu contextuel de l'objet, sélectionnez l'option "Propriétés". Changez l'ordre d'application des couleurs et appuyez
sur "Appliquer'", vous obtiendrez le résultat suivant :

Avec l'outil glisser, vous pouvez régler la largeur du chevauchement sur la feuille de travail.
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Optimiser pour l'imbrication

Cette fonction permet de créer une imbrication orientée objet. Sélectionnez une forme vectorielle et le menu "Edition,
optimiser pour l'imbrication".

1 Vous pouvez sélectionner ici un outil existant dans la galerie ou une valeur numérique pour le diamètre.
2 Echoppage mâle
3 Echoppage femelle
4 Résultat miroir

L'outil glisser permet d'ajuster l'objet directement à l'écran. Le résultat s'affiche si l'outil sélectionné ou le diamètre
sont adaptés à l'objet.

1 Original
2 Corriger l'imbrication
3 Outil non adapté, le diamètre est trop grand.

Entrée numérique des lignes

Afin de satisfaire de nombreuses demandes, une méthode permettant d'entrer les lignes de façon numérique a été
ajoutée à EasySIGN. Les utilisateurs de programmes de CAO apprécieront tout particulièrement cette manière de
tracer des lignes. 

Sélectionnez le menu "///Insert (Insertion), Objets, Ligne". Cette commande ouvre la boîte de dialogue suivante :
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1 Point final
 Vous pouvez entrer ici les coordonnées "X" et "Y" de la ligne. 
2 Type
 Vous pouvez indiquer ici si les coordonnées entrées correspondent à un point de départ ou à une ligne. Chaque

ligne comporte au moins un point de départ et un point final (ligne). Si vous avez entré uniquement des
coordonnées avec la propriété "Ligne", la boîte de dialogue génère un avertissement lorsque vous cliquez sur
"OK", vous indiquant la présence d'une erreur et vous donnant la possibilité de la corriger.

3 Ajouter
 Après avoir entré une coordonnée, ajoutez-la à la liste "Forme" en cliquant sur ce bouton.
4 Modifier
 Si vous avez sélectionné une entrée dans la liste "Forme", cette entrée s'affiche dans les champs de

modification des coordonnées "X" et "Y" et vous pouvez modifier les valeurs. 
5 Forme
 Vous pouvez sélectionner une entrée à modifier ou à supprimer dans cette liste.
6 Supprimer
 Ce bouton permet de supprimer une entrée sélectionnée dans la liste "Forme".

Liaison de feuilles de travail

L'option "Importer une liaison" a été ajoutée à la boîte de dialogue d'importation de EasySIGN. Cette option est
disponible lorsque vous sélectionnez une feuille de travail EasySIGN dans cette boîte de dialogue. Si vous activez
cette option, la feuille de travail sélectionnée sera importée en tant que liaison. La liaison importée sera affichée sous
forme d'aperçu dans la feuille de travail. Une liaison est toujours signalée par un symbole dans la partie inférieure de
l'aperçu.

A quoi sert une liaison ?

Cette option est très utile si vous souhaitez utiliser, dans plusieurs feuilles de travail, une conception qui sera
régulièrement modifiée. Ainsi, au lieu d'importer, de dimensionner et de positionner la conception à chaque fois, vous
pouvez l'importer sous forme de liaison. Si l'original est modifié, la modification sera décelée lors de la détection de la
feuille de travail comportant la liaison et la boîte de dialogue correspondante s'ouvrira automatiquement. 
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Cette boîte de dialogue permet de mettre à jour la liaison à l'aide du bouton "Actualiser le lien " (4). 

L'espace réservé se trouve dans le coin inférieur gauche de la liaison. Si vous avez modifié la taille du fichier
d'origine, un ajustement sera effectué à partir de ce point.

Vous pouvez ouvrir la feuille de travail initiale en double-cliquant sur une liaison (si vous double-cliquez sur une
bitmap liée, l'éditeur Windows™ externe que vous avez choisi s'ouvre).

Si vous souhaitez inclure une feuille de travail liée (c'est-à-dire supprimer la liaison et insérer la feuille de travail
initiale), vous devez sélectionner l'option "Infos de liaison" dans le menu contextuel de l'objet. La boîte de dialogue de
liaison s'ouvre et vous pouvez sélectionner le bouton "Annuler liaison" (5). Cette boîte de dialogue permet également
de redéfinir la liaison vers l'objet d'origine (par exemple, si le fichier d'origine a été déplacé) à l'aide du bouton
"Redéfinir liaison”. Le bouton "Exporter" est disponible uniquement pour les images bitmap.

Liaisons comportant d'autres liaisons  

Si vous avez lié des feuilles de travail contenant des bitmaps liées (ou d'autres feuilles de travail liées), vous devez
vous assurer que ces liaisons sont à jour. Le programme peut déterminer si une liaison vers une feuille de travail
d'origine est à jour, mais il ne peut pas déterminer si les liaisons inclues dans ces feuilles de travail liées sont
également à jour. Vous devez toujours vous assurer que la feuille de travail initiale est à jour.

Résultat des liaisons

Lorsque vous ouvrez la boîte de dialogue de traçage, vous disposez de plusieurs options. L'une d'entre elles, “Inclure
couleurs des documents liés” (3), concerne les feuilles de travail liées.  
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1 Sélection uniquement
 Si vous avez sélectionné des objets dans votre feuille de travail, cette option est disponible à l'ouverture de la

boîte de dialogue de traçage. Si vous activez cette option, la liste “Par couleur” se limite aux couleurs
présentes dans la sélection de votre feuille de travail.

2 Par couleur
 Seule la couleur sélectionnée dans cette liste sera tracée.
3 Inclure couleurs des documents liés
 Cette option est disponible uniquement si l'option “Par couleur” est activée. La liste contiendra également

toutes les couleurs des feuilles de travail liées.

Vérification des liaisons

Lorsque vous ouvrez une feuille de travail, toutes les liaisons qu'elle contient sont vérifiées afin de s'assurer qu'elles
sont à jour. Si ce n'est pas le cas, une boîte de dialogue permettant de les mettre à jour s'affiche. Si vous ne les
mettez pas à jour immédiatement, la mise à jour sera effectuée (si possible) lors d'un travail d'impression ou de
traçage. Pour éviter toute surprise (la taille ou la position peuvent varier considérablement en cas de modification de
la liaison, ce qui peut créer des problèmes), il est préférable de s'assurer que toutes les liaisons fonctionnent avant de
lancer un travail d'impression ou de traçage. En cas de liaison manquante, vous en serez informé avant l'impression
ou le traçage. Si vous ignorez cet avertissement, la liaison manquante sera imprimée avec une résolution basse et les
données manquantes seront ignorées lors du traçage.

Numérotation automatique

EasySIGN prend en charge l'utilisation d'un objet de numérotation automatique. Cet objet est très facile à utiliser. Il
vous suffit de sélectionner le menu “Insérer, Objets, Numérotation automatique”. Une boîte de dialogue s'affiche et un
objet de numérotation automatique est inséré dans la feuille de travail.
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Les paramètres suivants sont disponibles dans cette boîte de dialogue.

1 Numéro
- L'option “En-tête” permet d'affecter un texte fixe qui sera placé avant le numéro automatique réel.
- L'option “Numéro” permet de déterminer le numéro à partir duquel la numérotation automatique doit

commencer.
- L'option “Longueur minimale” permet de définir le nombre de zéros à utiliser pour que tous les numéros

automatiques aient la même longueur. Si vous définissez uniquement un zéro, la numérotation automatique
utilise le numéro automatique réel, sans zéro.

- L'option “Suffixe” permet d'affecter un texte fixe qui sera placé après le numéro automatique réel.
2 L'option “Alignement” permet de définir si certaines parties du numéro automatique sont alignées les unes

après les autres ou les unes en dessous des autres.
3 Cela permet d'afficher un aperçu des paramètres que vous avez sélectionnés dans cette boîte de dialogue.

Vous pouvez revenir à cette boîte de dialogue à tout moment en utilisant la commande Propriétés du menu contextuel
de l'objet de numérotation automatique (obtenu en cliquant avec le bouton droit) et modifier les paramètres définis.
Pour appliquer les paramètres définis à l'objet de numérotation automatique, appuyez sur “OK”.

Vous obtenez un objet de numérotation automatique de base. Lorsque vous effectuez une duplication, un placement
en conservant l'objet d'origine (à l'aide de la commande “Multiplier”) ou toute autre action qui crée une copie de
l'objet, l'objet de numérotation automatique est incrémenté. Que l'objet appartienne à un groupe ou à une conception
(par exemple, une étiquette contenant des numéros), le numéro augmente automatiquement. Des objets qui ont déjà
été incrémentés peuvent être eux-mêmes dupliqués. La numérotation repart à partir de l'objet de numérotation
automatique en question.
Il est possible de créer une plage de numérotation automatique très rapidement en déplaçant l'objet et en cliquant
une fois sur le bouton droit de la souris (cela permet de conserver l'objet d'origine). Si vous utilisez ensuite le
raccourci “CTRL+R” (répéter) plusieurs fois, vous pouvez générer en quelques secondes une feuille de travail
complète comportant de nombreux objets de numérotation automatique.

Les propriétés textuelles d'un objet de numérotation automatique peuvent également être modifiées dans certaines
limites.
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1 L'option “En-tête” permet de modifier les propriétés textuelles et les couleurs séparément pour chaque
caractère. 

2 Le numéro automatique réel permet de modifier les propriétés textuelles et les couleurs séparément pour
chaque caractère. Toutefois, si ce numéro est incrémenté, les propriétés du nouveau numéro automatique
seront toujours basées sur le premier caractère du numéro d'origine.

 

 
 
3 L'option '“Suffixe” permet de modifier les propriétés textuelles et les couleurs séparément pour chaque

caractère.

Vous ne pouvez pas ajouter ni supprimer un caractère des parties ci-dessus. Ces opérations doivent être effectuées à
l'aide de la boîte de dialogue relative aux propriétés de l'objet de numérotation automatique. Si vous modifiez l'objet
de numérotation automatique à l'aide de cette boîte de dialogue, tous les caractères ont les mêmes propriétés que le
premier caractère.

 

 
Si vous ne souhaitez plus utiliser l'objet de numérotation automatique en tant qu'objet, vous pouvez le convertir en
objet textuel à l'aide du menu contextuel.

Enregistrement d'une sélection à partir d'une feuille de travail

Si vous avez créé une feuille de travail et que vous souhaitez en enregistrer une partie dans une nouvelle feuille de
travail, vous pouvez exporter une sélection de cette feuille de travail vers un nouveau fichier. Pour ce faire,
sélectionnez le menu “Fichier, Exporter”. Dans la boîte de dialogue qui s'affiche, vous sélectionnez le format
“EasySIGN” et activez l'option “Sélection uniquement”.
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Gestionnaire d'objets

Gestionnaire d'objets
G e s t i o n n a i r e  d ' o b j e t s

Qu’est-ce que le Gestionnaire d’objets ?
Le Gestionnaire d’objets permet un retour à l’état original de presque tous les objets. Chaque intervention (un effet,
une soudure, etc.) n’affecte pas un objet original manipulé par le Gestionnaire d’objets. Chaque objet est en effet
indépendamment sauvegardé. Par exemple, d’ordinaire, un texte enrichi d’effets multiples ne peut pas être modifié
sans le retrait préalable de tous ses effets — effets qu’il faut réintroduire après les changements apportés.  Avec le
Gestionnaire d’objets, vous pouvez sélectionner directement la partie du projet à modifier : les autres effets sont
automatiquement réappliqués. 

Important
Quand le Gestionnaire d’objets est actif, le résultat des diverses interventions du graphiste n’est jamais définitif parce
que de nouveaux objets sont continuellement créés.  Chaque objet à l’intérieur de ce nouvel objet conserve tous ses
traits originaux. Le fonctionnement du Gestionnaire d’objets peut, au début, vous paraître compliqué. Si vous voulez
commencer à travailler sans attendre, vous avez la possibilité de désactiver quelques unes de ses fonctions en allant
dans le menu “ Fichier ”, “ Paramétrages ”, “ Gestionnaire d’objets ”. Chaque objet créé est alors un objet définitif, à
chaque fois différent des versions précédentes. Vous pouvez à tout moment réactiver les fonctions suspendues pour
les essayer provisoirement. Quand l’outil vous sera plus familier, vous pourrez les installer à demeure.

Notez que les objets sur lesquels vous travaillez avec le Gestionnaire d’objets peuvent être convertis en objets
définitifs (il ne vous sera plus possible alors d’intervenir sur des éléments distincts de l’objet) avec la commande
“ Modifier ”, " Convertir en ”, “ Courbes ” (CTRL+Q). 

Comment fonctionne le Gestionnaire d’objets ?
Un exemple vous fera très vite comprendre ce que peut accomplir le Gestionnaire d’objets.

Si le Gestionnaire d'objets n'est pas déjà affiché, sélectionnez le menu “ Affichage ”, “ Gestionnaire d’objets ”. La
fenêtre qui s‘ouvre déroule la liste de tous les objets dans une feuille de travail : 

Chaque objet a son propre symbole et sa description :
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Les objets texte présentent toujours cette icône dans le texte couleur, ainsi qu'une étiquette montrant les premiers
caractères du texte. Les autres objets ont une étiquette indiquant leur nom (par exemple, pour un effet, le nom de
l’effet).

Dans l’exemple qui suit nous commencerons avec une feuille de travail vierge.

1 Saisissez un texte en y introduisant une erreur ; tapez par exemple “ ERREURE ” au lieu de “ ERREUR ”.
Utilisez une police en style gras d’environ 19 mm de haut.

2 Sélectionnez le menu “ Effets ”, “ Etendre segment ” dans la boîte de dialogue, puis activez les options “ Souder
objets ” et " Supprimer l'original ". Dans le champ “Distance”, entrez 0,6 mm :

3 Appliquons un effet.  Nous utiliserons “ Cadre d’arc ” :

4 Appliquons un autre effet.  Nous choisirons “ Effet d’ombre ” :

Le texte d’origine comporte toujours une erreur qu’il faut corriger.   Au lieu de retirer les effets, corrigez le texte puis
essayez de réappliquer tous les effets (nous verrons plus loin une autre méthode). Dans le Gestionnaire d’objets,
sélectionnez le symbole pour le texte :
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Le texte est également sélectionné dans la feuille de travail :

Sélectionnez maintenant le symbole du texte pour corriger le texte.
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Une fois votre correction terminée, choisissez l’outil de sélection dans la barre d’outils ; le logiciel recalcule alors tous
les effets pour intégrer la correction de texte. Pour corriger le texte enrichi des effets, il vous suffit de le sélectionner
dans le Gestionnaire d’objets.

Le gestionnaire peut bien sûr faire beaucoup plus que corriger des coquilles. Supposons que vous ne vouliez pas de
texte transparent mais un texte avec un remplissage. Voici ce qu’il est possible de faire :

1 Dans le Gestionnaire d’objets, sélectionnez le symbole pour les contours.

2 Le contour est sélectionné dans la feuille de travail :
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3 Dans la barre d’outils du Gestionnaire d’objets, sélectionnez le symbole pour “ Propriétés ” :

4 Quand la boîte de dialogue des propriétés des contours s’ouvre, désactivez l’option “  Supprimer l’original ” :

5 Le texte et son contour ont maintenant un remplissage ; en sélectionnant à nouveau le texte dans le
Gestionnaire d’objets, vous ne pouvez changer que le remplissage du texte.
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Le Gestionnaire d'objets et la soudure
L e  G e s t i o n n a i r e  d ' o b j e t s  e t  l a  s o u d u r e

Chaque objet de EasySIGN peut être traité par le Gestionnaire d’objets. Une fonction comme “ Souder ” montre
clairement l’utilité du Gestionnaire d’objets. Nous choisirons le mode grille pour l’illustrer. 

1 Dessinez un rectangle et un cercle et placez-les l’un au-dessus de l’autre :

2 Lancer “ Modifier ”, “ Soudure ” et  “ Fusionner objets ”

3 En sélectionnant l’un des objets dans le Gestionnaire d’objets, vous pouvez le promener librement dans votre
feuille de travail.
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L’effet est recalculé une fois l’objet lâché. Vous pouvez retravailler le graphisme du projet sans avoir à retirer l’effet.

Vous pouvez également changer les propriétés d’une soudure. Vous pouvez ouvrir la boite de dialogue des propriétés
et changer le type des soudures :  

Vous pouvez plus que changer des effets, vous pouvez ajouter, à un effet existant, de nouveaux objets :
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1 Revenez à “ Fusionner objets ” et dessiner un cercle sur l’effet existant :

2 Sélectionnez le cercle dans le Gestionnaire d’objets et faites-le glisser dans la soudure :

Le cercle fait maintenant partie de la soudure.

Sur l’effet résultant vous pouvez appliquer un autre effet, par exemple une ombre :

Si vous changez un quelconque aspect de l’effet de soudure, tous les autres effets intègrent automatiquement
le changement.
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Le Gestionnaire d'objets et les contours
L e  G e s t i o n n a i r e  d ' o b j e t s  e t  l e s  c o n t o u r s

EasySIGN bénéficie du Gestionnaire d’objets. La fonction “ Contour ” montre un autre aspect des possibilités du
Gestionnaire d’objets. Combien de fois vous a-t-il fallu refaire un contour ? Avec le Gestionnaire d’objets, il suffit de
redéfinir les propriétés.

1 Dessinez un objet quelconque :

2 Appliquez l’effet “ Etendre segment ” :

3 Si maintenant vous voulez des coins ronds et non plus carrés, cliquez simplement sur le bouton droit de la
souris pour régler ce paramètre dans la boîte des propriétés.

4 Si l’épaisseur des contours ne vous conviennent plus, rouvrez le dialogue des propriétés et changez-en, ou,
plus simplement encore, travaillez l’épaisseur directement à l’écran avec l’outil glisser.
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5 Vous pouvez définir les propriétés d’un objet à n’importe quel moment. Dans l’exemple ci-dessous, la propriété
est modifiée en “ Double contour ” :

Conseils sur le Gestionnaire d'objets
C o n s e i l s  s u r  l e  G e s t i o n n a i r e  d ' o b j e t s

Tous les objets traités par le Gestionnaire d’objets ne peuvent être " prêts à l'emploi ". Mais ceci n’est pas un
problème. Vous faites une copie de travail de l’original et lancez la commande “ Modifier ”, “ Convertir en ”,
“ Courbes ” (CTRL+Q). L’objet est converti en “ résultat final ”. Vous pouvez alors utilisez la fonction de sortie
EasySIGN. Vous conservez toujours l’original pour d’autres éventuelles modifications. 

Tous les objets de la feuille de travail sont dans le Gestionnaire d’objets. Il devient quelquefois difficile de sélectionner
le bon sous-objet (l’objet partie d’un effet ou d’un groupe). La meilleure façon est de sélectionner l’objet “ principal ” à
l’écran ; il est alors automatiquement sélectionné par le Gestionnaire d’objets et, sous la sélection, vous retrouvez
très facilement le sous-objet.

Un changement des propriétés ne produit pas toujours le résultat désiré. En effet, dans une hiérarchie d’objets et
d’effets, certaines actions sont impossibles. Vous pouvez alors les en retirer : sélectionnez l’objet ou les objets dans
la hiérarchie, faites-le(s) glisser, changez les propriétés, remettez le(s) dans la hiérarchie.  Faire glisser des objets
dans le Gestionnaire d’objets n’a aucune incidence sur leur emplacement dans la feuille de travail, et donc sur leur
emplacement dans la hiérarchie.

Si vous ne pouvez pas sélectionner un objet dans le Gestionnaire d’objets, vérifiez si la couche contenant l’objet n’est
pas verrouillée.

Ouverture et fermeture  des objets du Gestionnaire d’objets
O u v e r t u r e  e t  f e r m e t u r e   d e s  o b j e t s  d u  G e s t i o n n a i r e  d ’ o b j e t s

Il y a deux commandes importantes dans le Gestionnaire d’objets et dans le menu “ Organiser ” :

Ouvrir objet

Fermer objet

Si, dans le Gestionnaire d’objets, vous modifiez un objet appartenant à une hiérarchie complexe, le temps de calcul
peut s'avèrer très long, surtout si de nombreuses manipulations sont indispensables.  Il serait préférable dans ce cas
d’ouvrir les objets avec le bouton ou la commande “ Ouvrir objet ” qui ignore provisoirement les autres parties de la
hiérarchie. Des modifications, mêmes complexes, peuvent alors être exécutées rapidement. 
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L’exemple ci-dessous est un texte avec une ombre ; il ne mobilise pas une hiérarchie très complexe, mais il montre
bien comment ouvrir des objets.

Si vous voulez régler le crénage de ce texte, l’ombre sera recalculée à chaque fois que vous relâchez le bouton de la
souris. Voici une meilleure façon d’ouvrir l’objet. Dans le Gestionnaire d’objets, sélectionnez le symbole pour le
texte :

Choisissez “ Organiser ”, “ Ouvrir objet ” ou cliquez sur le bouton du Gestionnaire d’objets. Seul le texte sélectionné
s’affiche ; toutes les autres composantes de l’objet dans la hiérarchie restent invisibles et sont provisoirement
ignorées : 

Vous pouvez maintenant modifier tout ce que vous voulez ; vos changements n’entraîneront pas un recalcul de toute
la hiérarchie de l’objet.

Le recalcul se fait après la fermeture de l’objet et non après chaque relâchement de la souris tirant un caractère.
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CTRL+CLIC ou les sous-sélections

EasySIGN prend en charge les sous-sélections dans les groupes et les effets. Une sous-sélection veut dire que vous
pouvez sélectionner une partie d’un groupe ou d’un effet sans avoir à déshabiller l’objet de son effet.  

Prenons un exemple :

Les 4 cercles de l’image ci-dessus forment un groupe.  Vous avez placé sur le groupe un carré rouge sombre et
appliqué sur deux des cercles un effet d’ombre.  Supposons que vous vouliez appliquer une autre couleur au carré.
Très classiquement, il vous faudrait d’abord enlever l’effet d’ombre, ensuite appliquer la nouvelle couleur, enfin
réappliquer l’effet d’ombre retiré.  Il existe une méthode beaucoup plus rapide. Sélectionnez le carré tout en
appuyant sur la touche Ctrl.

Vous avez fait une sélection directe du carré. Quand vous faites une sous-sélection, les poignées de sélection sont
rondes au lieu d’être carrées.
Mais, parce que l’action CTRL+CLIC fonctionne dans l’ordre d’application des effets, des groupes, etc., vous ne
pouvez pas toujours sélectionner un objet directement.  Pour sélectionner un objet “ à travers ” un effet ou un
groupe, vous devez parfois cliquer une deuxième fois.  

Vous pouvez faire ce que vous voulez d’une sous-sélection (ici le carré)  : changer la couleur, étirer les angles,
appliquer une transformation, etc. :
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Maintenant, avec la touche Ctrl, sélectionnez l’un des cercles jaunes :

Le groupe des 4 cercles étant sous-sélectionné, vous pouvez changer la couleur des 4 cercles en une seule fois.

Si vous cliquez à nouveau, vous ne sélectionnez que l’un des cercles (vous sélectionnez “ à travers le groupe ”) ;
toute action n’est maintenant applicable qu’au cercle sous-sélectionné :

N’oubliez pas que la sélection avec la touche Ctrl se fait dans l’ordre d’application des effets, des groupes, etc.  Pour
mieux comprendre, voyons ci-dessous l’exemple d’un groupe de 4 objets :

Si vous sélectionnez le rectangle jaune avec la touche Ctrl, vous faites une sous-sélection directe :
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Dans l’exemple ci-dessous, nous utilisons les mêmes objets mais nous ajoutons un carré que nous groupons avec le
groupe précédent : nous créons un groupe dans le groupe.  Si vous voulez maintenant sous-sélectionner le carré
jaune, vous devez cliquer deux fois pour sélectionner “ à travers ” le groupe ajouté.

Important : positionnement avec la touche Ctrl
Quand vous avez besoin de bien contrôler un effet ou le mouvement d’un groupe avec la touche Ctrl, vous devez
d’abord impulser le mouvement puis appuyer sur la touche Ctrl (après que le mouvement a commencé).  Si vous
appuyez d’abord sur la touche Ctrl puis commencez votre mouvement, vous risquez de ne déplacer que la sous-
sélection du groupe ou de l’effet.

Cadre d'arc

La commande “Effets, Cadre d'arc” permet de placer du texte (et des objets) sur un arc spécial. Comme le montre
l'exemple ci-dessous, le texte de script et le texte arabe ne peuvent pas être alignés correctement s'ils sont placés
sur un arc classique. 

La commande “Cadre d'arc” permet d'aligner les connexions des textes de script et des textes arabes comme si vous
les aviez tapés sur une ligne droite.
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Les points de connexion du texte illustré ci-dessus ne sont pas alignés. Pour corriger ce problème, sélectionnez le
menu contextuel de l'objet, puis sélectionnez la commande “Propriétés”.

1 Type de déformation
 Vous pouvez indiquer ici le comportement des objets sur l'arc.
2 Centré
 Vous pouvez indiquer ici l'emplacement de l'objet sur la feuille de travail.
3 Propriétés du cercle
 Vous pouvez définir ici le rayon, le début, le milieu et la fin de l'arc.

Pour aligner les points de connexion du texte, choisissez la deuxième option, puis appuyez sur “OK”.
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Tous les points de connexion sont à présent alignés. Cet effet est obtenu en déformant légèrement toutes les lettres.
Si vous utilisez un petit texte et un petit rayon, la déformation sera plus importante que si vous utilisez beaucoup de
texte et un grand rayon.

Ajustement des arcs

Les cadres d'arc sont faciles à gérer directement dans la feuille de travail à l'aide de l'outil de déplacement.

Objet d'origine.

Après la commande "Cadre d'arc".

Ajustement de la tension et du rayon de l'arc
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Ajustement du rayon.

Ajustement de la largeur.
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A Dimensionnez et faites pivoter l'objet en utilisant “I” comme point d'ancrage.
 A l'aide de la touche Ctrl, dimensionnez l'objet en utilisant “J” comme point d'ancrage, tout en conservant le

même angle pour “I”.
B Ajustez la longueur et la hauteur de l'arc.
 A l'aide de la touche Ctrl, faites pivoter l'objet autour de “J” sans changer le rayon.

C Même action qu'à l'étape “A”.
D Ajustement de la tension de l'arc
E Déplacez les points de contrôle.
 A l'aide de la touche Ctrl, faites pivoter l'objet autour de “J” sans changer le rayon.
F Même action qu'à l'étape “D”.
G Dimensionnez l'objet et faites-le pivoter en utilisant “A” comme point d'ancrage.
H Même action qu'à l'étape “B”.
I Même action qu'à l'étape “G”.
J Déplacement de l'arc.

Objets positionnés sur un arc

Ajuster

L'illustration suivante montre la différence entre les objets d'un arc auxquels la déformation "Ajuster" a été appliquée
et les mêmes objets auxquels cette déformation n'a pas été appliquée. L'illustration de gauche montre le résultat
obtenu avec l'option “Ajuster”.
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Perspective plate

Vous pouvez appliquer une perspective plate à objet ou à plusieurs objets en même temps.  La commande permet
d’appliquer une perspective à un ou deux points. Cela veut dire qu’un objet peut avoir deux points de fuite.

Comment appliquer une perspective plate ?
Sélectionnez l’objet auquel vous voulez appliquer l’effet :
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Sélectionnez maintenant le menu “ Effets ”, “ Perspective plate ” : 

Notez l’apparition de huit points de contrôle autour de l’objet : Les points de contrôle dans les coins servent à la
déformation de la perspective. Pour chaque point de contrôle, vous pouvez utiliser la touche Ctrl pour limiter les
mouvements horizontaux et verticaux. 

Vous pouvez régler la perspective en tirant sur les points d’angle.
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Vous avez avec cet outil une parfaite maîtrise de toutes les déformations de perspective plate possibles.  Vous
pouvez poser un logo sur un bâtiment ou sur le capot d’une voiture avec un effet de perspective correct. Un outil idéal
pour des présentations de projets au stade final.

Tous les points de contrôle peuvent s’amarrer magnétiquement aux guides et nœuds d’autres objets.

En faisant glisser les points de contrôle vers le milieu, vous pouvez déplacer les deux nœuds alentour sans modifier
leur position respective.
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Pour obtenir une ligne parallèle en vis à vis, tirez un point de contrôle d’une ligne en appuyant en même temps sur la
touche majuscule.

Si, avec le bouton droit de la souris, vous cliquez sur un point de contrôle, vous ouvrez une boîte de dialogue qui vous
permet de définir numériquement la position du point. 
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Une perspective plate peut être appliquée à n’importe quel objet vectoriel :

 

Effet de moulage

Avec l’effet de moulage, vous pouvez mouler n’importe quel objet dans la forme que vous voulez, sans que cela
affecte votre original. Le fonctionnement de l’outil de moulage est expliqué dans l’exemple ci-dessous.

Sélectionnez un objet :
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Choisissez la commande “ Effets ”, “ Effet de moulage ” :

Il y a maintenant 4 nœuds entourant l’objet. Ces nœuds peuvent être étirés dans n’importe quelle direction avec
l’outil glisser. La touche Ctrl limite les mouvements à des déplacements verticaux et horizontaux : 

Quand vous relâchez le bouton de la souris, l’objet se coule dans la forme de l’effet de moulage :

Vous pouvez former le moule avec beaucoup de précision en vous servant des poignées des nœuds :

 

Quand vous travaillez avec l’effet de moulage, la boîte de dialogue de modification du nœud est visible. En effet,
l’effet de moulage accepte la vectorisation et la modification des nœuds (ajout de nœuds, modification des propriétés
de nœuds, suppression de nœuds, etc.). 

Pour ajouter et faire glisser un nœud : 
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Sélectionnez maintenant tous les nœuds et choisissez la commande “ Ligne ” pour changer toutes les courbes en
lignes :

Ceci illustre les possibilités de modification de nœud sur un effet de moulage. Vous pouvez maintenant supprimer le
nœud ajouté précédemment en le sélectionnant et en appuyant sur la touche Suppr, ou en choisissant l’option de
suppression dans la boîte de dialogue de modification des nœuds : 

Sélectionnez maintenant les nœuds restants et choisissez la commande “ Courber ” et “ Rendre symétrique ” :

Un objet suit toujours approximativement les courbes d’un effet de moulage. Suivre exactement une courbe est
impossible. Il est toutefois possible, avec “ Propriétés ” du menu contextuel, de jouer sur la plus ou moins grande
précision d’un suivi de courbe. Un dialogue s’ouvre qui permet de choisir entre différents rendus d’effets.
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Si vous optez pour la précision, l’objet épouse le moule plus étroitement mais le temps de calcul s’allonge d’autant. Le
meilleur parti est de mouler l’objet d’abord assez grossièrement puis de s’approcher progressivement de la forme
souhaitée. 

Faible précision

Haute précision

Vous pouvez bien sûr appliquer l’effet de moulage à des objets nombreux et très complexes :

L’utilisation la plus efficace de l’effet de moulage est à chercher dans les ajustements de textes. Les possibilités sont
ici quasi illimitées :
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Avec la commande “ Modifier ”, “ Convertir en ”, “ Courbes ” (CTRL+Q), vous pouvez changer un objet moulé en un
objet vectoriel ; avec la commande “ Effet ”, “ Extraire d’un effet ”, vous pouvez conserver l’objet original ou les
objets originaux.

Fusion

Cette option permet de fusionner des objets et des couleurs.

Lors de la fusion, la forme, le remplissage et le style de ligne (couleur et largeur) sont pris en compte.

Fonctionnement d’une fusion

Sélectionnez au moins deux objets, puis le menu « Effets, Fusion ».
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Les derniers paramètres utilisés sont appliqués et le logiciel passe en mode outil de déplacement.

En faisant glisser le nœud en forme de diamant (1), vous pouvez déterminer si la fusion des couleurs se rapproche davantage du premier ou

du second objet. En faisant glisser le nœud en forme de triangle (2), vous pouvez déterminer si la fusion des formes se rapproche

davantage du premier ou du second objet.  

En cliquant sur la fusion avec le bouton droit de la souris, vous pouvez sélectionner « Propriétés » dans le menu contextuel. La boîte de

dialogue des propriétés de la fusion s’ouvre. Vous pouvez par exemple y définir le nombre d’étapes.

En utilisant la combinaison CTRL+CLIC sur l’un des objets d’origine (ou en le sélectionnant dans le Gestionnaire d’objets), vous pouvez le

modif ier (par exemple, changer la couleur de la forme). La fusion sera ensuite recalculée. 

Vous pouvez ajouter de nouveaux objets à la fusion (ou les supprimer) par le biais du Gestionnaire d’objets en les faisant glisser dans ou

hors de l’effet de fusion.
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En sélectionnant l’option « Circulaire » dans la boîte de dialogue des propriétés, vous pouvez relier le premier et le dernier objet.

Vous pouvez encore modif ier les objets d’origine ou appliquer d’autres effets à la fusion.

Boîte de dialogue Fusion
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1 Paire

Permet de sélectionner les différentes paires fusionnées. Si la fusion se compose uniquement de deux objets d’origine, il n’y aura

qu’une seule paire fusionnée, avec 3 objets il y aura 2 paires fusionnées, etc.

Objets d’origine (1), paires fusionnées (2) et les résultats (3).

2 Nombre d'étapes

Permet de définir le nombre d’étapes par paire fusionnée. Si vous activez l’option « Appliquer à toutes les paires fusionnées », le

nombre d’étapes s’applique à toutes les paires fusionnées.

3 Circulaire

Permet de définir su le premier et le dernier objet doivent aussi former une paire fusionnée.

1 : Non circulaire

2 : Bas

3 : Haut

4 Espacement

Sous « Ecart », vous pouvez définir si le point de départ de l’objet doit être plus proche du premier ou du second objet.

1 : 0 %

2 : -50 %

3 : 50 %

5 Style de remplissage et style de trait des objets générés

Dans les zones de liste modif iable qui se trouvent sous « Centrer » et « Autres », vous pouvez par exemple définir la manière dont

les dégradés doivent se comporter dans une fusion.
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1 : Les deux définis par défaut sur « Pas d’ajustement automatique ».

2 : « Autres » sur « Comme objet de début ».

Sous « Ecart », vous pouvez définir si le point de départ de la fusion des couleurs doit être plus proche du premier ou du second

objet.

1 : 0 %

2 : -75 %

3 : 75 %

6 Nœud de départ relatif

Cette option permet de déterminer le nœud de départ relatif  de chaque paire fusionnée.

1 : Nœud 0 (par défaut).

2 : Nœud 1

3 : Nœud 2

4 : Nœud 3

7 Tous les objets

Rotation dans le sens des aiguilles d'une montre. Cette option définit le sens de rotation de tous les objets d’une fusion pour qu’elle

s’effectue dans la même direction.

Exemples d’effets de fusion
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Découpage, le paramètre de l’image supérieure est défini sur « Distances égales centré » et celui de l’image inférieure sur « Espacement

égal ».

Dans l’image supérieure, le remplissage est en dégradé et dans l’image inférieure, chaque caractère a une couleur différente.

A gauche, les objets d’origine et à droite les mêmes objets avec une fusion.

Combinaison de la fusion et d’autres effets.

Conception d’un logo avec effets de fusion.



303EasySIGN

Effet de fusion sur des lignes.

Création d’un effet néon avec la fusion

Entrez une police en style gras. Ici, on utilise la police Verdana d’une hauteur de 200 mm et les caractères ont une largeur de 150 %.

Attribuez à ces objets le paramètre « Pas de remplissage » et un style de ligne de 6 mm de large. Appliquez la couleur suivante au style de

ligne. 

CMJN : 0-100-100-100

Sélectionnez « Modif ier, Clone, Par dessus ». Le clonage n’est pas indispensable, mais il simplif ie les choses lorsque le texte doit être modif ié

ultérieurement. Créez un style de ligne de 2 mm et appliquez la couleur suivante.

CMJN : 0-100-100-0

Sélectionnez « Modif ier, Dupliquer sur original ». Créez un style de ligne de 1 mm et appliquez la couleur suivante.

CMJN : 0-0-0-0

Dessinez un rectangle noir avec des angles arrondis derrière les objets texte.



304 EasySIGN

Sélectionnez tous les objets texte, puis le menu « Effets, Fusion ».

Si vous avez utilisé des clones, il vous suff it de modif ier le « texte de contrôle » pour que tout l’effet soit recalculé.

Clone

Un clone est la copie d'un objet qui reste liée aux propriétés de l'objet original. Lorsqu'une propriété du clone est
modifiée, celle-ci est déconnectée de l'original. 

Vous comprendrez rapidement avec un exemple. 

Dessinez un rectangle.

Sélectionnez la commande "Edition, Clone, Décalé".

Copions maintenant le clone plusieurs fois. Lorsqu'un clone est copié, la copie devient automatiquement un clone de
l'original à partir duquel le premier clone a été copié.
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Si nous changeons la couleur de l'original, le clone est aussi affecté.

Changeons maintenant la couleur de l'un des clones. La propriété "Couleur" est maintenant déconnectée de ce clone.

Lorsque nous changeons la couleur de l'original, tous les clones sont affectés sauf celui dont nous avons déconnecté
la couleur.

Seule la couleur est déconnectée, aussi si nous changeons la forme de l'original, tous les clones seront affectés.
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Reconnectez la propriété "Couleur" en sélectionnant "Restaurer l'original" dans le menu contextuel du clone.

La boîte de dialogue qui s'affiche présente une liste (1) de toutes les propriétés déconnectées. Sélectionnez la
propriété que vous souhaitez reconnecter (la couleur dans ce cas) et cliquez sur "OK".

Maintenant, lorsque vous changez la forme et la couleur de l'original, tous les clones sont affectés.

L'original est un rectangle. Lorsque cet objet est converti en courbes, les clones le sont également. Tous les
ajustements effectués avec l'outil glisser affecteront tous les clones. 
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Clones et texte
Les clones de texte disposent d'une fonction spéciale. Lorsque le texte est modifié de quelque manière que ce soit, les
clones sont modifiés également.

 

Clones et effets
Vous ne pouvez pas cloner un effet mais vous pouvez appliquer un effet à un clone.

Le clone avec effet réagira aux modifications apportées à l'original et, par conséquent, l'effet sera recalculé.
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Découpage

Cette fonctionnalité permet de diviser les objets vectoriels, les effets spéciaux, les bitmaps et leurs combinaisons en
différentes parties.
Il est même possible d’appliquer plusieurs découpages les uns après les autres pour créer vos propres effets. Le
découpage étant un effet spécial, les objets d’origine ne sont pas touchés. Vous pouvez supprimer le découpage à
tout moment.

Les exemples ci-dessous illustrent la possibilité d’appliquer plusieurs niveaux de découpage à plusieurs objets.

Original

Avec découpage horizontal

Avec découpage horizontal et vertical

Avec découpage horizontal, vertical et radial

Application d’un découpage

Sélectionnez les objets auxquels vous souhaitez appliquer un découpage. Sélectionnez ensuite le menu « Effets,
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Découpage » et choisissez un des sous-menus.

Le dernier découpage utilisé est appliqué aux objets sélectionnés. Pour ajuster ce découpage, sélectionnez l’option
« Propriétés » dans le menu contextuel. Vous pouvez également modifier le découpage directement à l’écran par le
biais des nœuds de contrôle, mais la boîte de dialogue contient plus d’options et améliore le contrôle.

L’option « Type » (1) contient les trois principales catégories de découpage. Lorsque vous sélectionnez un de ces
sous-types, les autres options de la boîte de dialogue sont activées.

Objet d’origine, le contour noir supplémentaire indique la frontière.

A Linéaire

2 Divers

Facteur d 'utilisa tion

Cette option permet de déterminer le ratio entre les rayures et les vides.

Facteur d 'utilisa tion : 50 %
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Facteur d 'utilisa tion : 25 %

Facteur d 'utilisa tion : 75 %

Variabilité

Cette option permet de déterminer le ratio entre la largeur de la première et de la
dernière rayure.

Variab ilité  : 0 %

Variabilité  : 100 %

Angle

Cette option permet de définir l’angle.
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Angle  : 0 degré

Angle  : 45 degrés

4 Nombre de

rayures

Le nombre de rayures devant être utilisées.

Rayures : 4

Rayures : 8

V ides

Cette option permet d’ajouter ou de supprimer un vide dans le découpage. De cette
manière, vous pouvez mieux contrôler la manière dont le découpage remplit un objet.

V ide  : 0, autant de  v ides que  de  rayures
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V ide  : -1, un v ide  en m o ins

V ide  : +1, un v ide  supplém enta ire

B Conique

2 Divers

Voir « Linéraire » pour plus d’informations.

Quelques exemples :

Facteur d 'utilisa tion : 50, Variab ilité  : 0 % , Angle  : 0 degré

Facteur d 'utilisa tion : 50, Variab ilité  : 50 % , Angle  : 15 degrés

Facteur d 'utilisa tion : 75, Variab ilité  : 0 % , Angle  : 0 degré
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4 Nombre de

Voir « Linéraire » pour plus d’informations.

Avec un découpage conique, vous pouvez uniquement définir le nombre de rayures
dans cette option.

Rayures : 16

5 Centrer

Vous disposez de plusieurs options pour influencer le centrage du découpage. Dans
l’exemple ci-dessous, le centre est défini sur
 x : -50 % et y : +50 %. Vous pouvez entrer des pourcentages de largeur et de
hauteur de la sélection, des valeurs numériques, des coordonnées absolues ou
relatives (à la sélection).

C Radial

Cette option contient les sous-options « Normal », « Polygone » et « Etoile ».

2 Divers

Voir « Linéraire » pour plus d’informations.

3 Rayon

Permet d’entrer le rayon externe et interne (vertical) mais aussi le rayon horizontal. Le
ratio entre le rayon externe et horizontal détermine le format de l’image.

Ex te rne  : 100 % , Inte rne  : 5 % , Horizonta l : 100 %
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Ex te rne  : 100 % , Inte rne  : 5 % , Horizonta l : 200 %

Ex te rne  : 200 % , Inte rne  : 5 % , Horizonta l : 100 %

6 Etoile/Polygone

Cette option groupée devient active si vous sélectionnez « Etoile » ou « Polygone ». 

Nbre  d 'angles

Définit le nombre d’angles.

Nbre  d 'angles : 5

Nbre  d 'angles : 10

Am plitude

Ce paramètre influence la forme interne de « l’Etoile » ou du « Polygone ». 
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Am plitude  : 50 %

Am plitude  : 0 %

Am plitude  : 100 %

Le découpage étant très souple et s’appliquant à la plupart des types d’objets, c’est également une fonction de
conception multi usage qui ne se limite pas aux tâches de découpe.

Arrondi

Les angles des formes vectorielles peuvent être arrondis sans toucher aux objets d’origine. Si une ligne droite est reliée à une courbe, cette

ligne est également arrondie. Sélectionnez un objet dont vous souhaitez arrondir les angles.
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Sélectionnez ensuite l’option « Arrondi » dans le menu « Effets ».

Le curseur passe en mode « outil de déplacement » et les nœuds de contrôle de l’arrondi apparaissent autour de l’objet. Les derniers

paramètres d’arrondi utilisés sont automatiquement appliqués. Vous pouvez également ajuster l’arrondi via une boîte de dialogue. Vous avez

alors la possibilité de choisir entre des angles arrondis et des angles « biseautés».

En exagérant l’arrondi, vous pouvez même créer des formes totalement nouvelles.

L’arrondi s’applique à tous les objets vectoriels. Les objets standard tels que l’étoile peuvent donc également être utilisés pour créer des

formes totalement nouvelles.

Etant donné que l’effet d’arrondi, comme tous les autres effets, ne touche pas aux objets d’origine, vous pouvez ajuster l’objet d’origine par
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le biais de la combinaison CTRL+CLIC ou via le Gestionnaire d’objets.

Modèles

Assistant des modèles
A s s i s t a n t  d e s  m o d è l e s

A l'aide de l'Assistant des modèles, vous pouvez modifier facilement l'un des nombreux modèles fournis ou un modèle
personnalisé. Vous pouvez changer le texte et les objets d'un modèle en entrant un nouveau texte ou en choisissant
un autre fichier clipart. L'Assistant de modèles vous permet même de modifier les dimensions ou la taille des pages,
de dupliquer ou remplir une page à l'aide de copies d'un modèle.

Sélectionnez "Fichier, Nouveau à partir du modèle" pour ouvrir l'Assistant des modèles. Dans la boîte de dialogue qui
s'affiche, vous pouvez parcourir les fichiers modèles à l'aide d'aperçus des modèles. 
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1 Favoris, en cliquant sur "+", vous pouvez ajouter le dossier actuellement sélectionné à vos favoris. La
prochaine fois que vous ouvrirez cette boîte de dialogue, vous pourrez accéder directement à un dossier en le
sélectionnant dans la liste des favoris.

2 Vous pouvez parcourir l'arborescence de votre système pour accéder au dossier.
3 Vous pouvez afficher ici les aperçus des fichiers modèles dans le dossier actuellement sélectionné.

Sélectionnez le modèle que vous souhaitez utiliser et cliquez sur "OK".
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La première fois que vous ouvrez l'Assistant des modèles, une page d'accueil s'affiche. Vous pouvez activer
l'option permettant de ne plus afficher la page d'accueil (1). Le nombre de pages qui s'affichent dans l'Assistant
dépend des options choisies et du nombre d'objets remplaçables inclus dans le modèle sélectionné.

Pour chaque texte doté de la propriété "Remplaçable", une page s'affiche dans l'Assistant. Sur cette page, vous
pouvez changer le texte et la police.
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1 Affiche l'emplacement du texte dans le modèle en mode aperçu.
2 Texte dans le modèle.
3 Texte modifié.
4 Rétablit le texte original.
5 Change la police.

Lorsqu'une police n'existe pas sur votre système, un point d'interrogation apparaît dans la liste et vous êtes invité à
remplacer cette police par une police existante.

Lorsque tous les objets texte du modèle sont traités, vous obtenez une page contenant une image clipart remplaçable
(si elle existe dans le modèle).
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1 Affiche l'emplacement de l'image clipart dans le modèle en mode aperçu.
2 Vous pouvez choisir ici si vous souhaitez remplacer l'image clipart.
3 Ouvre une boîte de dialogue dans laquelle vous pouvez rechercher et sélectionner des images clipart.

Si vous ne sélectionnez pas d'autre image clipart, celle du modèle sera utilisée.



322 EasySIGN

1 Sélectionnez une dimension prédéfinie pour le modèle.
2 Entrez vos dimensions prédéfinies.
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1 Sélectionnez une taille de page prédéfinie.
2 Définissez une taille de page personnalisée.
3 Taille des pages de requête à partir de vos périphériques de sortie.
4 Sélectionnez l'orientation de page.

Si vous ne changez aucune propriété, la taille et l'orientation de page du modèle seront utilisées.
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Vous pouvez multiplier ici le modèle en entrant un chiffre ou laisser le programme calculer le nombre de modèles
nécessaire pour remplir la taille de page sélectionnée. Vous pouvez également définir la marge de la page et l'espace
entre les modèles.

Si vous ne modifiez aucune propriété, seule une copie du modèle sera utilisée.

Création de modèles
C r é a t i o n  d e  m o d è l e s

Créer vos propres modèles est très facile. Tout nouveau texte entré sur votre feuille de travail est automatiquement
remplaçable. Vous pouvez désactiver cette option en sélectionnant "Organiser, Modèles, Annuler la propriété
remplaçable". Si vous souhaitez activer cette option pour du texte ou des objets, sélectionnez "Organiser, Modèles,
Affecter la propriété remplaçable".
Enregistrez maintenant la feuille de travail en tant qu modèle en sélectionnant "Fichier, Enregistrer sous, Fichier
modèle". Si vous ouvrez ce fichier avec la commande "Fichier, Nouveau à partir du modèle", l'Assistant affiche une
page pour chaque texte et objet dont la propriété "Remplaçable" a la valeur Vrai.

Importation et exportation spéciales

Exportation de PDF Adobe™
E x p o r t a t i o n  d e  P D F  A d o b e ™

Vous pouvez exporter une feuille de travail à partir de EasySIGN vers un fichier PDF (Portable Document Format).
Notez que seuls les objets placés sur une page seront exportés correctement. Le format PDF ne peut pas afficher les
objets placés à l'extérieur d'une page.
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Sélectionnez "Fichier, Exportation". Dans la boîte de dialogue, sélectionnez sous "Type de fichier" le filtre "(Portable
Document Format) (*.PDF)” et entrez le nom du fichier PDF que vous souhaitez exporter. Lorsque vous appuyez sur
le bouton "Exporter", la boîte de dialogue suivante s'affiche :

1 Dégradés
Utiliser les vecteurs sous ... étapes.
Le format PDF gère les dégradés de manière globale. Ces dégradés sont beaucoup plus petits que les dégradés
vectoriels mais ils ne sont jamais identiques aux dégradés de votre feuille de travail. Si vous souhaitez que les
dégradés soient identiques à ceux de votre feuille de travail, veillez à entrer ici un chiffre supérieur au nombre
d'étapes de remplissage en dégradé de votre feuille de travail. Lorsque vous utilisez des paramètres par
défaut, 300 étapes est un nombre suffisant.

Convertir les dégradés en ...
Le format PDF ne reconnaît que les espaces colorimétriques RVB et CMJN. Si vous avez utilisé un remplissage
HSB irisé dans votre feuille de travail, il doit être converti à l'un des espaces colorimétriques mentionnés. CMJN
est normalement la méthode la meilleure et la plus précise.

2 Bitmaps
Compression
Vous avez le choix entre "Aucune" et compression "JPG" . Si vous envisagez de transmettre le fichier PDF à un
bureau de services, choisissez de préférence "Aucune". Le fichier PDF sera plusieurs fois plus grand qu'un
fichier compressé mais les bitmaps de votre feuille de travail seront exactement les mêmes sur la machine du
bureau de services que sur votre propre machine et dans votre feuille de travail. L'utilisation de la compression
peut entraîner la perte de données. 
 
Qualité
Vous pouvez définir ici la force de la compression.

Courrier électronique

Configuration des courriers électroniques
C o n f i g u r a t i o n  d e s  c o u r r i e r s  é l e c t r o n i q u e s

Avec le système de courrier électronique de EasySIGN, vous pouvez rapidement et facilement envoyer une feuille de travail active en tant

que pièce jointe dans un courrier électronique ou envoyer un aperçu pour accord à votre client.

Avant d’utiliser cette fonctionnalité, vous devez définir certains paramètres. Sélectionnez le menu « Fichier, Envoi vers, Paramètres de la

messagerie électronique ».

Onglet Paramètres HTML
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1 Vous pouvez indiquer ici à quel moment vous souhaitez que le logiciel vous avertisse que les pièces jointes sont

trop volumineuses. Rappelez-vous que la plupart des fournisseurs d’accès limitent la capacité des messageries

électroniques. En outre, vos clients préfèrent ne pas recevoir des courriers électroniques volumineux de plusieurs

Mo.

2 HTML

Pièce jointe :

Indiquez ici si vous souhaitez utiliser un modèle HTML lorsque vous envoyez la feuille de travail en tant que pièce

jointe, et le cas échéant, précisez lequel.

Aperçu :

Permet de sélectionner le modèle que vous souhaitez utiliser lorsque vous envoyez la feuille de travail en aperçu.

Codage :

Permet de sélectionner le code du pays dans lequel vous vivez.

Cette sélection doit correspondre aux paramètres du modèle HTML que vous utilisez.

Reportez-vous aux paramètres par défaut et aux modèles fournis en exemple.

3 Interface

Compatible EML :

Permet d’ouvrir les courriers électroniques dans votre application compatible .EML. Sur la plupart des ordinateurs, il

s’agit d’Outlook Express™.

L’avantage de cette option est que vous pouvez modif ier le contenu comme vous le souhaitez avant d’envoyer vos

courriers électroniques.

Vous pouvez ignorer les paramètres de l’onglet « Paramètres SMTP », mais vous devez définir les paramètres

correspondants dans votre application compatible .EML.

SMTP directe :

Cette option permet d’ouvrir les courriers électroniques dans l’environnement de travail de EasySIGN. Vous pouvez

modif ier le modèle sélectionné avant d’envoyer vos courriers électroniques. Si vous choisissez cette option, vous

devez également définir les paramètres de l’onglet « Paramètres ».
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4 Aperçu :

Permet d’indiquer la largeur maximale en pixels et la résolution de l’aperçu de la feuille de travail. 

Onglet Paramètres SMTP

Ces paramètres doivent être définis uniquement lorsque vous sélectionnez « Connexion SMTP directe » dans l’onglet « Paramètres HTML ».

Ces paramètres doivent être définis uniquement si vous n’avez pas accès à un client compatible .EML tel que Outlook Express, ou si vous ne

souhaitez pas l’utiliser. Nous vous conseillons de contacter votre fournisseur d’accès si vous rencontrez des problèmes. Il peut vous fournir

les informations nécessaires.

Si vous utilisez ce logiciel au sein d’un réseau d’entreprise avec Exchange Server, contactez votre administrateur réseau.

1 Expéditeur

Nom :

Entrez le nom apparaissant dans le champ « De : » d’un courrier électronique. Il s’agit souvent du nom de votre

entreprise.

 

Adresse E-mail :

Entrez votre adresse e-mail.

Méthode d'authentification :

Le moyen de connexion utilisé par votre fournisseur d’accès.

Choisissez l’une des options suivantes :

AUCUNE : Si votre fournisseur d’accès prend en charge les connexions anonymes. Cela se produit

occasionnellement.

CRAM MD5 : Cette méthode est adaptée si vous souhaitez vous connecter à un serveur LDAP.

AUTH LOGIN : Cette méthode est adaptée dans la plupart des cas. Votre nom d’utilisateur et votre mot de
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passe sont cryptés.

PLAIN LOGIN : Identique à AUTH LOGIN, seuls votre nom d’utilisateur et votre mot de passe sont cryptés.

Cette option n’est pas recommandée.

Nom d'utilisateur :

Entrez votre nom d’utilisateur. Vous pourrez le trouver dans la lettre envoyée par votre fournisseur d’accès. Dans

le cas contraire, contactez-le.

Mot de passe :

Entrez votre mot de passe. Vous pourrez également le trouver dans la lettre envoyée par votre fournisseur

d’accès.  Si vous ne le trouvez pas ou que vous l’avez modif ié, contactez votre fournisseur d’accès.

2 Serveur

Nom/adresse de l'hôte :

Entrez le nom de votre serveur SMTP. Il s’agit souvent de 'smtp.domaine.com', où vous devez remplacer domaine

par le nom de votre fournisseur d’accès. Consultez la lettre de votre fournisseur. Si utilisez le réseau d’une

entreprise, vous pouvez entrer l’adresse IP ou le nom WINS du serveur.

Numéro de port :

Entrez le numéro de port utilisé par le serveur smtp permettant de recevoir des courriers électroniques. Il s’agit

souvent de 25. Contactez votre fournisseur d’accès en cas de problème.

3 Carnet d'adresses

WAB :

Sélectionnez cette option si vous souhaitez utiliser le carnet d’adresses Window s™.

Contacts Outlook™ :

Sélectionnez cette option si vous souhaitez utiliser la liste de contacts d’Outlook™.

4 Connexion :

Activez cette option si vous souhaitez que ce programme se connecte automatiquement à votre fournisseur

d’accès si aucune connexion n'est ouverte à ce moment-là.

Modèles de courriers électroniques HTML
M o d è l e s  d e  c o u r r i e r s  é l e c t r o n i q u e s  H T M L

Le système de courrier électronique de EasySIGN utilise des modèles HTML. Grâce aux modèles HTML, vous pouvez inclure toutes les

informations requises sur l’entreprise dans la présentation d’une conception que vous souhaitez envoyer à vos clients.

Pendant l’installation de EasySIGN, plusieurs exemples de modèles HTML sont installés dans le sous-répertoire « \HtmlTemplates\ » du

répertoire de programmes. Ces modèles contiennent un faux texte (en fait, l’espace réservé à votre propre texte) et un exemple de logo. Les

images, telles que l’exemple de logo, sont placées dans le sous-répertoire « \HtmlTemplates\images\ ». Vous devez définir un modèle avant

de l’utiliser, ou bien vos clients seront surpris de découvrir le faux texte des exemples. Vous pouvez procéder à un test en vous envoyant à

vous-même un modèle existant par courrier électronique.

Adaptation/Création d’un modèle HTML
L’adaptation ou la création d’un modèle sont totalement libres. Un modèle HTML doit au moins contenir le texte suivant (littéralement) :

<<|InsertWorksheetImageHere|>>

Ce texte permet de signaler l’endroit où le programme doit insérer l’aperçu de la feuille de travail (image) dans le modèle HTML.

Un autre marqueur, ou espace réservé, vous permet d’ajouter un texte non standard dans votre courrier électronique avant de l’envoyer.

Ce texte s’aff iche toujours à un emplacement f ixe du courrier électronique et est identif ié dans le modèle par le texte suivant (littéralement) :

<<|InsertAdditionalBodyHere|>>

Attention
Pour éviter des problèmes, vous devez utiliser une syntaxe HTML correcte. L’utilisation d’un éditeur HTML professionnel, tel que

« Dreamw eaver™ », est recommandée. En cas de problème lors de la conversion du modèle HTML en courrier électronique, vérif iez la

syntaxe HTML. Une syntaxe non correcte est souvent à l’origine du problème.

Etant donné que le modèle HTML ne peut être modif ié qu’une fois, vous pouvez sous-traiter cette tâche à un bureau externe si vous ne

maîtrisez pas le langage HTML.

Si aucune des options ci-dessus ne vous convient, vous pouvez utiliser le modèle HTML « basic.htm ».
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Ce modèle contient uniquement un marqueur (espace réservé) pour l’aperçu de la feuille de travail, et un pour le texte supplémentaire. Dans

la boîte de dialogue de courrier électronique de EasySIGN, vous pouvez entrer le texte de votre choix pour chaque nouveau courrier

électronique.

J’utilise déjà d’autres modèles de courrier électronique, que dois-je faire ?
Si vous utilisez déjà d’autres modèles de courrier électronique de l’entreprise, par exemple dans Outlook™ (à ne pas confondre avec

Outlook Express™ qui est gratuit), vous pouvez facilement inclure un aperçu d'une feuille de travail dans ces modèles. Sélectionnez la partie

de la feuille de travail (ou la totalité de la feuille de travail) que vous souhaitez inclure en aperçu dans votre modèle. Sélectionnez le menu

« Modif ier, Copie spéciale, En tant que bitmap dans le Presse-papiers ». Comme l’indique ce nom, votre sélection est copiée dans le Presse-

papiers en tant que bitmap, d’où vous pourrez ensuite la copier dans votre courrier électronique. La disponibilité du menu dépend du type de

licence de EasySIGN.

Configuration du courrier électronique
C o n f ig u r a t io n  d u  c o u r r ie r  é le c t r o n iq u e

Suivez les étapes ci-dessous pour configurer le système de courrier électronique de EasySIGN.

Etape 1
Définissez les paramètres nécessaires. Ceci ne doit être fait qu’une seule fois. Voir le chapitre « Configuration des courriers

électroniques ».

Etape 2
Créez un modèle HTML correspondant au style de votre entreprise. Ceci ne doit être fait qu’une seule fois.

Voir le chapitre « Modèles de courriers électroniques HTML ».

Etape 3

Envoyer la feuille de travail active sous forme de pièce jointe
Cette option est utile uniquement si le destinataire dispose également d’une licence utilisateur pour EasySIGN. Sinon,
le client à qui vous souhaitez présenter une conception ne pourra pas ouvrir le fichier EasySIGN que vous aurez joint
à votre courrier électronique. Utilisez la seconde méthode de présentation.

Sélectionnez le menu « Fichier, Envoi vers, Adresse e-mail (sous forme de pièce jointe) ».

Dans le cas d’un client compatible .EML

Votre client compatible .EML s’ouvre avec la feuille de travail actuelle en pièce jointe. Si vous avez choisi cette

option, un modèle sera utilisé pour le corps du courrier électronique.

Dans le cas d’une connexion SMTP directe

Une boîte de dialogue s’ouvre dans EasySIGN, où vous pouvez entrer les paramètres du courrier électronique tels

que « A », « Cc » et « Cci ».  Vous pouvez là aussi sélectionner un modèle pour le corps du courrier électronique.

Voir « Boîte de dialogue SMTP » pour connaître la procédure.

Si vous n’utilisez pas de modèle avec cette méthode, vous n’avez pas à remplir le champ « Corps de texte
supplémentaire », car il est utilisé uniquement avec les modèles.

Envoyer la feuille de travail active (ou une partie de celle-ci) sous forme d’aperçu à votre client
Utilisez cette option si vous souhaitez envoyer un aperçu pour accord à votre client. Toute personne disposant d’un
client de messagerie électronique prenant en charge les courriers électroniques au format HTML (presque tous les
clients modernes le peuvent), verra l’aperçu.
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Sélectionnez le menu « Fichier, Envoi vers, Adresse e-mail (aperçu dans le modèle) ». 

Dans le cas d’un client compatible .EML

Votre client compatible .EML s’ouvre avec un aperçu de la feuille de travail actuelle à l’emplacement de l’espace

réservé à cet effet (<<|InsertWorksheetImageHere|>>).

Dans le cas d’une connexion SMTP directe

Une boîte de dialogue s’ouvre dans EasySIGN, où vous pouvez entrer les paramètres du courrier électronique tels

que « A », « Cc » et « Cci ».  Vous pouvez là aussi sélectionner un modèle pour le corps du courrier électronique.

Dans le courrier électronique f inal, l’espace réservé aux aperçus sera remplacé par un aperçu de la feuille de

travail active.

Voir « Boîte de dialogue SMTP » pour connaître la procédure.

Boîte de dialogue SMTP
La boîte de dialogue SMTP et ses différents composants sont illustrés ci-dessous.
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Priorité du courrier électronique « Basse ».

Priorité du courrier électronique « Normale ».

Priorité du courrier électronique « Elevée ».

Ouvre un aperçu du courrier électronique dans Internet Explorer™.

Enregistre le courrier électronique sur le disque en tant que f ichier .EML.

Vide le champ « Pièces(s) jointe(s) ».

Ouvre la boîte de dialogue des paramètres.

1 Modèle :

Sélectionnez le modèle que vous souhaitez utiliser.

2 Pièce(s) jointe(s) :

Sélectionnez les pièces jointes autorisées.

3 Informations :

Entrez les informations standard sur le courrier électronique. Pour ouvrir le carnet d’adresses, cliquez sur les

boutons « A », « Cc » et « Cci ».

4 Corps de texte supplémentaire :

Ce champ est utile uniquement si vous utilisez l’espace réservé <<|InsertAdditionalBodyHere|>> dans votre

modèle HTML. L’espace réservé est remplacé par ce texte.
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Transparence

Transparence des objets vectoriels et des bitmaps
T r a n s p a r e n c e  d e s  o b je t s  v e c t o r ie ls  e t  d e s  b it m a p s

EasySIGN intègre des fonctions précises et très avancées permettant d’appliquer et de gérer la transparence. La
transparence peut être appliquée à tous les objets d’une feuille de travail, notamment les groupes, les effets et le
style de ligne des objets. Plusieurs modes de transparence sont disponibles. 

1 Transparence uniforme

2 Dégradé transparent

3 Motif transparent

4 Bitmap transparent à l’aide des canaux alpha

1 : Transparence uniforme

Cette forme de transparence peut être appliquée à n’importe quel objet. La procédure est la suivante :

Sélectionnez l’objet (ou les objets) auxquels vous souhaitez appliquer la transparence.

Ensuite, sélectionnez l’outil de transparence dans la boîte à outils.

Une boîte de dialogue f lottante permettant de gérer la transparence apparaît.

La transparence est définie par défaut sur « Aucune ». Remplacez-la par « Uniforme ».
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Sur la feuille de travail, la transparence de l’objet prendra la valeur par défaut 50 %. Si vous réduisez cette valeur à 20 %, l’objet sera moins

transparent. Pour ce faire, entrez la valeur 20, puis appuyez sur Entrée.

Si vous remplacez la valeur de transparence par 80 %, l’objet deviendra presque invisible. La valeur 100 % le rendra complètement

transparent.

Cliquez maintenant sur l’outil de sélection de la boîte à outils (ou appuyez sur « Echap »)… La boîte de dialogue Transparence disparaît et

l’objet est à nouveau sélectionné.

Appliquez maintenant un style de ligne à l’objet transparent.
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Comme vous pouvez le voir, le style de ligne est également transparent. Vous allez maintenant modif ier les propriétés de la transparence.

Cette méthode est toujours la même. Vous devez d’abord sélectionner l’objet transparent, puis cliquer sur l’outil de transparence dans la

boîte à outils.

Remplacez la valeur de transparence par 50 % (1).

Dans la zone de liste modif iable (2), sélectionnez « Remplissage ». Maintenant, seul le style de remplissage est transparent.

Dans la zone de liste modif iable (2), sélectionnez « Crayon ». Maintenant, seul le style de trait est transparent.
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Vous pouvez supprimer la transparence d’un objet en le sélectionnant, puis en cliquant sur l’outil de transparence et en choisissant l’option

« Aucune » dans la première zone de liste modif iable.

Sur la gauche apparaît un groupe d’objets complexes sans transparence et sur la droite apparaît le même groupe avec transparence.

La transparence peut bien sûr être appliquée à une combinaison de bitmaps et d’objets vectoriels.

2 : Dégradé transparent

La procédure d’application d’un dégradé transparent est similaire à celle de la transparence uniforme, avec toutefois quelques

fonctionnalités supplémentaires.

Sélectionnez l’objet que vous souhaitez rendre transparent.
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Sélectionnez l’outil de transparence dans la boîte à outils et sélectionnez l’un des dégradés transparents en option.

(Linéaire, Radial, Carré ou Conique).

Comme pour les dégradés standard, vous pouvez faire glisser les poignées pour définir la direction de la transparence. Vous pouvez le

faire directement à l’écran ou en utilisant la boîte de dialogue Dégradé.

Dans la boîte de dialogue Transparence, les options suivantes sont disponibles :

1 Permet de sélectionner différents types de transparence.

2 Transparence de départ en pourcentage

3 Transparence de f in en pourcentage

4 Elément auquel la transparence doit être appliquée : Remplissage, Crayon ou les deux.

5 Options supplémentaires. Si vous sélectionnez un remplissage transparent, la boîte de dialogue Dégradé s’ouvre.
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Sur la gauche apparaît un groupe d’objets complexes sans transparence et sur la droite apparaît le même groupe avec transparence.

La transparence peut bien sûr être appliquée à une combinaison de bitmaps et d’objets vectoriels.

3 : Motif transparent

Un motif transparent s’applique de la même manière qu’une transparence uniforme ou un dégradé transparent.

Au niveau de (1), sélectionnez « Motif ».

Lorsque l’option « Motif » est activée, un bitmap en noir et blanc est utilisé par défaut comme motif transparent. Lorsqu’un bitmap en noir est

blanc est utilisé, les options (2) et (3) sont disponibles dans la boîte de dialogue. Elles permettent de définir la densité des pixels en noir et

blanc. Dans l’exemple, une transparence de 50 % est utilisée pour les pixels blancs.



338 EasySIGN

Cliquez maintenant sur le bouton des options supplémentaires pour ouvrir la boîte de dialogue Remplissage mosaïque et appliquer un autre

motif transparent.

Le bitmap choisi est en niveaux de gris, les options (2) et (3) ne sont donc plus disponibles.

Vous pouvez modif ier les options directement à l’écran ou via la boîte de dialogue Remplissage mosaïque.
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Sur la gauche apparaît un groupe d’objets complexes sans transparence et sur la droite apparaît le même groupe avec transparence.

La transparence peut bien sûr être appliquée à une combinaison de bitmaps et d’objets vectoriels.

4 : Bitmap transparent avec canaux alpha

EasySIGN prend non seulement en charge l’importation de bitmaps avec canaux alpha, mais il vous permet également de créer vous-même

des canaux alpha.  Un canal alpha peut être créé à partir de n’importe quel objet.

Importez d’abord un bitmap. Il peut s’agir d’un bitmap sans canal alpha.
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Créez maintenant une fusion simple entre deux rectangles de largeur différente. Cette fusion ne doit pas être ajoutée sur le bitmap, mais peut

être positionnée n’importe où sur la feuille de travail.

Sélectionnez le bitmap, puis cliquez sur les options de menu « Bitmap », « Transparence », « Choisir… ». La souris changera de forme.

Utilisez-la pour sélectionner la fusion.

1 Positionner

Non modifié

Cette option peut être utilisée si les objets du canal alpha sont déjà correctement positionnés sur le bitmap.

Ajuster

Cette option permet d’ajuster les objets sélectionnés pour le canal alpha par rapport à la largeur et à la hauteur du

bitmap.

Aligner

Cette option permet d’aligner les objets sélectionnés pour le canal alpha sur le bitmap, en utilisant la sélection

effectuée dans la palette d’alignement.

2 Aperçu
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Permet de voir un aperçu du résultat f inal. Vous avez le choix entre « avant » et « après ».

3 Couleur initiale du canal Alpha

Cette option permet de définir le comportement du canal alpha lorsqu’aucun objet ne le recouvre. Vous avez le

choix entre noir et blanc.

4 Combiner

Inverser

Tous les objets blancs deviendront noirs et les objets noirs deviendront blancs, afin d’inverser la transparence. Les

valeurs en niveaux de gris sont également prises en compte.

Remplacer

Il est possible d’appliquer une quantité illimitée d’objets au canal alpha, mais si vous activez cette option tous les

canaux alpha existants seront remplacés par la sélection actuelle.

Ajouter

Lorsqu’un canal alpha existe déjà, cette option permet de lui ajouter la sélection actuelle.

Soustraire

Lorsqu’un canal alpha existe déjà, cette option permet d’en retirer la sélection actuelle.

Intersection

Lorsqu’un canal alpha existe déjà, la sélection actuelle y est insérée.

5 Divers

Supprimer les objets choisis

Supprime la sélection active après l’avoir appliquée au canal alpha.

anticrénelage

Cette option est recommandée. Elle évite les effets « d’escalier » dans le canal alpha. Si vous utilisez uniquement

des objets verticaux et horizontaux (comme les carrés), cette option peut être désactivée.

Choisir un autre objet (1)

Lorsque cette option est activée, vous pouvez sélectionner un autre objet pour le canal alpha immédiatement après

avoir cliqué sur OK.

Appliquer les objets maintenant

Cette option est disponible si vous activez « Choisir un autre objet (1) ». La première sélection sera appliquée avant

de pouvoir faire une nouvelle sélection.

Pour le canal alpha de notre exemple, nous avons choisi les options suivantes :

1 Ajuster

2 Blanc

3 Inverser/remplacer

5 Anticrénelage

Dessinez maintenant une ellipse, sélectionnez le bitmap et choisissez le menu « Bitmap », « Transparence », « Choisir… ».

Sélectionnez les options suivantes :

1 Ajuster

2 Blanc

3 Inverser/Ajouter

5 Anticrénelage
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Dans le menu « Bitmap, Transparence… », les options suivantes sont disponibles :

Afficher

Permet d’activer ou de désactiver l’utilisation du canal alpha.

Inverser

Permet d’inverser la transparence.

Recadrer

Cette option permet de réduire la taille du bitmap autant que possible, en utilisant les limites du canal alpha.

Choisir

Voir la description complète ci-dessus.

Détacher

Cette option permet de détacher le canal alpha du bitmap.

Ces options sont également accessibles via le menu contextuel du bitmap.

Paramètres de la transparence

Si vous souhaitez imprimer des transparences ou les exporter vers d’autres applications, vérif iez les paramètres associés. Sélectionnez le

menu « Fichier », « Paramètres » et choisissez l’onglet « Sortie ». Il contient la zone de groupe « Transparence/Motif de remplissage » qui

fournit les options suivantes :

Calculer en tant que : RVB ou CMJN

Permet de définir si la transparence sera calculée en tant que RVB ou CMJN. Pour des résultats

plus précis, choisissez CMJN.

Résolution PPP

La configuration optimale est 300 PPP. Toutefois, sur de grandes feuilles de travail telles que

celles utilisées pour les impressions grand format, une résolution de 72 PPP suff ira, en

particulier lorsque le résultat est vu à distance, comme un panneau d’aff ichage.

Intersection complète en

tant que bitmap

Si vous activez cette option, la transparence sera appliquée de manière optimale. Si vous

n’utilisez pas cette option, des différences de couleur pourront apparaître dans les feuilles de

travail complexes où différents objets transparents se chevauchent.

Anticrénelage Cette option permet d’avoir le meilleur aperçu de la transparence, avec un anticrénelage. Si

vous n’utilisez pas cette option, un « effet d’escalier » peut ressortir dans le résultat.

Dans EasySIGN, la transparence est calculée avec une précision maximale pour garantir la meilleure qualité possible lors de l’exportation

vers d’autres formats. C’est pourquoi le rendu peut prendre un certain temps lorsque la feuille de travail contient de nombreux objets

transparents. Vous pouvez réduire ce délai en diminuant par exemple la résolution de l’exportation.

Compatibility

Configuration de Compatibility
C o n f i g u r a t i o n  d e  C o m p a t i b i l i t y

L'installation de « Compatibility » pour chaque programme pris en charge s'effectue durant la configuration de EasySIGN. Pendant la

configuration, vous pouvez choisir le programme pour lequel vous souhaitez installer « Compatibility ».

Après l'installation
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Vous pouvez démarrer « Compatibility » via « Démarrer, Tous les programmes, Compatibility », ou directement à partir de EasySIGN, via le

menu « Fichier, Compatibility ». 

Fonctionnement de “Compatibility”
F o n c t i o n n e m e n t  d e  “ C o m p a t i b i l i t y ”

Démarrez le programme souhaité par le biais du menu « Fichier, Compatibility » de « EasySIGN ».

Une icône apparaît dans la barre d’état système de Window s™ et le programme sélectionné (dans cet exemple, CorelDRAW™ 8) démarre.

Lorsque le programme souhaité ne démarre pas ou lorsqu'un message indique que le programme est introuvable, démarrez le programme

manuellement, puis « Compatibility ».

Chaque logiciel pris en charge aff iche une icône de couleur différente. L'icône est visible uniquement lorsque le programme sélectionné est

démarré.

Lorsque vous cliquez sur l'icône, le menu suivant apparaît.

1 Annuler

Ferme le menu.

2 Fermer

Permet de fermer le programme « Compatibility ».

3 Basculer vers EasySIGN.

4 Sélectionner une langue.

5 Sign Center (uniquement en combinaison avec CorelDRAW™) Cette partie sera traitée ultérieurement.

6 Exporter

Permet de placer la feuille de travail active (ou bitmap) directement dans EasySIGN.

Exceptions

Lorsque vous utilisez Macromedia Freehand™, aucune icône n’apparaît dans la barre d’état système. Le lien entre EasySIGN et ce

programme est géré par le biais du menu « Xtras, EasySIGN, Exporter ».

Dans chaque programme doit apparaître un menu supplémentaire visible. Dans Adobe Illustrator™, par exemple, vous ne pouvez exporter

que les découpables.

Logiciel vectoriel

Si vous utilisez « Compatibility » avec, par exemple, Illustrator™ ou CorelDRAW™, une copie de la feuille de travail active sera optimisée

avant d’être exportée vers EasySIGN.

Logiciel bitmap

Si vous utilisez « Compatibility » avec, par exemple, Photoshop™ ou Corel PhotoPAINT ™, une copie du bitmap actif  sera optimisée avant

d’être exportée vers EasySIGN.

Paramètres dans CorelDRAW™
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Si vous avez installé CorelDRAW™, et que vous n’avez jamais utilisé la fonction d’exportation au format Adobe Illustrator (.AI) auparavant,

vous devez le faire une fois manuellement pour initialiser les f iltres d’exportation CorelDRAW™. L’emplacement vers lequel est effectuée

l’exportation et le contenu de la feuille de travail n’ont aucune importance. Vous devez effectuer cette opération une seule fois.

Limitations d’ordre général

N’utilisez jamais plus d’une instance d’un programme pris en charge en même temps. Par exemple, si deux instances de CorelDRAW™ 10

sont ouvertes, nous ne garantissons pas que « Compatibility » fonctionnera.

Limitations des produits Adobe™

Vous ne pouvez pas exécuter deux versions différentes du même produit simultanément. Par exemple, vous ne pouvez pas exécuter

Illustrator™ 9 et Illustrator™ 10 en même temps lorsque vous utilisez « Compatibility » pour ces produits.

Gravure et échoppage

Divers
D i v e r s

Le module d'échoppage de EasySIGN est un produit qui contient toutes les méthodes de travail 2.5D. L'information

relative au traçage ne comporte que 2 dimensions, tandis qu'avec 2.5D la profondeur est ajoutée. 2.5D peut être utilisé pour

la gravure, l'échoppage ou même une application spéciale. Quelle est la signification exacte de tous ces termes ?

Gravure
La gravure est le découpage de texte et de logo dans une matière. En général, les entailles ne sont pas très profondes et

jamais elles ne traversent la matière. Certaines matières de gravure ont une couche supérieure de couleur différente qui

laisse apparaître la couche inférieure après découpage. Les étiquettes de noms et de type en sont des exemples.

Echoppage
Avec l'échoppage, la matière est traversée. C'est aussi l'enlèvement partiel de la matière.

Un objet courbe possède suffisamment d'informations pour être utilisé comme objet de traçage. La gravure nécessite
plus d'informations. Ces informations supplémentaires sont appelées "Style de production". Vous pouvez lier ce style
de production à tout objet vectoriel. Ce style de production comprend le style de remplissage, la profondeur, la
vitesse, etc. Pour l'échoppage, d'autres informations sont également nécessaires en fonction du type souhaité : un
échoppage de l'intérieur, de l'extérieur, de la vitesse, etc. Ces informations sont également contenues dans le style
de production. 

Application d'un style de production
Un style de production peut être affecté à un objet de deux manières : manuellement ou à l'aide d'un Assistant

Style de production manuel
Sélectionnez un objet vectoriel (ou un objet texte) puis l'icône de style de production.

Le menu déroulant suivant s'affiche :

Sélectionnez la première option (1).
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1 Passes
Un style de production comprend une ou plusieurs passes. Dans certains cas, une passe suffit, mais pour les
matières épaisses, plusieurs passes sont nécessaires. Les différentes passes sont illustrées dans (1). Lorsque
vous sélectionnez une passe, la boîte de dialogue affiche les paramètres de l'élément sélectionné.

2 Type de passe

A Type de passe
Ces paramètres déterminent le type de passe. Chaque type a une vocation spécifique. Ces
paramètres permettent de déterminer les opérations à effectuer avec la forme. 

Ligne
Une passe de ligne suit le contour de l'objet d'origine.

Mâ le
Cette passe suit l'extérieur d'une forme, le résultat sera la forme dessinée.

Fem e lle
Cette passe suit l'intérieur d'une forme, la forme réelle sera enlevée de la matière.
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Rem plissage  en "S"
Cette passe enlève l'intérieur d'une forme et suit un tracé en forme de "S" à travers la
matière. Cette forme sera enlevée de la matière jusqu'à une certaine profondeur seulement.

Rem plissage  de  ligne
Une forme sera remplie avec un ensemble de lignes droites, adaptées au laser et à d'autres
méthodes, lorsque la chaleur peut provoquer des problèmes.

Rem plissage  de  ligne , tr ié
Identique à "Remplissage de ligne", mais maintenant l'outil choisit le tracé le plus court à
suivre.

Rem plissage  Is land
L'intérieur complet d'une forme sera enlevé à l'aide d'un tracé en cercles concentriques de
l'extérieur vers le centre de la forme. 

B Angle
Angle des lignes de remplissage.

C Superposition des remplissages
Taille de la superposition dans laquelle les lignes séquentielles se recouvrent.

D Marge
Distance entre l'extérieur d'un remplissage jusqu'à l'intérieur d'une forme.

3 Outil

A Outil
Outil de la galerie utilisé pour effectuer cette passe.

B Pro fondeur, v ite sse  e t v ite sse  du m oteur
Ces paramètres sont généralement définis sur le périphérique. Ces paramètres généraux
peuvent être modifiés en fonction de la forme. Utilisez-les seulement lorsqu'une forme dérive
des paramètres par défaut.
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4 Zone d'amorçage

Zone  d 'am orçage
Lors de l'échoppage d'une forme, parfois il n'est pas souhaitable d'abaisser un outil exactement
dans le coin d'une forme. Cela pourrait provoquer de petites entailles. La “zone d'amorçage”
permet d'éviter cela en commençant la passe à un endroit sûr à l'intérieur ou à l'extérieur de
la forme et en avançant vers la zone de début. 

Cette option peut également être utilisée pour des matières souples. En définissant la "zone
d'amorçage" à "Si possible", vous évitez des entailles aux endroits où l'outil ralentit. 

Style de production à l'aide de l'Assistant
L'Assistant Tracé de l'outil de coupe vous aide à appliquer un outil complexe. Le nombre de possibilités fréquemment
utilisées avec les tracés de l'outil de coupe sont implémentées dans cet Assistant. Ce dernier peut être lancé à partir
de la barre d'outils ou de la boîte de dialogue des options de tracés de l'outil de coupe.
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L'Assistant vous demandera quelle action vous souhaitez effectuer et affichera des illustrations explicatives. Répondez
à ces questions et appuyez sur "Suivant" jusqu'à ce que vous accédiez au bouton "Appliquer". Lorsque l'Assistant est
lancé à partir de la barre d'outils, le tracé de l'outil de coupe s'applique à l'objet sélectionné. Lorsqu'il est lancé à
partir de la boîte de dialogue des options de tracé, le tracé est ajouté à la liste de la boîte de dialogue.

Galerie d'outils
Vous pouvez définir vos propres outils dans cette boîte de dialogue. Sélectionnez le menu "Fichier, Galerie d'outils".
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1 Galerie d'outils
 Vous trouverez ici tous les outils disponibles. Après avoir sélectionné un outil, vous pouvez modifier ses

paramètres sous "Propriétés de l'outil" (2).

2 Propriétés de l'outil

A Largeur à l'extrémité du manche de l'outil. Lorsque le manche a la même largeur partout, cette
option est désactivée.

B Largeur à la pointe de l'outil.

C Profondeur maximale à laquelle l'outil peut descendre dans la matière.

D Angle de la pointe de l'outil.

E Vous pouvez affecter une couleur à l'outil ici. La couleur de l'outil apparaît dans la feuille de
travail pour le distinguer des autres outils.

3 Vous pouvez ajouter ou supprimer ici un outil de la galerie. 
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Add an Engraver/Router
A d d  a n  E n g r a v e r / R o u t e r

To add an Engraver/Router select the menu 'File > Device Setup > 'Add Router Wizard...'.

Select from the dropdown for drivers (1) the desired device. Click 'Next'.

Select from the dropdown for Ports (1) the Port your device has been connected to. Click 'Next'.
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How this page will look depends on the selected Port from the previous page. On this page make your settings
according the manual supplied with your device.

To finish the installation of your device, click 'Finish'.
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Configuration équipement
C o n f i g u r a t i o n  é q u i p e m e n t

Select the menu 'File > Device Setup > Open...'. The following Window will become visible.

On the left open the folder 'Router/Engraver Settings' and click on 'Router/Engraver Setting 0'. On the right the
available Router/Engraver settings will become visible.

4 icônes s'affichent. Double-cliquez sur une icône pour ouvrir une boîte de dialogue.

A Tri et optimisation

1 Aucun tri
 La gravure et l'échoppage des dessins seront effectués dans l'ordre où ils ont été tracés.
2 Vitesse
 L'ordre des objets sera ajusté pour une vitesse optimale.
3 Transport de vinyle
 L'ordre des objets sera ajusté pour un mouvement minimal dans le sens de la matière.

B Paramètres par défaut
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1 Hauteur de dégagement
 Hauteur au-dessus de la matière avec les mouvements de l'outil.
2 Taux de creux
 Vitesse à laquelle l'outil descend dans la matière.
3 Vitesse de changement d'outil
 Vitesse lorsque l'outil est en haut (pas dans la matière).
4 Accélération
 Accélération maximale de l'outil, c'est important pour les coins.

C Paramètres par défaut par objet

Ces paramètres deviennent actifs lorsque les tracés de l'outil de coupe ne possèdent pas de paramètres propres dans
la boîte de dialogue des options de tracé de l'outil de coupe. Définissez l'option "Utiliser les paramètres par défaut" à
faux.

1 Profondeur
 Profondeur de l'outil.
2 Vitesse
 Vitesse de gravure et d'échoppage.
3 Moteur d'outils
 Tours par minute de l'outil.

D Affectation d'outils
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Vous pouvez définir le numéro et la position d'un outil, si votre machine est équipée d'un changeur d'outil. Le logiciel
sélectionne l'outil correct pendant un travail.

Affichage des paramètres
A f f i c h a g e  d e s  p a r a m è t r e s

Deux nouvelles qualités d'affichage sont ajoutées pour la gravure et l'échoppage.

Le paramètre "Affichage, Qualité, Tracé de l'outil de coupe" affiche l'outil de coupe et le sens de la rotation.
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Le paramètre "Affichage, Qualité, Tracé plein" affiche l'outil de coupe et la largeur de l'outil. Vous pouvez vérifier ici si
l'outil et les types de remplissage sont ceux que vous souhaitez pour le travail.

EasySIGN Print Server

EasySIGN Print Server, before you start
E a s y S I G N  P r i n t  S e r v e r ,  b e f o r e  y o u  s t a r t

Before you can start printing with the EasySIGN Print Server, either as stand-alone or as a supplement to EasySIGN,
you have to make some settings. In the following chapters we will explain what each setting does. Before you read
the following chapters, please work through the "Getting Started". As a prerequisite, you have to finish all the steps
that are explained in that manual. The "Getting Started" teaches you the basics of the EasySIGN Print Server. Also all
the necessary license tickets must have been entered, which is also explained in the "Getting Started".

We really can't emphasize enough that you have to finish the "Getting Started" to be able to understand the following
chapters. The EasySIGN Print Server is very easy to use, but you will have to gain some basic understanding first.

Note
If you've downloaded this software as a TryBuy, you can also download the "Getting Started" as a PDF file from the
download menu of http://www.easysign.com.

First use and Main screen
When you start the EasySIGN Print Server for the first time, the main screen will become visible, it will look
something like below. It might happen that you get a Wizard that asks you for a ticket. If so, please refer to the
“Getting Started” that came with the software. 
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Also, if you do not have a printer installed yet, a Wizard will come up to guide you through the procedure of installing
it. This wizard is described in the getting started and this manual assumes you have already installed a printer.

The components of this main screen are as follows. A more detailed explanation of each window will follow in the next
chapter.

Current jobs (A)
In this window all jobs will be placed that have been added, either by using a Hotfolder or by adding it manually. The
list will show a small preview for every job, as well as its name and some extra information. From this list, jobs can
be edited as well as dragged and positioned onto the prints.

Archived Jobs (B)
Once a job has been printed, it will be moved automatically to the archived jobs. This list behaves similarly to the
‘current jobs’ list, so you can place jobs, edited them and remove them. Only the name of the list, ‘Archived jobs’
signifies that the jobs have been printed already.

Installed Devices (C)
In this list, all installed printers will be shown, and you can edit every detail. A printer that is busy will shown a red
line through it, which means that the device cannot be edited at that moment.

Hotfolders (D)
A Hotfolder is a directory that is monitored by the software for files to be printed. By moving a file directly into this
directory, a new job will be created along with some default settings.

Logbook (E)
In the logbook, all significant events that occur in the print server will be shown, like starting and finishing a print, and
any error messages that might occur. The logbook has the option of being e-mailed to any mail account, enabling you
to monitor the progress from a remote location.

Print preview (F)
The most important part of the print server is the print preview which occupies the middle of the screen by default.
This preview shows an empty roll of material, ready for placement of jobs.

Print Properties (G)
This is where most of the interaction with the print server takes place. Here you will set the width and height of the
material, the stacking, start the print etc.
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User interface
U s e r  i n t e r f a c e

The user interface and placement of any window is customisable. Any window can be docked almost anywhere,
simply by clicking on its name, and dragging it to the desired position. By double-clicking on a docked window, it will
be floated above other windows. To dock a floating window, simply drag its title bar to another position. The window
placement will be shown by a blue, semitransparent box, and if it is to your liking, just release the mouse button to
dock the window.

Any Window can have the following situation: 

Floating The window is positioned over other windows, obscuring the underlying interface.
Double click the title of any window to float it.

Docked The window is positioned next to other windows. Drag any window by its title bar to
position it, a blue transparent box will show where it will be docked.

Auto Hide The window will be shown by a tab with its name on the left side of the main
window. By hovering the mouse over this tab, the window will be shown. To use this
feature, click the pin symbol in the title bar.

Hide A window can be closed by clicking the cross in its title bar. To re-enable it, use the
main menu "View > Toolbars" to re-check the menu item.
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It is also possible to change the entire look and feel of the windows in the print server. To do this, use the main menu
command "View > Icon style" and "View > Application look".

And if this does not provide you with enough customization options, you can now also customize the main menu and
toolbars. To do this, right-click the area to the right of the menu, and choose ‘Customize...’ The following dialog will
appear:

Through the tabs in this menu you can customize all menus and toolbars, or even create new ones to your liking. This
manual will not describe every option in detail, feel free to experiment until the interface is to your liking. Most tabs
have a ‘reset all’ button that will restore the original situation.

Working with jobs
W o r k i n g  w i t h  j o b s

The first thing to do when printing something is to add jobs. A job is a single file, like a PDF, JPEG or TIFF file. It has
many properties, which we will discuss in this chapter.

Adding a job
A job can be added in three different ways: by dragging it onto the job list, through the menu item "File > Add job", or
through a hot folder. Hotfolders will be discussed later on, in a separate chapter. 

To drag a file from the Windows explorer to the print server, simply drag and drop it onto the ‘job list’ or ‘Archived job
list’, like shown here:
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Or, click the main menu and go to "File > Add Job". Then, browse to the file you want to print and click it.

After a file has been added, a job will appear for it in the job list. The print server will then start to create a preview
for it, and collect some information like the size of the job and the number of pages.  It might be that the job does not
display a preview right away, as this process takes some time on larger jobs. During previewing, the job cannot be
edited, so please be patient.

After a while, the job will show ‘ready for printing’, and it will then be editable. To edit the job double-click it, or click
the edit icon.

which will show the following dialog:
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Options

A Nr of copies
How many times the current job should be repeated on the print.

B Print extra info
Select yes if you want extra info on the final print. This prints the setting, device, etc. at the bottom of
the print.

C Print cropmarks
Selecting Yes enables cropmarks on the final print.

D Cropmark type
Choose form ‘cropmarks’, ‘cropmarks and swatch bar’, or ‘Rulers’. If you are using paneling, you
should select ‘Rulers’, which will help you align the panels.

E Cropmark size
The size, around the print, of the printed cropmarks.
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Size  -  R o ta tion

A Width
The width of the current job in units. To change, type a number or use the spin buttons.

B Height
The height of the job in the currently active units.

C Width scale
The current width as a percentage of the original file size.

D Height scale
The current height as a percentage of the original file size.

E Scale proportionally
When ticked, the width and height of the job change proportionally.

F Rotation
Select the desired rotation in 90 degree steps from the combo box.

E Cropmark size
The size, around the print, of the printed cropmarks.
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Pa ne ling

A Paneling type
You can choose between ‘None’ and ‘User defined’, User defined switches the paneling to on.

B Number of panels
By changing this number, the job will automatically be divided in the specified number of panels.

C Carriage Panel size
Vertical panel line(s) in the preview. Type the positions where you want the panel lines to appear, for
example ‘50 100 150’.

D Carriage panel overlap
The overlap of the panels, these can also be negative. You can enter one value, which sets the overlap
for all panels, or multiple values if you want different overlaps. If you enter nothing or ‘0’ there will be
no overlap.

E Roll Panel Size
The position(s) of the panel lines in the roll direction.

F Roll panel overlap
The overlap of the panels in the roll direction.

G Active panels
If empty all the panels will be printed. When you enter one or more panel numbers separate by e white
space only these panels will be printed.

H Paneling In the preview window
You can manually add or remove panels by pressing the right mouse button in the preview window and
selecting a horizontal or vertical panel line from the menu. A double click will add a carriage panel line,
if you hold down the SHIFT key before double clicking, a roll panel will be added.

E Cropmark size
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The size, around the print, of the printed cropmarks.

Co lo r  co rre ction
All the different color corrections will be applied on top of the color management. As with all settings, you can see the
result in the preview window. This might take a few seconds, especially when the job file is large.

A Brightness
The brightness of the job, ranges from -100 to +100.

B Contrast
The contrast of the job, ranges from -100 to +100.

C Saturation
The saturation of the job, ranges from -100 (no color at all) to +100 (very bright color).

D Hue
The hue (color shift) of the job, ranges from -180 to +180.

E Color temperature
The temperature (‘warmth’) of the job, ranges from -4000K (very warm) to +4000K (very cold).

F Grayscale
Tick this box if you want the entire job to output in grayscale.

E Cropmark size
The size, around the print, of the printed cropmarks.
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Input ICC pro file
The following settings are color management related, and this manual is not intended as a complete guide. For a more
complete explanation of color management, see also the document “Calibration training”.

A CMYK bitmap input profile
A combo box from which you can select the desired input profile for CMYK bitmaps. All profiles on your
system, including the profiles from the EasySIGN "Shared" directory, are listed here.

B RGB bitmap input profile
A combo box from which you can select the desired input profile for RGB bitmaps.

C Grayscale bitmap input profile
A combo box from which you can select the desired input profile for Grayscale bitmaps.

D Bitmap render intent
The render intent for bitmaps. You can choose from the following:

Pe rce ptua l
All colors in a device’s gamut will be scaled to the output gamut, keeping the relation between the
colors intact. This method is recommended for reproducing scanned or imported bitmaps.

R e la tiv e  co lo r im e tr ic
This method will leave colors that fit into both gamut’s intact. Colors outside of the gamut of the output
device will be adjusted to fit, preserving brightness and color at the expense of saturation. This method
is preferred if accurate color representation is necessary, for example when printing spot colors.

Sa tura tion
Scales the source gamut to the destination gamut but preserves relative saturation instead of hue, so
when scaling to a smaller gamut, hues may shift. This rendering intent is primarily designed for
business graphics, where bright saturated colors are more important than the exact relationship
between colors.
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Abso lute  co lo r im e tr ic
Absolute colorimetric rendering reproduces in-gamut colors exactly, and clips out-of-gamut colors to
the nearest reproducible hue, sacrificing saturation and possibly lightness. This method also takes the
color of the paper into account when printing.

E Color manage CMYK bitmaps
Whether or not CMYK bitmaps should be color managed.

F Use embedded profiles when available
Whether or not you want to use the profile that was included in the source file for a job.

G CMYK vector input profile
A combo box from which you can select the desired input profile for CMYK vector data.

H RGB vector input profile
A combo box from which you can select the desired input profile for RGB vector data.

I Grayscale vector input profile
A combo box from which you can select the desired input profile for Grayscale vector data.

J Vector render intent
The render intent for vector data, see the description under "Bitmap render intent" for
the available types.

K Color manage CMYK vector
Whether or not CMYK vector data should be color managed.

L Suppress dirty Cyan
If enabled, dirty cyan is suppressed. use this if you want cyan to be printed as cyan, even after color
managing.

M Suppress dirty Magenta
If enabled, dirty magenta is suppressed.

N Suppress dirty Yellow
If enabled, dirty yellow is suppressed.

Working with Hotfolders
W o r k i n g  w i t h  H o t f o l d e r s

First of all what is a Hotfolders? A Hotfolder is a directory on your hard disk or network that represents a set of default
settings. By copying a job into a Hotfolder, the new job will be set up the same way as the Hotfolder, and then it will
be added to the job list, ready for printing. So if want to set up a way to print something that is always mirrored, or at
200% by default, a Hotfolder would be the way to do it.

Also, if you want to print something directly from the EasySIGN design software to the Print Server, a Hotfolder is
necessary to store the exported print job.

Adding a Hotfolder
To add a Hotfolder, first you have to find the window labeled Hotfolders. If it is not visible, just go to "View >
Toolbars" and make sure that ‘Hotfolders’ is ticked.

The Hotfolders window has the usual three-button icons, to add, remove and edit the Hotfolders that have been set.
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By clicking the ‘add’ button, a wizard will come up that guides you through the
process of installing a new Hotfolder.

Step 1. Choosing a device and a setting
Any Hotfolder will mark the incoming files with a device and setting, meaning that the jobs are intended to be printed
on the selected device and setting.

Please be aware that a Hotfolder is just a set of defaults. Any job that comes in through the Hotfolder, gets the same
setting but everything can be changed of course before committing to printing.

Check that you have chosen the correct printer and setting, and click ‘Next’ to continue. In the next page of this
Wizard, there is one important setting, the ‘Root directory’. You should choose one root directory and place all hot
folders in it. The root directory can then be shared over the network, for other computers to use.
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There are some extra settings to be made in this dialog:

A Input file processing
When you place a file in a Hotfolder it will be processed. When processing is done, you can choose
whether to remove the file or move it to a subdirectory called ‘Processed’ or ‘Error’.

B Job Processing
When a job has been printed, you can choose whether you want to keep it in the Archive. The following
choices exist:

R e m ov e
When the job has been printed, it will be removed immediately.

Archiv e  a s  spa ce  a llows
The job will be put in the archive, but it will be removed automatically if the software runs out of disk
space.

Archiv e  inde fin ite ly
The job is kept in the archive until removed by the user.

When you click ‘Finish’, your Hotfolder will be added and it will shown in the list.

Setting up Hotfolders
Every hot folder can have its own default settings, making it very easy to create Hotfolders, not only for every type of
material, but even for customer based hot folders. 
Make the default settings once, give it an appropriate name, very handy for returning jobs. Remember that these
settings are only defaults: an incoming job can always be changed before printing it. 

Editing the settings of a Hotfolder can be done in the following way: select the
Hotfolder itself, then click the ‘edit’ icon in the top of the toolbar.

The following dialog will appear:
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On the left side of the dialog are three icons that activate the following three tabs:

Hotfolder properties

A Name
The name and directory of this Hotfolder. You should change the name in something meaningfull.

B Folder
The actual directory that gets monitored for new files coming in. You can change this directory by
clicking the ‘Browse’ button on the right.

C Folder is active
Activates or de-activates the Hotfolder.

D After rendering
For some files, the RIP will render them, after which the original file will no longer be necessary, and
can be removed. Use ‘remove’ if you copy original files into the Hotfolder. Use ‘Move to processed’ if
you want to keep the original files for some reason. The file will then be moved to the ‘Processed’
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directory which is created in the Hotfolder directory.

E If an error occurs
Same as above, except the input file will be moved to the ‘error’ directory or deleted if it generates an
error while rendering.

F Job processing
When a job has been printed, it will be automatically moved to the job archive, where it will stay.

G Output settings
The default printer and setting that this job is meant to be printed with.

H Nr of copies
Number of times the job will be placed when dragged onto a print.

Sizing and paneling
This page gives you the opportunity to set up an incoming job for the correct size and paneling options. These settings
are similar in their function to the settings on an individual job, so please refer to the previous chapter on working
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with jobs for a more elaborate description.

Input profiles and color management
Again, these settings are the default settings for color management on the jobs that come in on this Hotfolder. As they
are similar to the settings on an individual job, please refer to the previous chapter on jobs for a detailed description
on how they work.

After pressing "OK" the Hotfolders tab will look like below:
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Working with prints
W o r k i n g  w i t h  p r i n t s

This is where it all comes together: a print is the centre where you place the individual jobs, arrange them, and send
them to your printer. The prints are shown like below:

A Print view
This view shows the print as it is going to come out of your printer: a long roll of material, which is
empty for now. To place jobs, you can simply drag them from the job list onto the print. If the job has
paneling activated, this will automatically show when dragging the job.

The print view has a number of drag able items itself:

Ma te r ia l s ize (B)
By dragging the small arrow on the lower right of the print view, the material size can be adjusted.

Ma rg ins (C)
The front end of the material, as well as the left and right side, can be dragged to set a margin. This
margin will be used when automatically placing items with the ‘stacking method’ option enabled.

Viewing around the print view can be done with the scrollbars around it, or by using the toolbar above it. The function
of the individual buttons are: 
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Wireframe
Shows placed jobs as a wireframe, with information as text.

Filled
Shows the jobs as a color preview.

Zoom sheet
Shows the entire length of the print, including empty space.

Zoom front
Shows the first side of the print, zoomed to maximum width.

Zoom jobs
Shows everything (every job) that has been placed on the print.

Select mode
Click this button to be able to select and move jobs.

Zoom in
Click this button, then drag across the print view to zoom to a specific area.

Zoom out
This button instantly zooms the view out by a predetermined amount.

Drag view
Activate this button, then click and drag to move the print view.

There can be an unlimited amount of individual prints at the same time, which enables you to work on a new print
while a previous one is processing. To do this, look at the top of the print where you will find a tab bar with the name
of your current print.

After adding a new print, just click back and forth between them to bring them to the front. The X in  prints name lets
you close and delete them, of course this will only work if the print is not being processed just yet.

When you create more than a few prints, they cannot be displayed all at the same time. In that case, a small arrow
on the right shows a menu of all available prints.

Print properties bar
On the right side of the print view you will find a large toolbar which enables you to control the active print. It has the
following options:
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A Device
The specific printer that this print will appear on.

B Setting
The setting you want to use for this device.

C Device mode
There are five different device modes available, hover the mouse over the icons to see a description:

Pr int

This is the default, it only prints even if cutline's are available.

Pr int a nd  cut

Immediately after printing, the job is also cut. Only available on Print & Cut hybrid machines.

Pr int & cut –  pr int only
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This will print a job with cropmarks, ready to be re-inserted on cut. Available on Print & Cut hybrid
machines only, and used in case you would want to laminate a Print & Cut job before cutting it.

Pr int & cut –  cut only

This will cut a print & cut job on a hybrid machine.

Cut only

This cuts a job on a hybrid print & cut machine without printing anything.

Be aware that the Print & Cut modes are only used on hybrid machines, meaning printers with an
integrated cutter. Please refer to the manual that can with the printer for the correct workflow.

Print & Cut workflows that use a separate cutter and printer can of course also be processed, however
the print server treats these as a normal print job (with crop marks of course) and they would be
printed in the default ‘print’ mode.

D Roll width/length
The size of the material in the printer. This size can also be changed by dragging the small black arrow
on the lower right of the print view.

E Stacking method
When placing jobs, it is possible to align the jobs automatically, a process called ‘nesting’. There are
three options available:

Sim ple

All jobs will be placed after each other, no other optimization Is performed.

Jobs  toge the r

Multiple copies of a job will be nested, but they will not be mixed with other jobs.

Sa v e  m a te r ia l

An optimal placement of jobs will be made, mixing copies of jobs and panels if necessary.

The selected stacking method will be shown by these buttons. However, when you move a job
manually, the stacking switches off and no automatic placement will be performed, until you click one
of these buttons again.

F Alignment

All stacking methods can have a left, middle or right alignment.  Click one of these buttons to choose,
the default is right-alignment.

G Margin
The distance between stacked jobs.

H Confidence strip
A strip can be enabled on the left and/or right side of the print. Enabling this ‘exercises’ the print heads,
which might help to keep open all inks in a print head. Width can be adjusted.

I Margins
A left, right and front margin can be entered here, this enables you to keep some extra material
around the print itself. This can be handy when doing Print & Cut for example.

J Number of copies
The number of times this print will be printed.

Print buttons
There are several ways of starting a print, you can choose to start printing right away, or to be a bit more careful and
render a print first. The buttons have the following functions:
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K Print now
Starts rendering, and as soon as a small portion of the render is ready the print will start. This can be
used when you have a fast computer and you know for sure that the computer can keep up with the
printer.

L RIP, then print
This renders the print data first, and when everything is ready the print will automatically be started.
Can be used on slower computers to make sure the printer will never need to wait.

M RIP only
Renders all data, but w ill not print until ‘Print now ’ is clicked.

N Triggers
It is possible to start any print that you have set up at a specific time. When you click the ‘Triggers’
button a new dialog appears:

Sta rt a t a  spe cific da te  a nd  tim e  (A)
This enables you to start the current print when you are away, for example when you want to print
during the night.
 
Sta rt whe n le ngth m ore  tha n (B)
This starts a print when there are enough jobs available.

Sta rt whe n e fficie ncy  m ore  tha n (C)
This starts the job when the stacking has produced a print with high enough accuracy.

Archive

Archive
A r c h i v e

Archive est un programme auxiliaire spécialement conçu pour EasySIGN. Ce programme vous aide à gérer vos
feuilles de travail de EasySIGN ainsi que vos fichiers clients. Vous pouvez enregistrer vos feuilles de travail par client
à partir de EasySIGN. Archive vous permet d’ouvrir, d’importer, de gérer, de traiter, etc. vos données client.

Première version
Si vous n’avez jamais installé une version de Archive sur votre système, un “ assistant ” apparaît à l’écran. Cet
assistant vous accompagne pendant la procédure d’initialisation du programme.
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La première boîte de dialogue de l’assistant vous présente les étapes que vous allez suivre. Vous pouvez déterminer
le mode dans lequel Archive 32 fonctionnera, selon que vous travaillez ou non en réseau. Vous devez également
préciser l’emplacement dans lequel Archive enregistrera les feuilles de travail de EasySIGN. Vous pouvez à tout
moment activer l’assistant à partir du programme initialisé. Si vous le faites et que vous disposez déjà d’un dossier
Archive et de feuilles de travail EasySIGN, il vous est conseillé de réaliser un back-up avant de poursuivre le
processus avec l’assistant. Vous pouvez alors appuyer sur le bouton “ Suivant ” (2) pour poursuivre la procédure.

La fenêtre suivante de l’assistant vous invite à choisir les modes dans lesquels vous souhaitez travailler.

4 “ Standalone ”
 Sélectionnez ce mode si vous ne travaillez pas en réseau et que vous n’utilisez le programme que sur un seul
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ordinateur.
5 “ PTP-Server ”
 Dans ce cas, votre ordinateur est un serveur et un poste de travail.
6 “ DS-Setup ”
 Sélectionnez ce mode si vous comptez utiliser un “ serveur de fichiers ”.
7 “ Client ”
 Optez pour ce mode si vous utilisez déjà un “ serveur de fichiers ”.

 

Les divers modes
L e s  d i v e r s  m o d e s  

“ Standalone ”
Si vous avez sélectionné cette option dans l’assistant, il vous suffit de cliquer sur le bouton “ Suivant ” pour passer à
la fenêtre suivante.

4 Ce champ reprend le chemin du dossier par défaut de Archive 32. Il est conseillé d’utiliser ce chemin. Si vous
préférez utiliser un autre chemin, il vous suffit de l’indiquer ou de le rechercher à l’aide du bouton
“ Parcourir ” (5).

“ PTP-Server ”
Sélectionnez cette option si votre réseau ne contient pas de “ Dedicated file server ”. L’un des ordinateurs du réseau
se comporte comme un serveur.
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4 Indiquez dans ce champ le chemin du dossier de Archive ou recherchez ce dossier à l’aide du bouton
“ Parcourir ” (5).

6 Si le dossier de Archive se trouve sur le disque “ C ”, vous devez préciser la répartition du disque “ C ” dans le
réseau.

S “ Serveur / Poste de travail ”
 Cet ordinateur a été soumis au “ PTP-Setup ”. Il contient le dossier divisé “ Archive ” pour les autres postes de

travail (“ C ”)  et la version de Archive.
C Poste de travail 
W Les postes de travail ont été soumis au “ Client Setup ” de Archive ; le dossier divisé (A ”) du serveur (“ S ”)

est utilisé comme source. 

“ DS-Setup ”
Sélectionnez cette option si votre serveur contient un “ Dedicated file server ” (un serveur NT par exemple). Les
feuilles de travail sont enregistrées sur ce serveur. 



379EasySIGN

4 Vous devez indiquer dans ce champ le chemin du dossier de Archive ou rechercher ce dossier à l’aide du
bouton “ Parcourir ”.

S Serveur
C Poste de travail
W L’un des postes de travail a été soumis au “ DS-Setup ” et le serveur (“ S ”) sert de source pour le dossier

“ Archive ” (“ A ”). Les autres postes de travail ont été soumis au “ Client Setup ” de Archive et le dossier divisé

(“ A ”) du serveur (“ S ”) est utilisé comme source. 

“ Client Setup ”
Cette option recourt à un lecteur déjà identifié et part du principe que vous avez déjà soumis un autre ordinateur au
“ DS-Setup ” ou au “ PTP-Setup ”.
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4 Vous devez maintenant indiquer le chemin du dossier de Archive ou rechercher ce dossier à l’aide du bouton
“ Parcourir ” (5).

Une fois le paramétrage terminé, cliquez sur le bouton “ Terminer ” (2).

L’environnement de travail
L ’ e n v i r o n n e m e n t  d e  t r a v a i l  

Lorsque vous lancez Archive, l’écran se présente sous la forme suivante. Si vous avez opté pour l’installation des
exemples lors de la configuration de EasySIGN, ceux-ci figurent dans Archive dans un dossier d’exemples.
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1 Le menu
 Tous les éléments du menu sont expliqués de manière approfondie ci-après.
2 La barre d’outils
 La barre d’outils contient les fonctions les plus fréquemment utilisées. Elles sont accessibles directement par

l’intermédiaire d’un bouton.
3 Fenêtre d’aperçu
 Cette fenêtre reprend tous les clients présents dans une arborescence.
4 Fenêtre de données
 Cette fenêtre vous permet d’introduire des données relatives à vos clients ou de consulter les feuilles de travail

de vos clients.
5 Barre d’état

 

Le menu
L e  m e n u

Client

Ce menu s’affiche également si vous cliquez sur un élément de l’arborescence à l’aide du bouton droit de la souris.

Nouveau (CTRL+N)
Un nouveau client est placé à un niveau déterminé qui dépend de l’élément que vous avez sélectionné dans
l’arborescence. Si vous avez sélectionné “ Root ” par exemple, vous pouvez créer un groupe nommé “ Clubs de
football ”. Sélectionnez ensuite le nouveau dossier “ Clubs de football ”, puis cliquez sur “ Nouveau ”. Le nouveau
client/dossier est ajouté dans le dossier “ Clubs de football ”. De cette manière, vous pouvez classer vos clients selon
le type de leurs activités.

Supprimer (DEL)
Cette option vous permet de supprimer un dossier sélectionné. Si le dossier contient encore des feuilles de travail,
vous devez les effacer avant de pouvoir supprimer le dossier.

Modifier / Lecture seule
L’option “ Modifier ” du menu vous permet de modifier les données relatives aux clients. La base de données est
provisoirement inaccessible aux autres utilisateurs pendant que vous modifiez les données relatives aux clients. Ce
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dispositif permet d’éviter que deux personnes traitent simultanément les données relatives au même client. Pendant
l’introduction des changements, les autres utilisateurs peuvent ouvrir les feuilles de travail, mais ne peuvent modifier
les données relatives au client. Pour libérer un enregistrement, il vous suffit de sélectionner l’option “ Lecture seule ”
du menu. L’accès des autres utilisateurs à la base de données est automatiquement rétabli si aucune opération n’est
effectuée pendant cinq minutes.

Rechercher
Cette option vous permet d’ouvrir une boîte de dialogue dans laquelle vous pouvez procéder à la recherche des
clients présents.

1 Recherche
 Introduisez dans ce champ les critères sur la base desquels vous souhaitez réaliser votre recherche.
2 Rechercher dans
 Indiquez dans ce champ les secteurs dans lesquels vous souhaitez procéder à la recherche.
3 Résultat 
 Ce champ présente les résultats de la recherche. Cliquez deux fois sur l’un des éléments de cette liste pour

ouvrir le fichier.
4 Rechercher
 Ce bouton vous permet de lancer la recherche.
5 Fermer

Quitter
Cette option vous permet de fermer le programme.

Traiter

Restaurer
Cette option vous permet de restaurer l’enregistrement sur lequel vous travaillez si vous êtes en mode de
modification.

Supprimer
Cette option vous permet de supprimer les feuilles de travail sélectionnées.

Tout sélectionner
Cette option vous permet de sélectionner toutes les feuilles de travail figurant dans le dossier ouvert.

Inverser sélection
Cette option vous permet d’inverser une sélection déjà réalisée.

Renommer
Cette option vous permet de renommer le dossier client sélectionné dans l’arborescence.

Vue

Barre d’outils
Cette option vous permet de masquer ou d’afficher la barre d’outils.
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Barre d’état
Cette option vous permet de masque ou d’afficher la barre d’état.

Données client
Cette option vous permet d’activer les données relatives au client dans le champ de données.

Grandes icônes
Cette option vous permet d’afficher les feuilles de travail présentes sous la forme de grandes icônes sous lesquelles
figurent les noms des fichiers.

Petites icônes
Toutes les feuilles de travail sont affichées sous la forme de petites icônes.

Liste
Les feuilles de travail sont affichées sous la forme d’une liste.

Détails
Les feuilles de travail sont accompagnées de données supplémentaires parmi lesquelles figurent la date de la dernière
modification du fichier.

Aperçu
Toutes les feuilles de travail sont accompagnées d’un aperçu de leur contenu.

Rafraîchir (F5)
Cette option vous permet de rafraîchir la fenêtre.

Extra

Mode Assistant
Comme indiqué dans le paragraphe “ Première version ”, cette option vous permet de passer en mode Assistant.

Back-up
Cette option vous permet d’obtenir des conseils en matière de sauvegarde.

Aide
Vous trouverez dans ce menu tout ce qui se rapporte à l’aide et au manuel numérique.

Fenêtre de données
F e n ê t r e  d e  d o n n é e s

Cette fenêtre reprend toutes les feuilles de travail qui figurent dans un dossier client déterminé. Elle vous permet
également de gérer les feuilles de travail.
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Vous pouvez sélectionner plusieurs feuilles de travail en même temps en appuyant sur la touche “ CTRL ” afin de les
supprimer ou de les importer dans EasySIGN par exemple. Si vous avez sélectionné une feuille de travail, cliquez sur
cette feuille à l’aide du bouton droit de la souris.
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Ce menu contextuel comprend les options suivantes.

1 Ouvrir
 Cette option vous permet d’ouvrir la feuille de travail sélectionnée dans EasySIGN. Si EasySIGN n’est pas

ouvert, il s’ouvre automatiquement. Vous pouvez également réaliser cette opération en cliquant deux fois sur
la feuille de travail.

2 Importer
 Cette option vous permet d’importer cette feuille de travail dans la feuille de travail active dans EasySIGN.
3 Supprimer
 Cette option vous permet de supprimer les feuilles de travail sélectionnées. Si vous effacez par mégarde une

feuille de travail que vous souhaitiez conserver, vous pouvez la récupérer dans la corbeille de Windows™.

Si Archive ne parvient pas à trouver le programme EasySIGN, un message vous demandant de localiser le
programme s’affiche à l’écran. Une boîte de dialogue vous permettant de procéder à la recherche du programme
s’affiche à l’écran si vous répondez “ Oui ”.

Déplacer tous les fichiers 

Si vous souhaitez placer les archives dans un autre disque, quittez Archive avant d’amener le dossier “ Archive ”

complet à son nouvel emplacement. Relancez ensuite Archive. Un message vous demandant d’indiquer l’emplacement
de la base de données s’affiche alors à l’écran. Introduisez le nouvel emplacement. Toutes les références sont
automatiquement corrigées.

Drag & Drop

Vous pouvez faire glisser un fichier au départ de Archive vers l’explorateur, et inversement. Vous pouvez également
faire glisser un fichier au départ de Archive vers EasySIGN. Le fichier est ouvert ou importé dès que vous le
déselectionnez.
Dans Archive, vous pouvez copier ou faire glisser des fichiers d’un dossier client à l’autre. Pour ce faire, il vous suffit
d’appuyer sur la touche “ Shift ” pendant que vous déplacez le ou les fichiers.
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Archive via EasySIGN
A r c h i v e  v i a  E a s y S I G N

Le menu “ Fichier ” de EasySIGN vous permet d’archiver vos feuilles de travail. Il existe trois options.

1 Archiver
 Cette option vous permet d’enregistrer les éventuelles modifications apportées à une feuille de travail ouverte.
2 Archiver sous
 Cette option vous permet de faire apparaître une boîte de dialogue à l’écran. Dans cette boîte de dialogue,

vous pouvez archiver une nouvelle feuille de travail ou une feuille de travail déjà archivée sous un autre nom
ou dans un autre dossier.
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La liste reprend les dossiers client présents dans Archive (1). Les données relatives à l’éventuel client sélectionné
figurent à cet endroit (2). Le champ (3) vous permet d’indiquer le nom de la feuille de travail. Vous pouvez ensuite
cliquer sur le bouton “ OK ”. La feuille de travail est alors enregistrée dans le dossier client sélectionné. 

Clients récents
C l i e n t s  r é c e n t s

Une liste contenant les dix derniers clients a été ajoutée au menu “Fichier”. Si vous gérez de nombreux clients dans
Archive, vous n'aurez plus besoin de parcourir vos enregistrements ni d'utiliser la commande de recherche pour
retrouver les clients avec lesquels vous traitez souvent.

Conseils de sauvegarde
C o n s e i l s  d e  s a u v e g a r d e

La sauvegarde n'est pas en soi une opération compliquée. En revanche, il est plus difficile de déterminer le moment
et l'objet de cette sauvegarde. Archive permet de déterminer quand une sauvegarde s'avère nécessaire pour vos
fichiers EasySIGN, Archive. Il s'agit généralement de vos fichiers EasySIGN et Archive clés qui ne seraient
normalement pas remplacés après une réinstallation, par exemple, les exécutables ajoutés manuellement, les feuilles
de travail ou les palettes de couleurs personnelles.

Pour accéder à la boîte de dialogue permettant d'effectuer cette opération, vous devez utiliser le menu “Aide,
Conseils de sauvegarde”.
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1 Fichiers à sauvegarder
 Cette option permet d'obtenir une liste de tous les fichiers à sauvegarder.
2 Afficher dossiers uniquement
 Si vous activez cette option, seuls les dossiers contenant les fichiers à sauvegarder sont visibles.
3 Imprimer
 Ce bouton permet d'ouvrir un fichier texte contenant tous les fichiers figurant dans la boîte de dialogue.
4 Fermer
 Cette option permet de fermer la boîte de dialogue.

Recherche de feuille de travail
R e c h e r c h e  d e  f e u i l l e  d e  t r a v a i l

Cette commande permet de rechercher les feuilles de travail EasySIGN sur l'ensemble de vos disques durs et
connexions réseau. La sélection que vous effectuez dans le résultat de la recherche peut être ajoutée en tant que
nouveau client. Vous pouvez lancer cette recherche à partir du menu “Extra, Recherche de feuille de travail”. Une
boîte de dialogue indiquant l'avancement de la recherche s'affiche.

Vous pouvez utiliser le bouton “Annuler” pour abandonner la recherche. Une fois que la recherche a été effectuée sur
tous les lecteurs et toutes les connexions réseau, une autre boîte de dialogue s'ouvre, répertoriant tous les dossiers
qui contiennent des feuilles de travail EasySIGN (anciennes ou nouvelles).
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Cette boîte de dialogue permet d'effectuer des sélections et d'ajouter ces sélections en tant que nouveaux clients
dans la base de données Archive.

Déplacement de clients
D é p l a c e m e n t  d e  c l i e n t s

Le champ gauche de Archive permet de déplacer des clients vers un autre emplacement de la base de données. Une
fois le client déplacé, l'emplacement de vos feuilles de travail et dossiers sur le disque dur reste le même. Il n'est pas
possible de copier des clients vers un autre emplacement.
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Aperçus
A p e r ç u s

Si vous souhaitez que Archive aff iche non seulement les feuilles de travail standard, mais également les feuilles de travail pouvant être

prévisualisées dans Window s™ Explorer, vous pouvez activer le menu « Vue, Aff icher tous les aperçus ».
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